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AGENDA AT-A-GLANCE

8:00 - 9:00

Breakfast, Exhibitors and The InfoXchange

177TH SOLO & SMALL FIRM CONFERENCE

Break: Exhibitors and The InfoXchange

CONCURRENT BREAKOUT SEMINARS AND WORKSHOPS

Registrants watch/attend either Seminar A, Seminar B, or a Workshop

Best Practices for Your Team

10:30-11:20 Integrating Alternative The Modern Lawyer’s
(10 m@) Billing into Your Firm Marketing Blueprint
11:20-11:25 Session Change
Successfully Implementin Pride and Pronouns: Bring Your Own Device - Learn
11:25-12:15 Chan esyin qur Firm 9 Navigating Diversity How to Use Microsoft 365 Tools
9 (50 m@®) and Outlook to Your Advantage
12:15-1:15 kunch
Exhibitors and The InfoXchange
Yes, You Really do Belong -
1:15-2:05 The Four-Day Work Week Managing the Imposter Succession Planning for
: : Syndrome in Your Life and All Stages of Your Career
.................................................................................................................................... Practice BOmM@) ...
2:05-2:10 Session Change
The Solo/Small Firm During Rebooting Y«
2:10-3:00 L g rour
Challenging Times Uz e ey el Client Intake Process
3:00-3:30 Break: Exhibitors and The InfoXchange
3:30-4:30 Closing Plenary: Growth Stories of Successful Law Firms
4:30-6:00 Reception
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Breakfast (Room 202), Exhibitors (Room 202) and The InfoXchange (Room 205 A)

The Honourable Justice Kathleen Erin Cullin, Superior Court of Justice
Barbara Hicks, Hicks & Hicks Professional Corporation
Jennifer Reynolds, Fresh Legal

Do you have questions for the faculty? Speaking times include 10 minutes for Q & A.

To submit questions for the faculty, scan the relevant QR code or click on the link below:

Opening/Closing Plenary
and Seminar A Questions Seminar B Questions Workshop Questions

[=] s [m] [=] §Es [m]
- e
[=]

"
https://bit.ly/3LFcjzM https://bit.ly/3HsYh1U https://bit.ly/3NqrdLN

The Secrets for Success

What does success look like to you? And what does it look like for your team? And your clients? Our
distinguished speaker shares his insights on running the business of your law practice successfully so that
you can meet your goals. He sets the stage for the conference by offering data-based information to help
you make the right decisions for you and your firm. Hear how to design a client-centred law firm, improve
your time utilization, create an anti-fragile and more resilient business, increase your competitive edge by
using technology, and more.

Jack Newton, CEO & Founder, Clio

#17SoloSmall store.lso.ca/17thsolosmall Cm 17th Solo & Small Firm Conference 3
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Please note:

Registrants attend or watch either Seminar A, or Seminar B, or a Workshop.
Workshop for in-person attendees are a first-come, first served basis. Space is limited.

* All sessions and all workshops will be available on-demand post-program.

CONCURRENT BREAKOUT SEMINARS AND WORKSHOPS

BREAKOUT ONE
10:30 a.m. - 11:20 a.m.

SEMINAR A: Room 206

Best Practices for Your Team (10 m @)

If there is one consistent theme from the past three years, it is that the workplace has changed significantly,
and perhaps forever. What does that mean for you? More than ever, engaging your staff can reap benefits for
you as a business leader, through retention, job satisfaction, and a well-managed professional life. Learn about
innovative approaches and new models to create a culture that reflects a firm’s vision, as well as meeting
employees’ needs. Hear why it is essential to have clear employment contracts and solid workplace policies in
place, understand how to offer benefits, rewards, and compensation structures that resonate with staff, and
where work challenges can give you opportunity for reflection and positive change.

Moderator: Barbara Hicks, Hicks & Hicks Professional Corporation

Panelists: James De Melo, Construct Legal
Jonquille Pak, JPak Employment Lawyers
Jonathan Richardson, Richardson Hall LLP

OR
SEMINAR B: Room 205 B/D

Integrating Alternative Billing into Your Firm

Many of your peers may be shifting away from traditional billing practices - have you thought about it for
your firm? Hear how and why you might consider moving from an hourly rate to an alternative billing model.
Understand which practice areas alternative billing fits best for, what the process is to implement these
systems, how to train and manage your staff, and how to manage your clients and their expectations under
these alternative billing arrangements.

Digby Leigh, Digby Leigh & Co.
Allison Speigel, Speigel Nichols Fox LLP
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The Modern Lawyer’s Marketing Blueprint

How do you find your dream clients? Or, perhaps, more importantly, how do they find you? One of the
challenges of solo or small firm practice is learning how to create your brand and how to build the relationships
that help build your business. Our presenters started their practices from the ground up and share their secrets
on how to leverage technology, how to best invest your time (not just your money) in effective marketing
techniques and offer solutions so that you can develop a blueprint for your firm’s success.

Romesh Hettiarachchi, Signal Lawyers / Lawtrepreneur
Andrew Leroy Rudder, Rudder Law Group

THANK YOU TO OUR
PLATINUM SPONSOR

Dye &
Durham

Dye & Durham is one of the world’s most trusted providers of mission-critical
software for legal, financial and business professionals. We provide premiere practice
management solutions empowering legal professionals every day, deliver vital data
insights to support critical corporate transactions and enable the essential payments
infrastructure trusted by government and financial institutions.

Learn more at dyedurham.ca

#17SoloSmall store.lso.ca/17thsolosmall Cm 17th Solo & Small Firm Conference S
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BREAKOUT TWO
11:25 a.m. - 12:15 p.m.

SEMINAR A: Room 206

Successfully Implementing Changes in Your Firm

Change is hard. Navigating change when your staff, clients, and your network of related professionals

are involved may be even harder. You need to ensure that the right processes are in place to make these
transitions successful. Understand how to implement transformations in varied aspects of your practice,
including introducing new technologies, onboarding new staff, reducing or altering your team’s responsibilities,
and more.

Sukhi Dhillon Alberga, Bridging Legal Solutions Law Professional Corporation
Amy Grubb, Grubb Legal Consulting

OR

Pride and Pronouns: Navigating Diversity (50 m Q)

How do you create a more inclusive environment for your clients and in your workplace? Our panel helps you to
navigate by giving you a better understanding of concepts relating to the 2SLGBTQ+ community. Learn more
about gender identity, what it means today, and become more aware of how to use gender neutral language
appropriately.

Renée Fuchs, Legal Aid Ontario
Milena Soczka, Legal Aid Ontario Duty Counsel Office

OR

Bring Your Own Device - Learn How to Use Microsoft 365 Tools and Outlook to Your Advantage

You likely already have the tools to make your workflow more efficient, but you might not be using them to their
full potential. Bring your own device to this hands-on workshop where you learn how to use Microsoft Office
365, Outlook, and other software more effectively. Discover additional ways to unlock the secrets that will save
you (and your team) time and assist you in serving your clients more effectively.

Paul Unger, Affinity Consulting Group

Lunch (Room 202)
Exhibitors (Room 202) and The InfoXchange (Room 205 A)
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Everyone could use a helping hand. Stop by our Exhibitors (Room 202) to discover

products and services that can take your practice to the next level!
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BREAKOUT THREE
1:15 p.m. - 2:05 p.m.

SEMINAR A: Room 206

The Four-Day Work Week

For lawyers, a four-day work week may seem like an unattainable goal. How can you work four days and still
be able to service your clients while succeeding financially? Hear how our speakers have taken steps to make
this approach work well in their firms. They offer practical tips on the processes you need, the technology
they rely on, and the efficiencies they have pursued to make this dream a reality.

Quinn Ross, The Ross Firm Professional Corporation
Leena Yousefi, YLAW

OR

Yes, You Redlly do Belong - Managing the Imposter Syndrome in Your Life and Practice (30 mQ)

Do you ever feel that you are in over your head? Or fear that someone will find out that you are a fraud, and
that you have no idea what to do next? In a profession that prizes perfection, competitiveness, and reputation,
many lawyers experience feelings of self-doubt throughout their careers, despite their accomplishments.
Without the skills to cope, lawyers can experience mental health issues, burnout, or paralyzing anxiety. Our
speakers share their personal stories on how to identify “imposter syndrome” and offer strategies to overcome
these feelings.

Moderator: The Honourable Justice Kathleen Erin Cullin, Superior Court of Justice

Panelists: The Honourable Justice Lucille Shaw, Superior Court of Justice
Neha Chugh, Chugh Law Professional Corporation
Doron Gold, Doron J. Gold, Psychotherapy and Wellness Education

OR

Succession Planning for All Stages of Your Career

They say that failing to plan means planning to fail. This holds true for succession planning no matter
what stage you are at in your career. If you don’t have a proper plan for your practice for unexpected
illness, accident, incapacity, or death it can mean negative consequences for your clients, your employees,
and even your family. Our panel gives you tips to ensure you are prepared with the steps to take and the
documentation you need. They cover how the LSO’s Trustee Services get involved when a succession or
contingency plan is not in place. Setting up your plan now helps safeguard your practice in the future.

Jordan Atin, C.S., TEP, Atin Professional Corporation
Kim Mackay, Trustee Services, Law Society of Ontario
Colleen Peffers, PeffersLaw
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Visit our on-site photographer to get your
professional headshot today.

: Make sure your first impression is a great one!

COMPLIMENTARY Registrants will receive an email to book an

appointment, on a first come, first served

PROFESSIONAL basis. Didn’t get an appointment? Visit
HEADSHOTS the photographer’s booth on program day

for avdailability.

N\

THE INFOXCHANGE

Have a question in Mind? Look to the people at The InfoXchange for the answer! (Room 205 A)

-

| Coach and Advisor Network | Réseau d'encadrement de la pratique H o e OOd
. mew

Health | Santé

LAW P R()® LSO-Practice Review

Great Library
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Legal Information and Resource Network
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BREAKOUT FOUR
2:10 p.m. - 3:00 p.m.

SEMINAR A: Room 206

The Solo/Small Firm During Challenging Times

Solo and small firms are uniquely positioned to rapidly adapt to the changing landscape because they can
quickly pivot when faced with external challenges and are always able to evolve in creative ways. Hear how
our panel of speakers handle the stress of change in career path, the economic challenges of the pandemic,
mental health obstacles, and the need for resilience to build a strong foundation for their firm.

Katharine Brack, Osprey Law LLP
Selwyn Hicks, Hicks & Hicks Professional Corporation
Jodie Primeau, Primeau Law Professional Corporation

OR

Technology Update

The rapid changes in technology are daunting for anyone operating a solo or small firm. Understanding
available technology and how - and when - to implement these new tools is critical to your firm to make you
competitive. Hear about the risks and opportunities in using Al in your practice, learn about the importance of
knowledge management tools, and be aware of the steps you can take to protect from cyber attacks.

Catherine Sanders Reach, Director, Center for Practice Management, North Carolina Bar Association
Paul Unger, Affinity Consulting Group

OR

Rebooting Your Client Intake Process

Onboarding new clients is an essential step in your firm’s operations. You want to meet your professional
obligations and mitigate risk while ensuring you have a process that works for your clients. In this workshop,
our speakers provide valuable tips so you can build (or tweak) that process to identify gaps, introduce
automation, and create a well-designed intake process that will serve you better.

Lisa Feldstein, Lisa Feldstein Law Office Professional Corporation
Jennifer Reynolds, Fresh Legal
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Growth Stories of Successful Law Firms
What does it mean to grow your firm? It might be adding staff or perhaps it is increasing the services you
provide. Or maybe it’s updating processes through tech or expanding the territory you cover. Hear tips

and practical insights from speakers who have managed these changes, to see how you can grow your
firm in the ways that work for you.

Moderator: Jennifer Reynolds, Fresh Legal

Panelists: Jennifer Gold, Wood Gold LLP
Cheryl Siran, Hook Seller Lundin LLP
Jacqueline Swaisland, Landings LLP
Darlene Tonelli, Inter Alia Law

11 17th Solo & Small Firm Conference Cm [ Law society of Ontario cPD @LSOCPD



THANK YOU TO OUR GOLD SPONSOR!

" Accounting for Law is a bookkeeping firm with
Accountlng for Law expertise specific to the legal industry. Alongside

legal bookkeeping, we assist with Law Society
“ Financial Peace of Mind for Lawyers Spot Audits, Software migrations and New Start

Up Firms.

forlaw.ca

THANK YOU TO OUR SILVER SPONSORS!

™ Lex =] eState

g Hull & Hull LLP
by vprofitsolv

Cosmolex is cloud-based law practice management eState Planner, an award-winning software used by
software that integrates compliant trust & business 1,500+ Canadian lawyers, streamlines the estate
accounting, docketing, invoicing, document planning and will drafting process for lawyers and their
management & eSignature, as well as email clients. This cloud-based program helps lawyers save
management, and tasks & calendaring, in a single time on client intake, create detailed estate plans,
application. enhance client's experience, and generate wills, powers

of attorney, and other legal documents.

cosmolex.com e-stateplanner.com

DTO LawVo" M stewart

TITLE
LawVo (Law Virtual Office) is the first end to end A Trusted Partner in the Canadian Title Insurance
fully digital legal SAAS solution provider for legal Industry. Stewart Title serves a network of thousands
professionals and their customers offering a complete of legal professionals across Canada who have come
e-commerce platform that lets you start, grow, and to know and trust Stewart Title as an experienced,
manage your legal business completely online and reliable title insurer. We have become the preferred
modernize your practice. title insurance provider for lawyers and notaries by

providing unsurpassed Residential and Commercial
Title Coverage.

lawvo.com stewart.ca
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APPROVED FoOR

| AWPRO

Risk MANAGEMENT

This program qualifies for the
2024 LAWPRO Risk
Management Credit

What is the LAWPRO Risk Management credit program?

The LAWPRO Risk Management Credit program pays you to participate in certain CPD
programs. For every LAWPRO-approved program you take between September 16, 2022 and
September 15, 2023, you will be entitled to a $50 premium reduction on your 2024 insurance
premium (to a maximum of $100 per lawyer). Completing any Homewood Health Member
Assistance Plan e-learning course available at homeweb.ca/map also qualifies you for a $50
credit.

Why has LAWPRO created the Risk Management Credit?

LAWPRO believes it is critical for lawyers to incorporate risk management strategies into their
practices, and that the use of risk management tools and strategies will help reduce claims.
Programs that include a risk management component and have been approved by LAWPRO are
eligible for the credit.

How do I qualify for the LAWPRO Risk Management Credit?

Attendance at a qualifying CPD program will NOT automatically generate the LAWPRO Risk
Management Credit. To receive the credit on your 2024 invoice, you must complete the online
Declaration Form.

STEP 1. STEP 2:

e Attend an approved program in person or
online; and/or

e Self-study a past approved program

e Completing a Homewood Health e-course*

Complete the online Declaration form at
lawpro.ca/RMdec by Sept. 15, 2023. The credit will
automatically appear on your 2024 invoice.

You are eligible for the Risk Management Credit if you chair or speak at a qualifying program
provided you attend the entire program.

Where can | access a list of qualifying programs?

See a list of current approved programs at lawpro.ca/RMcreditlist. Past approved programs are
usually indicated as such in the program materials or download page. Free CPD programs
offered by LAWPRO can be found at www.practicepro.ca/cpd

Whom do | contact for more information?
Contact practicePRO by e-mail: practicepro@lawpro.ca or call 416-598-5899 or 1-800-410-1013.

*One Homewood Health e-learning course is eligible for the credit on a yearly basis.

LAWPRO

Lawyers™ Professional Indemnity Company
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Integrating Alternative Billing into Your Firm
Resources

Digby Leigh, Digby Leigh & Co.
Allison Speigel, Speigel Nichols Fox LLP

Shutt, Sandra (CANADIAN LAWYER, 2015) The journey from the billable hour to value-based flat
fees

https://www.canadianlawyermag.com/news/general/the-journey-from-the-billable-hour-to-
value-based-flat-fees/269807

Shutt, Sandra (CANADIAN LAWYER, 2016) Case assessments: do them early and often

https://www.canadianlawyermag.com/news/general/case-assessments-do-them-early-and-

often/270063

Let’s Be Frank: Challenging the status quo of pricing legal services
(Monthly LinkedIn Newsletter; 19 editions to date; 1,580 subscribers)
https://www.linkedin.com/newsletters/6823387679435165696/

Canadian Bar Talk: Moving Away from Hourly Billing
(Feature Article June 2021)
https://www.cbabc.org/BarTalk/Articles/2021/June/Features/Moving-Away-from-Hourly-Billing
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The Modern Lawyer’s Marketing Blueprint

RUDDER

Law Society Barreau . ]
of Ontario de I'Ontario LAW GROUP

RudderLawGroup.ca

FIRST EDITION

Andrew Leroy Rudder

@ Lexishexis
Andrew Leroy Rudder (he, him) andrew@rudderlawgroup.ca
1
Law Society | Barreau m Law Society | Barreau
of Ontario de I'Ontario of Ontario de I'Ontario
RUDDER
LAW GROUP
Agenda: How & Who, Where and What?
Step Number 1: HOW & WHO?
e HOW do you identify WHO your target clients are for the purpose of more effective target marketing?
Step Number 2: WHERE?
e WHERE are your prospective target clients congregating?
e WHERE do your target clients get their information?
Step Number 3: WHAT?
e WHAT medium do you use to market your specific legal services to your target clients?
2

2-1
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LAW GROUP

RudderLawGroup.ca

Step Number 1: HOW & WHO?

HOW do you identify WHO your target clients are for the purpose of more effective target
marketing?

Prior to any marketing campaign, you must first take a deep dive into really knowing your prospective clients, in
order to tailor your marketing message directly to them.

If you want to create marketing campaigns that stand out from your competitors and win over your prospective
clients, you need to know them on a deeper level, as opposed to a surface level.

You need to know their deepest and most primal desires.

You need to know their fears, hopes, wishes, and dreams.

You need to know what they’re thinking about, but not telling anyone.
You need to know how your clients think, feel and act.

O O OO

You can learn more about your prospective clients by answering 8 important questions!

Law Society | Barreau m Law Society | Barreau
of Ontario de I'Ontario of Ontario de I'Ontario

LAW GROUP

RudderLawGroup.ca

Question Number 1

Who are your focused set of targeted clients within a niche market?

As a solo practitioner or small law firm, you have limited resources, so it’s difficult to address every legal problem
within your area of expertise, without the possibility of spreading yourself too thin.

If you want to compete with bigger law firms, you have to zero in on a niche market, which is comprised of a
focused set of prospective clients who have their own unique needs, preferences and/or identity that’s different
from other prospective clients in the larger market.

A niche market is a subset or segment of a larger market on which your specific legal service is focused.
Focusing on a niche market brings clarity to your marketing message.

Niche marketing is important because it can:

O (1) help you corner a part of the market where few other lawyers are present; and
O (2)itcan also help you to position yourself as a specialist/expert and stand-out from other lawyers.
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Question Number 2

What are your target clients’ biggest frustrations and
challenges?

e Know your target clients’ biggest frustrations and challenges, in order to determine the right emotions to speak
to them in your marketing campaigns.

e Know the emotions behind your target clients’ challenges and frustrations they are experiencing, which can
range from ange, sadness, and fear to remorse, hope and desire for something better.

Impact on Your Marketing Campaigns

e If you're able to speak to exactly what your target clients are feeling, then you’ll be able to connect with them
emotionally, and not just on a rational level.

e If you're able to communicate to your prospective clients via your marketing campaigns that your legal services
are able to solve their biggest frustrations and challenges, then they are more likely to want to retain you as
their lawyer.
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Question Number 3

What are your target clients’ hopes, dreams, and desires?

e Know your target clients’ hopes, dreams and desires, in order to learn how to paint a vivid picture of what life
could be like after they use your legal services.

The Impact on Your Marketing Campaigns

e If you know how your legal services can help your prospective clients attain their hopes, dreams and desires,
it becomes much easier to write copy for your law firm’s website, landing pages, advertisements, and
marketing campaigns that capture the attention of your target audience.
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Question Number 4

What are your target clients’ biggest fears?

e Know the primary things that keep your target clients up at night, tossing and turning, and unable to
sleep.
o Know the things that your target clients worry about in their minds, but never tell anyone.

The Impact on Your Marketing Campaigns

e Knowing your target clients’ deepest and most primal fears is important because people are
motivated more by their pain than they are by pleasure, and are more motivated by the fear of loss
than they are by the desire to gain something.

® Therefore, communicating in your marketing campaigns how your legal services can help your target
clients address their most primal fears, can get them to act and motivate them to move towards your
creative legal solutions, and away from what they fear the most.
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Question Number 5

What are your target clients’ preferred form of communication?

e Know where your target clients want you to communicate with them, which includes, but not limited to:
O In-person communication;

Video conference;

Teleconference;

Email;

WhatsApp; and
o Messenger.

e Communicate with your target clients where they already are.

O 0O 0O

The Impact on Your Marketing Campaigns

e Articulating in your marketing campaigns how you’ll adapt to accommodate them by communicating with them
where they already are, will help to eliminate friction points or inconveniences that sometimes stop a
prospective client from completing the action of reaching out to you for a free consultation.
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Question Number 6

What phrases, exact language, and vernacular do your target clients
use?

“Enter the conversation already taking place in the customer’s mind” — Robert Collier

e Know the language and niche-specific terms being used in your clients’ mind for their hopes, dreams, pain, fears,
and desires.
e Listen to the language, phrases, and niche-specific terms they’re already using, and write them down.

e What industry terminology are your target clients using?
e What specific vernacular and niche-specific terms are your target clients using?

® People are more attracted to people and businesses who speak their language, because skepticism is rampant.

The Impact on Your Marketing Campaigns
e Ifyou're able to create marketing campaigns that’s imbued with the language, phrases and niche-specific terms
being used by your target clients’ minds, you’ll resonate with them better.
e Your target clients should be saying to themselves, “Whoa, it’s like this lawyer is talking directly to me”.

9
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Question Number 7
What does a day in your target client’s life look like?
e Know what your target clients’ daily life looks like, in order to add an incredible personal element to your
marketing campaigns.
The Impact on Your Marketing Campaigns
e It helps you make more practical decisions and answer useful questions, such as, but not limited to:
o When is the best time to email your prospective targeted clients?
o0  When in the day are they most likely to respond?
O  When are they most attentive to correspondence?
e Your prospective clients are completely different people at 9am on a Monday morning than they are at 7pm. on
a Friday evening.
O You must be aware of all of these subtle differences and use it effectively in your marketing strategy.
10

2-5



Law Society | Barreau Law Society | Barreau
of Ontario de I'Ontario of Ontario de I'Ontario

LAW GROUP
RudderLawGroup.ca

Question Number 8

What makes your target clients
happy?

Your clients” journey from being retained by your law firm, to when your law firm closes their files, is more than
the mere exchange of money for legal services.

Remember that your clients are emotional human beings, who want to interact with personable people within law
firms, and personal brands that make them feel good about themselves.

Know where the touch points are in your clients’ journey
O Ask yourself: Where can you insert surprises?
O Be prepared to do the unexpected.
o Think of how you can bring a smile to your clients’ faces.
m i.e. Updating them at every major milestone, a personalized email sent on their birthday, a
handwritten thank-you note after retaining your law firm, a free box full of company swag, etc.

Happy clients are also more inclined to leave positive reviews (i.e. Google Reviews) and make referrals.

11
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Step Number 2: WHERE?
WHERE are your prospective target clients
congregating?
WHERE do your target clients get their information?
How are your target clients going to find your law firm?
1. They're going to interact with things that interest them, where you'll interrupt them.
1. They're going to search for you using the most popular search engines, where you’ll
increase the likelihood that they find you by using popular keyword phrases.
Russell Brunson, co-founder and CEO of ClickFunnels Inc., identified two types of congregations.
1. Interested-Based Congregations.
1. Search-Based Congregations.
12
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Interest-Based Congregations

e The first type of congregation is based on interests.

Action Plan
e Start by creating worksheets that list all of the places that your clients congregate.

Social Network Worksheet: Create a column for each of the main social networks.

o Write down between 20 to 100 names (pages, groups, influencers, people, et cetera) for each social
network.

e Do the same thing for websites, forums and message boards, Facebook groups, podcasts, email newsletters,
blogs, vlogs, YouTube channels, and any other important type of congregation.

o These lists are not static, but rather organic in that they’ll continue to evolve.
® S0, you have re-create the lists periodically throughout the year by pulling off names that aren’t bringing in
the right clients and adding new names as you find them.

13
Law Society | Barreau m Law Society | Barreau
of Ontario de I'Ontario of Ontario de I'Ontario
RUDDER
LAW GROUP
Interest-Based Congregatlons
Continued
e Which websites do your target clients frequently visit?
O Brainstorm the top websites that come to your mind that they frequently visit and write them down.
e Which forums or message boards do your target clients participate in?
o Brainstorm and then write down the top forums or message boards they participate in.
e Which Facebook groups do your target clients participate in?
o  Write down the top Facebook groups they participate in and how many members are in each group.
e Which podcasts do your target clients listen to?
O Brainstorm and then write down the top podcasts they listen to.
e Which email newsletters do your target clients subscribe to?
O  Brainstorm and write down the top email newsletters they subscribe to.
e Which blogs, vlogs and YouTube channels do your target clients read and watch, respectively?
o  Write down the top blogs, vlogs and YouTube channels they read and watch, respectively.
14
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Search-Based Congregations

e The second type of congregation is based on the keyword phrases used on a search platform like Google.

e When someone goes to Google or any other search platform, they type in a keyword phrase looking for
something, such as, for example:

O  “Best personal injury lawyers near-me” — transactional keyword phrase; or

o “What to do after a motor vehicle accident?” — informational keyword phrase.

® Assoon as they type a keyword phrase, they enter an existing congregation of people searching for the same

thing.
15
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Search-Based Congregations Continued
3-Types of Keywords
Transactional Keywords
e Keywords searched by people who are ready to make a decision to retain a lawyer.
e Keywords that attract website visitors who will convert at a higher rate than other types of keywords.
o i.e. “personal injury lawyer near me”
Information Keywords
e Keywords searched by people who have questions around your areas of practice/expertise, but are not
necessarily looking for a lawyer/attorney.
o i.e. “do I need a lawyer for my car accident?” or “what is the statute of limitations for a personal
injury?”
Navigational Keywords
e Keywords used by people to navigate to a specific website.
o i.e. When someone searches for your law firm’s specific name, this is a navigational search.
16
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Search-Based Congregations Continued: Search Engine Optimization

How do you find Transactional Keywords?

® You can find popular keyword phrases that your prospective clients will use in search engines like Google, which
will increase the likelihood that they find your law firm, by using free keyword research tools such as Ubersuggest.

® You can also find these keyword phrases by using paid keyword research tools such as Moz and Ahrefs.

Number of
. Search Cost Per Paid g Mobile vs
Keyword Clicks on SEO Volume Click Difficulty SEO Difficulty Desktop
Results
. M:120,000
Personal Injury Lawyer 27,375 110,000 $126.00 34 55 D: 56,000

e You want to include the top transactional and informational keywords on your website and marketing content.

17
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Step Number 3: WHAT?
WHAT medium do you use to market your specific legal services to your target
clients?
1. Paid-Traffic . . . .
. 2. Owned-Traffic Marketing 3. Earned-Traffic Marketing
Marketing
e Invest of your time. e Invest of your time or
e Invest of your money.
your money, or both.
18
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Paid-Traffic Marketing

e Paid-traffic marketing refers to ad spots that you pay for, such as on search engine results pages (SERP) and

social network websites, similar to how you would pay to purchase ad space in a print publication.

e Some law firms prefer paid media because it allows them to target the exact type of audience they’re looking
to engage with. (i.e. FaceBook tracks over 50,000 data points on each user as they are using their platform).

e Examples of methods that generate paid traffic include, but are not limited to:

Pay Per Click Google Ads;

Paid social network ads on sites like LinkedIn, Facebook, Instagram, et cetera;
Web banners displayed on affiliate websites;

Pay Per Click ads placed on sites your target clients frequent; and

Influencer marketing.

O O O 0O

e It'simportant to set a budget for your paid advertising.

e What do you do if you are a solo practitioner or small law firm, and you can’t afford paid-traffic marketing?

19
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Owned-Traffic
e Owned-traffic marketing doesn’t require a significant investment of your money, but rather an investment
of your time.
e |t comes from the creation of your owned assets, such as, but not limited to, the following:
o Your law firm’s social network websites (LinkedIn, Facebook, Instagram, TikTok, Pinterest, Twitter,
Snapchat, et cetera) that link back to your law firm’s website;
o Your law firm’s blog that’s located on your law firm’s website;
o Your law firm’s vlog that’s located on your law firm’s website;
o Your law firm’s YouTube channel that links back to your law firm’s website;
o Your law firm’s podcast that links back to your law firm’s website;
o Your law firm’s email newsletters that links back to your law firm’s website;
o Your law firm’s webinars that’s either located on, or links back to, your law firm’s website; and
o Any other content you created that’s housed on your law firm’s website.
20
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Owned-Traffic Marketing and Building Your Personal Brand

® You grow your owned-traffic organically through strategic and creative practices, which doesn’t require a
huge budget, but rather the development of your personal brand and the use of effective storytelling.
o Astrong personal brand helps you and your message cut through the noise online.

e The common trait between successful people on social network websites is their use of the power of
building a personal brand. Consider the following 3 LinkedIn examples:

O Gary Vee: 5 million followers (personal brand) vs. Vayner Media: 195,000 followers (corporate brand)
o Bill Gates: 35 million followers (personal brand) vs. Microsoft: 20 million followers (corporate brand)

® As asolo practitioner or small law firm, one of the advantages you have over larger law firms is your ability

to build a strong personal brand that effectively tells your unique and authentic story, which resonates with
people on a deeper, human level.

O  Your prospective clients will connect with your personal brand quicker than they will connect with
your corporate brand.
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Earned-Traffic Marketing
e Earned-Traffic Marketing comes from web content produced by third party sources.
® It can be stimulated by your owned media because someone might see your organic content and then share
your information about your law firm via digital word of mouth to their respective audiences.
e Examples of earned traffic stimulated by your owned media include, but not limited to:
o Actively doing speaking engagements for popular organizations with huge followings, that mention
your law firm and link back to your law firm’s website.
o  Writing books, legal journal articles, blogs and writing for other online publications that include links
back to your law firm’s website.
O Interviews or mentions in major newspapers, legal magazines, podcasts, blogs, vlogs, et cetera that
include links to your law firm’s website.
O Press mentions, like listicles or reviews written by legal industry influencers that rate or suggest your
law firm.
o Awards to your law firm for legal excellence in reputable legal magazines that link back to your law
firm’s website.
22
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Earned-Traffic Marketing equals Earned
Respect

e Social Proof

o  When you engage in earn-traffic marketing and reputable organizations (i.e. newspapers,
magazines, governing bodies/agencies, journals, book publishers, industry influencers, et cetera)
are mentioning you, writing about you, interviewing you, reviewing you, recommending you, and
linking back to your website, they’re not just redirecting traffic to your website, but they are also
vouching for you and making it easier for prospective clients to choose you.

o Ifyou tell a client how great you are, it comes off as bragging, but if a respected and trusted third
party says you’re great, it comes off as authentic validation in the eyes of your prospective clients.

e Authority

o When a trustworthy third party publicly states that you’re an authority in your area of expertise, it
influences the way your prospective clients view you, and ultimately, their decision to retain you as
their lawyer.

23
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Give Value and Know your Law Firm’s WHY

Give Value
o The focus of the strategic marketing content that you create for your law firm to attract prospective
clients should be on giving value to them.

o Freely give information to your prospective clients that answers their legal questions and
educates them, and they will reciprocate in some shape or form.

o The Rule of Reciprocation: “The rule requires that one person try to repay, in form, what another
person has provided” — Dr. Robert B. Cialdini, Influence: The Psychology of Persuasion

Know Your Law Firm’s WHY
e If you want to engage in effective storytelling, then you must know the WHY behind your law firm's
purpose, not only for your mission statement, but for your entire law firm’s story.

O  Providing the WHY of your law firm’s story gives your prospective clients a way to connect with
you on a personal level and view your law firm as a living, breathing entity.

24
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The Modern Lawyer’s Marketing Blueprint

17th Solo and Small Firm Conference: Secrets for Success

Andrew Leroy Rudder

RudderLawGroup.ca

Step Number 1: WHO?

Identifying who your target clients are that want to utilize your legal services.

Who are your target clients that want to utilize your legal services?

Just like how a speaker wants to know who his or her audience is before taking the stage, in order to
know how to finetune the delivered message so it resonates with them better, you must also know who

your target clients are in order to finetune your marketing campaigns to them better.

Prior to any successful marketing campaign, you must first take a deep dive into really knowing your

prospective clients, in order to tailor your marketing message directly to them.

If you want to create marketing campaigns that stand out from your competitors and win over your
prospective clients, you can’t just know who your target clients are on a surface level, such as, for
example, people injured in motor vehicle accidents. You need to know them on a much deeper,

substantive level.

You need to know their deepest and most primal desires.

You need to know their fears, hopes, wishes, and dreams.

You need to know what they’re thinking about, but not telling anyone.

You need to know how your prospective clients think, feel and act.

Here are eight questions to ask yourself, in order to know your target clients on a much deeper level.
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Questions Number 1

Who are your focused set of targeted clients within a niche market?

As a solo practitioner or small law firm, you have limited resources, so it’s difficult to address every legal

problem within your area of expertise, without the possibility of spreading yourself too thin.

If you want to compete with bigger law firms that have much more resources and a larger marketing
budget, then you have to zero in on a niche market, which is comprised of a focused set of prospective
clients who have their own unique needs, preferences and/or identity that’s different from other

prospective clients in the larger market.
A niche market is a subset or segment of a larger market on which your specific legal service is focused.

For example, I’'m a solo practitioner and personal injury lawyer, who chose to focus primarily on clients

with catastrophic impairments, which is a subset or segment of the larger personal injury market.

| cannot afford to address everyone’s personal injury law problem, especially in today’s market
conditions where the media we use to reach our clients is so highly fragmented. If Rudder Law Group is
going to compete with the bigger personal injury law firms, | have to zero in on my niche client, AKA,

catastrophically impaired clients. Specificity is key and of the utmost importance.

And while defining my target client might seem, prima facie, like I’'m excluding other prospective clients
who might retain me as their lawyer, keep in mind that targeting a specific client doesn’t mean | have to
exclude anyone who doesn’t fit the criteria of a catastrophically impaired insured as a result of a motor

vehicle accident. However, focusing on a niche market brings clarity to your marketing message.
Niche marketing is important because it can:

1. Help you corner a part of the market where few other lawyers are present; and

2. It can also help you to position yourself as a specialist/expert and stand-out from other lawyers.
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Question Number 2

What are your target clients’ biggest frustrations and challenges?

Knowing your target clients’ biggest frustrations and challenges is important, in order to determine the

right emotions to speak to them in your marketing campaigns.

You have to know the emotions behind your target clients’ challenges and frustrations they are
experiencing, which can range from anger, sadness, and fear to hope, remorse, and a burning desire for

something better.

Impact on Your Marketing Campaigns
If you’re able to speak to exactly what your target clients are feeling, then you’ll be able to connect with

them emotionally, and not just on a rational level.

If you’re able to communicate to your prospective clients via your marketing campaigns that your legal
services are able to solve their biggest frustrations and challenges, then they are more likely to want to

retain you as their lawyer.

It will also reflect the types of stories you tell in your marketing campaigns.

Furthermore, when your prospective clients see a testimonial from one of your former clients, whose
biggest frustrations and challenges were solved by your legal services, then they will be able to see the

positive transformation that took place in someone else in a similar situation, and they’ll be more likely

to want to retain you as their lawyer.
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Question Number 3

What are your target clients’ hopes, dreams, and desires?

Knowing your target clients’ hopes, dreams and desires is important, in order to learn how to paint a

vivid picture of what life could be like after they use your legal services.

The Impact on Your Marketing Campaigns
If you know how your legal services can help your prospective clients attain their hopes, dreams and
desires, it becomes much easier to write copy for your law firm’s websites, landing pages,

advertisements, and marketing campaigns that capture the attention of your target audience.

Question Number 4

What are your target clients’ biggest fears?

You have to know the primary things that keep your target clients up at night, and unable to sleep. You
have to know the things that your target clients worry about in their minds, but never speak out loud

and never tell anyone.

The Impact on Your Marketing Campaigns
Knowing your target clients’ deepest and most primal fears is important because people are motivated
more by their pain than they are by pleasure, and are more motivated by the fear of loss than they are

by the desire to gain something.
Therefore, communicating in your marketing campaigns how your legal services can help your target

clients address their most primal fears, can get them to act and motivate them to move towards your

creative legal solutions, and away from what they fear the most.
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Question Number 5

What are your target clients’ preferred form of communication?

You have to know where your target clients want you to communicate with them, which includes, but

not limited to, the following:

® |n-person communication;
e Video conference;

e Teleconference;

e Email;

e WhatsApp; and

® [Messenger.

Learn how to communicate with your target clients where they already are, because if you don’t, then

they will move on to another law firm that is more convenient for them.

The Impact on Your Marketing Campaigns

Articulating in your marketing campaigns how you’ll adapt to accommodate them by communicating
with them where they already are, will help to eliminate friction points or inconveniences that
sometimes stop a prospective client from completing the action of reaching out to you for a free

consultation.

Question Number 6

What phrases, exact language, and vernacular do your target clients use?

“Enter the conversation already taking place in the customer’s mind” — Robert Collier
You have to know the language and niche-specific terms being used in your clients’ mind for their hopes,

dreams, pain, fears, and desires. Learn to listen carefully to the language, phrases, and niche-specific

terms that your target clients are already using, and write them down. Don’t be afraid to take specific
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comments from such places as, but not limited to, Reddit, FaceBook Groups, or YouTube, and document
your target clients’ word-for-word responses for strategic use in the content of your future marketing

campaigns.

Ask yourself these two questions:

e What industry terminology are your target clients using?; and

e What specific vernacular and niche-specific terms are your target clients using?

People are more attracted to people and businesses who speak their language.

The Impact on Your Marketing Campaigns
If you're able to create marketing campaigns that’s imbued with the language, phrases and niche-
specific terms being used by your target clients’ minds, you’ll resonate with them better. Your target

clients should be saying to themselves, “Whoa, it’s like this lawyer is talking directly to me”.

Question Number 7

What does a day in your target client’s life look like?

Knowing what your target clients’ daily life looks like is important, in order to add an incredible personal

element to your marketing campaigns.

The Impact on Your Marketing Campaigns
It helps you make more practical decisions and answer useful questions, such as, but not limited to, the

following:

e When is the best time to email your prospective targeted clients?;

e When in the day are they most likely to respond?; and
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® When are they most attentive to correspondence?

Remember that your prospective clients are completely different people at 9am on a Monday morning
just after the weekend than they are at 7pm. on a Friday evening just before the weekend. You must be

aware of all of these subtle differences and use it effectively in your marketing strategy.

Question Number 8

What makes your target clients happy?

Your clients’ journey from being retained by your law firm, to when your law firm closes their files, is
more than the mere exchange of money for legal services. Remember that your clients are emotional
human beings, who want to interact with personable people within law firms, and personal brands that

make them feel good about themselves.
You have to know where the touch points are in your clients’ journey.

Ask yourself the following: Where can | insert surprises? Be prepared to do the unexpected. Think of

how you can bring a smile to your clients’ faces, such as, but not limited to, the following:

e Updating them at every major milestone;

e Sending a personalized email to them on their birthdays;

e Sending a handwritten thank-you note to them after they retain your law firm; and/or
e Providing a free box full of company swag.

Happy clients are also more inclined to leave positive reviews (i.e. Google Reviews) and make referrals.
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Step Number 2: WHERE?

Ask yourself these two important questions:
e WHERE are your prospective target clients congregating?
e WHERE do your target clients get their information?
Knowing exactly where your target clients are hanging out influences a lot of things, which range from

where you should advertise and what you should advertise, to the specific tone of your copy and the

particular vernacular you use in your marketing campaigns.

How are your target clients going to find your law firm?
They’re going to either:

1. Interact with things that interest them, where you’ll interrupt them; or

2. They're going to search for you using the most popular search engines, such as Google and

YouTube, where you'll appear in their searches by using the right keyword phrases.

Russell Brunson, co-founder and CEO of ClickFunnels Inc., identified two types of congregations, as

follows:
e Interested-Based Congregations; and

e Search-Based Congregations.
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Interest-Based Congregations

The first type of congregation is based on interests.

Action Plan

Start by creating worksheets that list all of the places that your clients congregate.

Create a social network worksheet, and include a column for each of the main social networks. Write

down between 20 to 100 names (pages, groups, influencers, people, et cetera) for each social network.

Do the same thing for websites, forums and message boards, FaceBook groups, podcasts, email
newsletters, blogs, vlogs, YouTube channels, and any other important type of congregation. These lists
are not static, but rather organic in that they’ll continue to evolve. So, you have to re-create the lists two
to three times per year by pulling off names that aren’t bringing in the right clients and adding new

names as you find them.
Which websites do your target clients frequently visit?
e Brainstorm the top websites that come to your mind that they frequently visit and write them

down.

Which forums or message boards do your target clients participate in?

® Brainstorm and then write down the top forums or message boards they participate in.

Which FaceBook groups do your target clients participate in?

® Brainstorm and write down the top FaceBook groups they participate in and how many

members are in each group.

Which podcasts do your target clients listen to?

® Brainstorm and then write down the top podcasts they listen to.

2-22



Which email newsletters do your target clients subscribe to?

® Brainstorm and write down the top email newsletters they subscribe to.

Which blogs, vlogs and YouTube channels do your target clients read and watch, respectively?

e Write down the top blogs, vlogs and YouTube channels they read and watch, respectively.

Search-Based Congregations

The second type of congregation is based on the keyword phrases used on a search platform like

Google.

When someone goes to Google or any other search platform, they type in a keyword phrase looking for

something, such as, but not limited to, the following:
® “Best personal injury lawyers near-me” — transactional keyword phrase; or
e “What to do after a motor vehicle accident?” — informational keyword phrase.

As soon as they type a keyword phrase, they enter an existing congregation of people searching for the

same thing.

These searches can occur on (1) Google, Yahoo, and YouTube.com, where people search for videos, (2)
Pinterest, where people search for images, (3) Quora.com, where people can ask questions on any topic,

or (4) any other search platform.

10
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Three Types of Keywords

Transactional Keywords
These are keywords searched by people who are ready to decide to retain a lawyer. They attract website
visitors who will convert at a higher rate than other types of keywords. An example of a transactional

keyword phrase is: “personal injury lawyer near me”.

Information Keywords
These are keywords searched by people who have questions around your areas of practice and/or
expertise, but are not necessarily looking for a lawyer. Examples of information keywords are: “do | need

a lawyer for my car accident?” or “what is the statute of limitations for a personal injury?”

Navigational Keywords
These are keywords used by people to navigate to a specific website. An example of a navigational

keyword is when someone searches for your law firm’s specific name.

How do you find the most popular transactional keyword phrases?

You can find popular keyword phrases that your prospective clients will use in search engines like
Google, which will increase the likelihood that they find your law firm, by using free keyword research
tools such as Ubersuggest. You can also find these keyword phrases by using paid research tools such as

Moz and Ahrefs.

When you use the aforementioned keyword research tools, you’ll obtain a wide range of data from
search volume, cost per click and SEQ difficulty, to paid difficulty, number of clicks on SEO results, and a

breakdown of the searches from both mobile and desktop devices.

11
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Here is an example of data | organized using Ubersuggest to search for personal injury related keyword

phrases:

Keyword Research — Organizing the Data

Number of
Cost Per SEO Paid
Subject Keyword Search Volume Clicks on
Click Difficulty | Difficulty
SEO Results
Car Accident Car Accident Lawyer 110,000 $127.33 46 27 34,492
Catastrophic Catastrophic Injury
1,600 $0.00 31 2
Impairment Accident Lawyer
Wrongful Death
Wrongful Death Lawyer 14,800 $95.07 49 5 7,400
Accident
Slip and Fall Accident| Slip and Fall Lawyer 18,100 $99.94 18 26
Pedestrian Accident
Pedestrian Accident 6,600 $2.60 15 1
Lawyer
Cyclist Accident Cyclist Accident Lawyer 390 $0.00 19 18
Assault Assault Lawyer 1,600 $68.75 42 38
Personal Injury Law | Personal Injury Lawyer 110,000 $126.00 55 34 27,375
Car Accident Lawyer
Car Accident 18,900 $123.53 51 58 2,413
near me
Catastrophic
Catastrophic
Impairment 50 $10.75 41 1
Impairment Accident
Settlement Ontario
Wrongful Death | Wrongful Death Lawyer
720 $76.33 52 53
Accident near me
Slip and Fall Accident
Slip and Fall Accident 4,400 $193.84 9 8
Lawyer
Pedestrian Accident Pedestrian Accident 201 $4.97 43 10
12
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Cyclist Accident

Assault

Personal Injury Law

Truck Accident

Car Accident

Car Accident

Personal Injury Law
Personal Injury Law

Wrongful Death

Accident

Slip and Fall Accident

Pedestrian Accident
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Lawyer near me
Bicycle Accident Lawyer
Assault Lawyer near me

Personal Injury Lawyer

near me
Truck Accident Lawyer
Vehicle Accident Lawyer

Motor Vehicle Accident

Lawyer
Personal Injury Attorney
Car Accident Attorney

Wrongful Death

Attorney
Slip and Fall Attorney

Pedestrian Accident

Attorney

5,400

590

22,000

33,100

720

880

74,000

60,500

8,100

9,900

6,660

13

$8.14

$58.56

$68.66

$203.79

$400.00

$68.63

$66.68

$114.25

$119.71

$146.39

$101.96

15

52

53

24

57

49

68

49

45

15

16

73

64

56

25

24

33

35

24

325

11,684

15,921

2,700

4,950



Step Number 3: WHAT?

WHAT medium do you use to market your specific legal services to your target clients?

1. Paid-Traffic Marketing;
2. Own-Traffic Marketing; and
3. Earned-Traffic Marketing.

Paid-Traffic Marketing

Paid-traffic marketing refers to ad spots that you pay for, such as on search engine results pages (SERP)

and social network websites, similar to how you would pay to purchase ad space in a print publication.

Some law firms prefer paid media because it allows them to target the exact type of audience they’re
looking to engage with.
e For example, FaceBook automatically tracks over 50,000 data points on each user as they are
using their platform, which enables you to target very specific demographics with your

marketing campaigns.
Examples of methods that generate paid traffic include, but are not limited to, the following:

e Pay Per Click Google Ads;

e Paid social network ads on sites like LinkedIn, FaceBook, Instagram, et cetera;
e Web banners displayed on affiliate websites;

e Pay Per Click ads placed on sites your target clients frequent; and

e Influencer marketing.

It’s important to set a budget for your paid advertising.

14
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What do you do if you are a solo practitioner or small law firm, and you can’t afford paid-
traffic marketing?

ANSWER: Owned-Traffic Marketing and Earned-Traffic Marketing

Owned-Traffic Marketing

Owned-traffic marketing doesn’t require an investment of your money, but rather an investment of your

time.

It comes from the creation of your owned assets, such as, but not limited to, the following:

Your law firm’s social network websites (LinkedIn, FaceBook, Instagram, TikTok, Pinterest,
Twitter, Snapchat, et cetera) that link back to your law firm’s website;

e Your law firm’s blog that’s located on your law firm’s website;

e Your law firm’s vlog that’s located on your law firm’s website;

e Your law firm’s YouTube channel that links back to your law firm’s website;

e Your law firm’s podcast that links back to your law firm’s website;

e Your law firm’s email newsletters that links back to your law firm’s website;

e Your law firm’s webinars that’s either located on, or links back to, your law firm’s website; and

® Any other content you created that’s housed on your law firm’s website.

Owned-Traffic Marketing and Building Your Personal Brand

You grow your owned-traffic organically through strategic and creative practices, which doesn’t require
a budget, but rather the development of your personal brand and the use of effective storytelling. It

helps you and your message cut through the noise online.

15
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The common trait between successful people on social network websites is their use of the power of
building a personal brand. Here are examples of the power of personal branding over corporate

branding:

e Gary Vaynerchuk: 5 million LinkedIn followers (personal brand) versus Vayner Media: 195,000

LinkedIn followers (corporate brand); and

o Bill Gates: 35 million LinkedIn followers (personal brand) versus Microsoft: 20 million LinkedIn

followers (corporate brand).

As a solo practitioner or small law firm, one of the advantages you have over larger law firms is your
ability to build a strong personal brand that effectively tells your unique and authentic story, which
resonates with people on a deeper, human level. Your prospective clients will connect with your

personal brand quicker than they will connect with your corporate brand.

Earned-Traffic Marketing

Earned-traffic marketing comes from web content produced by third party sources. It can be stimulated
by your owned media because someone might see your organic content and then share your

information about your law firm via digital word of mouth to their respective audiences.
Examples of earned traffic stimulated by your owned media include, but not limited to, the following:

e Actively doing speaking engagements for popular organizations with huge followings, that
mention your law firm and link back to your law firm’s website;

e Writing books, legal journal articles, blogs and writing for other online publications that include
links back to your law firm’s website;

e Interviews or mentions in major newspapers, legal magazines, podcasts, blogs, vlogs, et cetera
that include links to your law firm’s website;

® Press mentions, like listicles or reviews written by legal industry influencers that rate or suggest

your law firm; and

16
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e Awards to your law firm for legal excellence in reputable legal magazines that link back to your

law firm’s website.

Earned-Traffic Marketing equals Earned Respect

Social Proof

When you engage in earn-traffic marketing and reputable organizations (i.e. newspapers, magazines,
governing bodies/agencies, journals, book publishers, industry influencers, et cetera) are mentioning
you, writing about you, interviewing you, reviewing you, recommending you, and linking back to your
website, they’re not just redirecting traffic to your website, but they are also vouching for you and

making it easier for prospective clients to choose you.

If you tell a client how great you are, it comes off as bragging, but if a respected and trusted third party

says you’re great, it comes off as authentic validation in the eyes of your prospective clients.

Authority

When a trustworthy third party publicly states that you’re an authority in your area of expertise, it
influences the way your prospective clients view you, and ultimately, their decision to retain you as their

lawyer.

17
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Give Value and Know your Law Firm’s WHY

Give Value
The focus of the content that you create for your law firm to attract prospective clients should be on

giving value to them.

Freely give information to your prospective clients that answers their legal questions and educates

them, and they will reciprocate in some shape or form.

The Rule of Reciprocation: “The rule requires that one person try to repay, in form, what another
person has provided” — Dr. Robert B. Cialdini, Influence: The Psychology of Persuasion

You also elevate your status as an authority figure when you educate people, because you are placed in

the role of the teacher and your audience is placed in the role of students.

Know Your Law Firm’s WHY
If you want to engage in effective storytelling, then you must know the WHY behind your law firm’s

purpose, not only for your mission statement, but for your entire law firm’s story.
Here are some questions that you can answer to help you discover your law firm’s WHY:

e What inspired your idea to start your law firm?;

e What is unique and intriguing about your law firm?;

e What is interesting and intriguing about the founding story of your law firm?;

e What unique legal problems is your law firm trying to creatively solve?;

e What is the purpose of your law firm?;

e How has your law firm evolved from its humble beginnings to the present day?; and

e |s there a specific social justice issue or noble cause that your law firm fights for and supports?

Providing the WHY of your law firm’s story gives your prospective clients a way to connect with you on a

personal level and view your law firm as a living, breathing entity.

18
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Contact Me for Further Information

| hope you found this information and gained some value from it.

If you want to learn more, or if you have any further questions, then please don’t hesitate to contact me

at andrew@rudderlawgroup.ca, or visit my website at www.RudderLawGroup.ca to book a free

consultation.

Thank you!

19
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The Modern Lawyer’s
Marketing Blueprint

About Romesh

* Signal Lawyers

* Business Owners

» Solve Problems In and Out
of Court

* Lawtrepreneur
* Helps Solo Lawyers
* Modernize Legal Practices

* Help 1,000 Lawyers Manage
Legal Practice From Phone
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About The
Marketing
Blueprint

Lawtrepreneur provides solo
and small firm lawyers the
learning experiences and
support they need to design
processes and integrate
technology into their business.

As a result, our members are
better able to deliver more
value to clients, be more
productive and live more
balanced lives.

Foundation For Marketing Initiatives

* Value Propositions
* Client Journeys

» Key Advisors To Inform Decisions

Key Learning Outcomes

» Create A Value Proposition For Your Practice
* Design a Customer Journey

* |dentify Your Supports

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

An Introduction To Value
Propositions
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Understanding Essential for effective marketing &
Value Propositions  sales strategies.

* The benefits of your service.
* The solutions you offer.
* What makes you different from competitors.

Key Elements

Value Propositions are the » Clear, concise, and compelling

reasons why customers « Audience Centric
choose to support your
practice over others. « Addresses A Problem

* Focuses on Outcome
« Credible

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

Key Elements Of What problems are What solution are you

ou solving? offering?
Your Value Y d °

Y » Client centric + Standalone

Propositions

* Emotional * Retainer

* Financial * Fixed Fee

* Intangible * Practice Area

Who are you solving Why should a customer

When answering these those problems for? choose you over others?
questions, consider who
your ideal clients are and + Gender * Cost

what solutions those clients

are looking for. * Demographics * Quality
* Money * Security
+ Geography + Feelings

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.
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Value Proposition
Template

This is just one of many
templates for a value
proposition statement.

Feel free to experiment with
placeholders to create a
statement that feels
authentic to you.

helps deal with
by providing . Our clients
trust us because .

Lawtrepreneur helps [solo and small firm
lawyers] [deliver more value to clients, practice
more efficiently and live more balanced lives.]

We do so by [providing the virtual learning
experiences and support our clients need to
design processes and integrate technology into
their business.]

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

Defining Your Client
Journey Experience
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The Importance Of  Helpsyou:
Client Jou rneys » Anticipate the needs and expectations of your clients.

» Identifies specific touchpoints where clients need extra

attention.
Benefits

* Address potential pain points or bottlenecks in the

process

Your client journey is the * Better Marketing Initiatives

sum of the various » Helps Identify Opportunities for upselling or cross-selling
interactions and services.

experiences between you

i * Set expectations for clients and ensure that they are
and your client.

satisfied with the services provided.

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

Key Phases In A
Client Journey

How Clients

How Clients Use You How Clients
Find You (How You Serve Remember You
Clients)

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.
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Key Phases In A
Client Journey

How Clients

How Clients Use You How Clients
Find You (How You Serve Remember You
Clients)

Where do potential clients What promises do you How do you treat clients after

first hear about you?
How do potential clients
first contact you?
How do potential clients
become clients?

make to clients?

How often do you
communicate with clients?
How do clients expect you
to communicate to others?

services are finished?

Do you keep a relationship
with previous clients?
What incentives do you give
clients to remmember you?

Copyright 23 Lawtrepreneur Inc. All Rights Reserved.

Key Phases In A

Client Journey

How Clients
Find You

Where do potential clients
first hear about you?
How do potential clients
first contact you?
How do potential clients
become clients?

2-38

How Clients
Use You
(How You Serve
Clients)

How Clients
Remember You

What promises do you
make to clients?
How often do you
communicate with clients?
How do clients expect you
to communicate to others?

How do you treat clients after

services are finished?

Do you keep a relationship
with previous clients?
What incentives do you give
clients to remember you?

2023 Lawtrepreneur Inc. All Rights Reserved.




How Potential Clients
Find You

The Core Question

How does a potential
client first learn about
your legal services?

How do clients find out about you?
What do your ideal clients read/watch/listen/do?

Where are the opportunities to be part of those

activities?

Newspapers » Digital Advertising
Radio » Social Media

TV * Webinars

« Email Lists

* Online Referrals

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

14

How Are You
Retained

The Core Question
How does someone
become a client after
they first contact you?

What is your sales process?
Who is accountable?

How do you follow up?

Walk ins * Intake Form
Phone calls « |nitial Call
Email « Strategy Sessions

14
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Key Phases In A
Client Journey

How Clients
How Clients Use You How Clients
Find You (How You Serve Remember You
Clients)
Where do potential clients What promises do you How do you treat clients after
first hear about you? make to clients? services are finished?
How do potential clients How often do you Do you keep a relationship
first contact you? communicate with clients? with previous clients?
How do potential clients How do clients expect you What incentives do you give
become clients? to communicate to others? clients to remember you?

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

How Clients “Use” .
* How do you communicate?

You * When do you communicate?

* Tone of communications

The Core Question * Retainer * Bcc on Emails
H(,DW do you serve your * Milestones » Video conferences
clients?

* Closing Letter » Transcripts

e Call Summaries

* Newsletter

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.
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Key Phases In A
Client Journey

How Clients
How Clients Use You How Clients
Find You (How You Serve Remember You
Clients)
Where do potential clients What promises do you How do you treat clients after
first hear about you? make to clients? services are finished?
How do potential clients How often do you Do you keep a relationship
first contact you? communicate with clients? with previous clients?
How do potential clients How do clients expect you What incentives do you give
become clients? to communicate to others? clients to remember you?

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

How Clients

* How do you communicate?
Remember You .

* When do you communicate?

* Tone of communications
The Core Question + Closing Letter + Surveys
What does your client « Newsletter

experience after services

are completed? * Webinars

* Review Requests

18
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Your Modern

Marketing Advisors

20

External Brand
Advisors

2-42

Begin curating a set of professional images that
best represents you and your business visually.

Informs the improvement, redesign or reimagining
of your professional image so you are better able to

attract your ideal clients.

Helps build a stronger presence on social media

and through other forms of digital communication.

Helps maintain your online presence - often, the
first point of contact for your client.

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.
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Internal
Advisors

Supports the integration of automation into your
legal practice.

Helps design more efficient processes and
choosing the most appropriate technology for your
legal practice.

Helps build a stronger presence on social media
and through other forms of digital communication.

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

Lawtrepreneur helps solo and Looking to learn how to use
small firm lawyers deliver more ChatGPT in your practice?

value to clients, practice more

efficiently and live more Discover how to use Al to enhance

balanced lives. your practice, become more efficient
and be more profitable with our

We do so by providing the virtual ChatGPT Toolkit for Solo Lawyers.

learning experiences and support

our clients need to design Click to learn more:

processes and integrate go.lawtrepreneur.co/chatgptkit

technology into their business.

lawtrepreneur.co
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. helps
Crafting Your
Value deal with
Proposition
by providing

As a result, our clients benefit because
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Defining Your First, list the various

interactions you currently
have with clients after you

Client jou rn ey finish providing legal services

to that client.

Then, consider how you want
these clients to remember
This is one approach you you and your services after
can adopt when mapping completed.
one aspect of the journey
your client takes in your
practice.
Consider replicating this Feel free to use a separate
approach for each phase of piece of paper.
interactions you have with
your clients.

Lastly, list the things you can
do to foster these feelings.

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.

Identifying Your
Key Marketing
Advisors

Your marketing advisors are
the professionals you rely on
to connect and build
relationships with your ideal
clients and/or customers.

Copyright © 2023 Lawtrepreneur Inc. All Rights Reserved.
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Lawtrepreneur helps solo and
small firm lawyers deliver more
value to clients, practice more
efficiently and live more
balanced lives.

We do so by providing the virtual
learning experiences and support
our clients need to design
processes and integrate
technology into their business.

lawtrepreneur.co

Looking to learn how to use
ChatGPT in your practice?

Discover how to use Al to enhance
your practice, become more efficient
and be more profitable with our
ChatGPT Toolkit for Solo Lawyers.

Click to learn more:

go.lawtrepreneur.co/chatgptkit
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Implementing Legal Tech

and Getting Buy-in From Your Team

Choose your product leader gﬁ% Outline your project details
to manage the process and

including deadlines, tasks,
keep things on track.

and workflows.

Who's your leader? Why? What are the highest priority tasks?

Demo the new software ﬁ

to showcase its benefits
to your team.

Appoint a tech leader

to stay up to date on current

How will this new software benefit the firm? Who is your tech leader? Why?

technology and future needs.

Pick your project champion W

to help generate excitement
and get buy-in from your team.

Who's your champion. Why?

[=]
s
[=]

Get more details on

:ﬁ

=
o

best practices for

implementing new
tech in chapter 5 of

our Complete Guide
to Legal Tech!
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Pride and Pronouns
Navigating Diversity +

Presenters:

* Milena Soczka, Manager of Legal Services North(east) District

* Renée Fuchs, Staff Lawyer at Legal Aid Ontario

ijectives

The objective is for us, as legal professionals, to be more inclusive when interacting
with people who do not fall into the broader cis gender heteronormative category of
people. This includes a discussion on how to possibly signal your allyship, respect
and/or acceptance, including through the use of gender neutral language when and
where appropriate. We intend to cover material that should allow you to:

= Explain what gender identity means.
= Use gender neutral language.

= Have a better understanding of concepts relating to the 2SLGBTQ+ community
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So...Which
one of you
is the fork?

The Genderbread Person.. s pomaumadeds

~~Attraction

@) means a lck of what's on the
€ CGender Identity Ex i Hg Anatomical Sex
- \NOMAN-NESS Femininity - Female-ness
> Man-ness Masculinity — Male-ness
Sex Assigned At Birth
[ Female [ Intersex [ Male
QP Sexually Attracted to..  and/or (/o) QP Romantically Attracted to.
> Women a/0 Feminine a/0 Female People > Women /0 Feminine a/0 Female People
> Men a/0 Masculine a/0 Male People > Men a/0 Masculine 2/0 Male People

Genderbread Person Version 4 created and uncopyrighted 2017 by Sam Kilerman  (EZEEERE SR ISR TEaR TR S S IR I
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Definitions

OPS Bilingual Glossary on gender identit

TereeeeeerTRRTT

Transgender Non-Binary
Refers to a person whose gender Refers to a person whose gender
identity differs from the one identity does not align with the binary
associated with their birth-assigned concept of gender such as man or
sex. woman.

20% of the trans community have non-binary identities.

Transsexual

A person who has a desire or has had
treatment to make their physical
appearance more consistent with their
gender identity.

Did you know?

* 11% of LGBTQ+ adults and 26% of youth are non-binary (Williams Institute/Trevor Project)

* Non-binary youth who reported that “no one” respected their pronouns had more than 2.5x the
rate of attempting suicide compared to those who reported that “all or most of the people” they

know respected their pronouns (Trevor Project)

* 35% of youth know someone who uses gender-neutral pronouns (Pew research institute)

* 17% of youth assigned male at birth are non-binary (Trevor Project)

* 28% of assigned female at birth are non-binary (Trevor Project)
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https://www.sdc.gov.on.ca/sites/mgcs-onterm/Documents/GenderIdentity/GIgloss.pdf

What is gender neutral language?

———

= Gender-neutral language is language that avoids
bias toward a particular sex or social gender.

= You can refer to individuals without assuming their
gender and without assuming they are men or
women.

Why gender neutral language important?

= Gender neutral language is important when communicating or writing about clients because it
is more accurate, respectful and is consistent with the values of equality recognized in the
Canadian Charter of Rights and Freedoms.

= |n 1985, the Government of Ontario adopted an official policy of using gender-neutral language
in all official publications.

= The purpose of gender-neutral language is to avoid word choices which may be interpreted as
biased, discriminatory or demeaning by implying that one sex or social gender is the norm.



https://www.canada.ca/en/canadian-heritage/services/how-rights-protected/guide-canadian-charter-rights-freedoms.html

Using gender neutral language

Listen Mirror and Match

Ask questions

Observe and listen to the Identify one of th? C|i€.ﬂt s key words_ You may ask indirect questions
client s verbal cues: you heard; and mirror it back when it s 26
= Keywords Is your turn to speak. = can | refer to you by your first
= Phrases name?; or
how would you prefer that |
address you?

Yo

Gender neutral pronouns

When you must use a gender specific pronoun, use the term preferred or considered
appropriate by the client. In English, the terms below are used:

QA OAQA

However, the French language does not offer this flexibility (however, there are folks
working on it! In November 2021, the widely used French dictionary Le Robert added
the non-binary pronoun “iel” to its online edition)

A brief article on the progress being made with respect to the French language and pronouns:
https://blog.lingoda.com/en/french-gender-neutral-pronouns/

Your listening skills are key and the best option is to mirror the client during the
interaction.

10
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She/He/Herself/Himself
Her/Him
Hers/His

Husband/wife

Common law husband/wife

Daughter/son

Gender neutral terms

Instead of

Use

They, Themself
Them
Theirs

Spouse, partner, other party, any person
(or any number of less formal, gender neutral
alternatives)

Spouse, partner, other party, any person
(or any number of less formal, gender neutral
alternatives)

Child/children/offspring
(or any number of less formal, gender neutral
alternatives)

11

THE RICHNESS OF PRONOUNS

There are more pronouns than you may think...

zim

12
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Avoid assumptions

= Are you making any unconscious assumptions about a person’s gender based on their name?

Consider the long list of gender neutral (unisex) names you are already familiar with...

= Are you speculating that gender based on the person’s name or tone of voice?

Instead of making assumptions:

WA Ask a person or client about their gender
identification.

= Rework anything that ignores or may ignore diversity in order to establish rapport with

individuals.

= Be sensitive to differences.

Avoid using Miss/Mrs./Mr. unless the person expressly indicates that they wish to be
addressed in this manner.
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Original Pride flag - Transgender Pride flag - Progress Pride flag

I AM AN ALLY.

1 JUST SUPPORT THIS CRAZY
THOUGHT THAT EVERYONE
SHOULD HAVE EQUAL RIGHTS.
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Microsoft 365 - You Probably Have No Idea What You're

Missing

DEFINITIONS AND EXPLANATIONS: Before we talk about functionality, we first need to

define a few things to make sure we're on the same page.

A.

Microsoft 365:

Microsoft 365 (formerly "Office 365") refers to subscription plans
that include access to Office applications plus other productivity
services that are enabled over the Internet (cloud services).
Microsoft 365 includes plans for use at home and for business.
Learn about Microsoft 365 for use at home. Microsoft 365 plans for
business include services such as Skype for Business web
conferencing and Exchange Online hosted email for business, and
additional online storage with OneDrive for Business.

Many Microsoft 365 plans also include the desktop version of the
latest Office applications, which users can install across multiple
computers and devices. The fully installed applications include:
Word, Excel, PowerPoint, OneNote, Outlook, Publisher, and
Access. (Publisher and Access are available on PC only.) And you
can install them across multiple devices, including PCs, Macs,
Android tablets, Android phones, iPad, and iPhone. When you have
an active Microsoft 365 subscription that includes the desktop
version of Office, you always have the most up-to-date version of
the applications.

Microsoft Office: "Microsoft Office” is the name we still use for our familiar
productivity software. Office suites are available as a one-time purchase and
include applications such as Word, Excel, and PowerPoint, which can be installed
on only one PC or Mac. The applications are not automatically updated; to get the
latest version, you can purchase the product again when the new version becomes
available. The latest versions currently available for one-time purchase are Office
2019 for Windows and Office 2019 for Mac. These suites are essentially a snapshot
in time of Office via Microsoft 365 and do not come with any of the cloud-based
services included in Microsoft 365.

Office Online: There are web versions of Word, Excel, etc., that you can use
whether you have a Microsoft 365 account or not. They don't have all the
functionality of the desktop versions, but you can do a lot with them.

Microsoft 365 Security: You can read all about Microsoft 365's security at
https://www.microsoft.com/en-us/trustcenter/security/office365-security. In a
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nutshell, Microsoft 365 offers world-class security. It has the same user-level
security options and Trust Center as the desktop version of Office. Rights
management Service (RMS) supports encryption and lets you set permissions.
Offsite, files are saved in specialized data centers where security is a primary
concern. As a result, small to medium businesses will have better security using
Microsoft 365 than they can probably afford on their own.

According to Microsoft, here are Microsoft 365's Top 10 Security and Privacy
Features:

e We restrict physical data center access to authorized personnel and have
implemented multiple layers of physical security, such as biometric readers,
motion sensors, 24-hour secured access, video camera surveillance, and
security breach alarms.

e We enable encryption of data both at rest and via the network as it is
transmitted between a data center and a user.

e We don't mine or access your data for advertising purposes.

e We use customer data only to provide the service; we don't otherwise look in
your mailbox without your permission.

e We regularly back up your data.

e We won't delete all the data in your account at the end of your service term
until you have had time to take advantage of the data portability that we offer.

e We host your customer data in-region.
e We enforce "hard" passwords to increase security of your data.

e We allow you to turn off and on privacy impacting features to meet your
needs.

e We contractually commit to the promises made here with the data processing
terms in your volume licensing agreement.

Microsoft 365 Desktop - Running Offline: You can use Microsoft 365 offline
(without internet access) if you download and install the desktop version of Office
with your plan. You must connect to the internet every 30 days to maintain your
subscription and Microsoft 365 tells you when it's time to connect. To install the
desktop versions of the software by clicking the Install Office apps button from
the main Microsoft 365 screen (see below):
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MICROSOFT 365 VERSIONS AND SERVICES: | have given up trying to keep up with the
incessant changes Microsoft makes to the 0365 plans. Here is a link to the latest summary
of what is included in each of the business plans: http://bit.ly/2gROE5g. To see and/or
buy the 0365 plans most of our clients buy, see http://bit.ly/2qTantS (screen shot below).
The most popular plan among our law firm clients is Business Premium.

Get first 6 months free with Includes Microsoft Teams for Includes Microsoft Teams for | Only includes apps |
annual commitment.2 easy remote working easy remote working.

Microsoft 365 Microsoft 365 Microsoft 365 Microsoft
Business Basic Business Business 365 Apps for
(formerly Office 365 Standard Premium business
Business Essentials) (formerly Office 365 (formerly Microsoft 365 (formerly Office 365
Business Premium) Business) Business)
$5.00 $12.50 $20.00 $8.25
user/month user/month user/month user/month

(annual commitment)

Buy now

Promotional pricing
reflected in cart.*

Best for businesses that
need Microsoft Teams and
cloud storage. Desktop
versions of Office apps not

(annual commitment)

Buy now

Try free for 1 month ¢

Best for businesses that
need Office apps across
devices plus business email,
cloud file storage, and online

(annual commitment)

Buy now

Try free for 1 month ¢

Best for businesses that
need everything included in
Business Standard plus
advanced cyberthreat

(annual commitment)

Best for businesses that
need Office apps across
devices and cloud file

storage. Business email

protection and device and Microsoft Teams not
management. included.

included. meetings and chat,

Office apps included

Office apps included

Office apps included Office apps included

(Web and mobile versions of
Word, Excel, and PowerPoint

included.)’
Outlook Word QOutlook Word Outlook Word
$32.00 $57.00 $10.00
user/month user/month user/month

(annual commitment) (annual commitment) (annual commitment)

Microsoft 365 E3 Microsoft 365 E5 Microsoft 365 F3

Formerly Microsoft 365 F1 Empower your
Firstline workforce with productivity apps and

Get best-in-class productivity apps and advanced
security, compliance, voice and analytical

Get best-in-class productivity apps combined with
core security and compliance capabilities for your

enterprise. capabilities for your enterprise. cloud services that allow them to do their best
work.
Contact sales Contact sales Contact sales

Learn more > Learn more > Learn more >

If you want to look at the enterprise plans, see http://bit.ly/2HEmhI1. We subscribe to E3
because it includes message encryption, among other things.
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Office 365 ProPlus

CAD $16.00

user/month
(annual commitment)

Plus applicable tax

Learn more >

Office applications plus cloud file-storage
and sharing. Business email not included.

Office applications included

P G B 3

Outlock  Word Excel  PowerPoint
Access  Publisher
(PC (PC
onty) only)

Services included

OneDrive

Office 365 E1

CAD $10.20

user/month
(annual commitment)

Plus applicable tax

Learn more >

Business services—email, file storage and
sharing, Office Online, meetings and IM, and
more. Office applications not included.

Office applications included

(Not included)

Services included

R e h S

Exchange OneDrive SharePoint Teams

& »

Office 365 E3

CAD $26.60

user/month
(annual commitment)

Pius applicable tax

Buy now

Try for free >

Learn more >

All the features of ProPlus and Office 365 E1
plus security and compliance tools, such as
egal hold, data loss prevention, and more.

Office applications included

P Ge Ba 3

Outlook Word Excel

e )

Access Publisher
(PC (PC
only) only)

PowerPoint

Services included

R e

Exchange OneDrive SharePoint Teams

& »

Office 365 E5

CAD $44.80

user/month
(annual commitment)

Pius applicable tax

Buy now

Try for free >
Contact sales >
Learn more >

All the features of Office 365 E3 plus
advanced security, analytics, and voice
capabilities.

Office applications included

P Ge Ga 3

Outlook Word Excel

e 3l

Access Publisher
{PC (PC
only) only)

PowerPoint

Services included

= S

Exchange OneDrive SharePoint Teams

g G0 p

. INCLUDED PROGRAMS AND APPLICATIONS:
A. Microsoft Exchange: This is included in some of the Microsoft 365 plans. We

would argue that this feature alone is worth the price of admission. Microsoft
Exchange is a program that, among other things, allows Outlook users to
syncronize their data (email, contacts, calendars, tasks, etc.) on a server.
However, there are much bigger benefits:

1. Share Data: Exchange also allows users to share information in Outlook.
For example, | could allow someone else in my office to access my calendar
electronically and add appointments. If you're going to use an electronic
calendar (which we recommend), then you need to have an arrangement
whereby others in your office can access it when you're not around.

2. Smartphone & Tablet Sync: Exchange will wirelessly sync with any
smartphone or tablet running Android, iOS, Blackberry OS or Windows
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Phone. This means that everything in Outlook (contacts, tasks, calendar &
email) will be available from any device you own as long as the device is
connected to the Internet. If you want to rely on an electronic calendar,
then you have to be able to take it with you and Exchange allows this.

3. Anywhere Email Access: Exchange also allows users to gain access to
office email while out of the office in many different devices. For example,
| can see my inbox, calendar & contacts on my iPad (or any tablet), on any
Windows or Mac computer connected to the Internet, or on my
smartphone. | can use Outlook Web Access (which comes with hosted
Exchange) via a browser; or | can run Outlook natively on my laptop (for
example) and as long as I'm connected to the Internet, I'm also connected
to Exchange.

4. Full Synchronization which acts as a Back Up: Everything in Outlook is
synchronized in Exchange (email, contacts, calendar & tasks), which serves
as a replication or a backup. Note though, this is not a multiple point-in
time backup. It is synchronizing your data to Microsoft’s servers. For
example, you are not able to request a recovery from 2 days ago or 7 days
ago, etc.

5. Operating System Agnostic: Exchange and Outlook will work with both
Windows and Mac computers.

To-Do: This is a fantastic task management application that is actually free
regardless of whether you have a Microsoft 365 subscription. That said, if you
want Microsoft ToDo to synchronize across devices, you will need a subscription.

FindTime: Microsoft FindTime is a scheduling tool designed to simplify the process
of finding suitable meeting times among multiple participants. Itis very similar to
Doodle if you are familiar with it. With FindTime, users can easily coordinate and
schedule meetings by automatically detecting availability and suggesting optimal
time slots based on participants' calendars. This intuitive Microsoft Outlook add-
in eliminates the back-and-forth communication typically associated with
scheduling, allowing users to efficiently send meeting invitations and receive
responses, all within a unified interface. FindTime streamlines the coordination
process, ensuring efficient collaboration and enhanced productivity for individuals
and teams alike.

Bookings: Microsoft Bookings is a appointment and scheduling management tool
that enables businesses to efficiently organize and manage customer
appointments. With Bookings, businesses can create customized booking pages
that allow customers to easily schedule appointments, services, or meetings. The
platform syncs with staff members' calendars, ensuring real-time availability
updates and avoiding double bookings. It also provides automated reminders and
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notifications to reduce no-shows and enhance customer engagement. Bookings
offers flexibility in terms of customization, allowing businesses to define services,
durations, and availability based on their specific needs. With its intuitive interface
and seamless integration with other Microsoft tools, Bookings streamlines the
booking process, enhances customer satisfaction, and optimizes business
operations.

Lists: Microsoft Lists is a productivity tool that helps users organize, track, and
manage information effectively. It provides a structured way to create, share, and
collaborate on lists, allowing users to track anything from simple to complex data
sets. With Microsoft Lists, users can create customizable templates, set up
columns and rules, add attachments, and apply conditional formatting to highlight
important information. It offers features such as sorting, filtering, and grouping to
easily analyze and visualize data. Users can access and update lists across multiple
devices and platforms, making it convenient for remote collaboration. Microsoft
Lists streamlines workflows, improves team productivity, and enables efficient
information management in a user-friendly and flexible manner.

Planner: Take the chaos out of teamwork and get more done! Planner makes it
easy for your team to create new plans, organize and assign tasks, share files, chat
about what you’re working on, and get updates on progress.

1. Easy to use: Launch Planner from the Microsoft 365 app launcher with a
single click. You can then create a new plan, build a team, assign tasks, and
update status—in a few easy steps.

2. Organize work visually: Each plan has its own board, where you can
organize tasks into buckets. You can categorize tasks based on their status
or on whom they’re assigned to. To update the status or change
assignments, just drag and drop tasks between columns.

3. Visibility and transparency: The My Tasks view provides a comprehensive
list of all your tasks and their status across all your plans. When working
together on a plan, team members always know who is working on what.

4, Collaborate around tasks: Built for Microsoft 365, Planner lets you attach
files to tasks, work together on those files, and even have conversations
around tasks without switching between apps. With Planner, all your
team’s discussions and deliverables stay with the plan and don’t get locked
away across disparate applications.

5. Works across devices: Planner works across all your devices. And with
Planner, everyone is always on the same page. A glance at Charts is all it
takes to know where things stand and if the team is making enough
progress towards their goal.
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6. Email notifications: With Planner, you’ll never miss a beat! Receive email
notifications whenever you’re assigned a new task or added to a
conversation.?

SharePoint: "SharePoint is Microsoft’s premier collaborative server environment,
providing tools for sharing documents and data across various organizations
within a company’s network. Typically deployed on a company’s network as a
series of intranet sites, SharePoint lets various departments control their own
security, workgroups, documents, and data.

As with any other website, a SharePoint site — or an individual page within the
site — is accessible by way of a URL that the user can access using a standard web
browser.

SharePoint is most often used for the storing of version-controlled documents,
such as Word documents and Excel worksheets. In many environments, email is
used for passing documents back and forth between users. The potential for
mixing up different versions of the same document is considerable. Also, storing
multiple copies of the same document takes up a lot of disk space. Because
SharePoint provides a single source for storing, viewing, and updating documents,
many of these issues are eliminated.

And because SharePoint easily handles virtually any type of document, it is
frequently used to consolidate and store various types of documentation (project
drawings, videos, schematics, photographs, and workbooks, for example) that are
required for large projects where multiple teams must collaborate."?

Shifts: Microsoft Shifts is a cloud-based platform designed for organizations who
need to manage shifts for their workforce. For instance, in a law firm, that might
be a pool of typists or transcriptionists. Shifts helps you create and manage work
shifts, share files, and communicate important information with team members.
It's available to Microsoft 365 for business subscribers and comes with a web app
for managers and mobile app for employees. The mobile app supports both iOS
and Android.

Stream: Microsoft Stream is a cloud video service that provides a secure way for
employees at organizations of all sizes to upload, watch, share, organize and
discover all videos within their organization from a single portal. Some
organizations use Stream to house their internal onboarding and/or instructional
how-to videos.

1 See https://products.office.com/en-us/business/task-management-software
2 What Is SharePoint? by Michael Alexander, see http://bit.ly/2qUDiO0
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J. Sway: According to Microsoft: Sway makes it quick and easy to create and share
polished, interactive reports, presentations, personal stories, and more. Add your
content, and we'll do the rest. Bring your Sway to life with interactive content.
Include a video to talk about your idea or add an interactive chart to let others
dive into the details. Sway suggests searches to help you find relevant images,
videos, tweets, and other content that you can drag and drop right into your
creation. No need to juggle apps and web pages to find what you want. You don't
need to worry about formatting, Sway's built-in design engine takes care of it. If
the first design isn't right for you, Remix! it to see others or customize it to make
it your own. It's super easy to share a Sway. Family, friends, classmates, and
coworkers can see your creation on the web without signing up or downloading
additional software. And you can change privacy settings for more control.3

K. Teams: This description is from TechTarget: Launched in beta in November 2016,
Microsoft Teams is a chat-based collaboration tool that is part of the Microsoft
365 suite of services. Teams enables remote, global and dispersed teams to work
together and collaborate through a common workspace, team chat, one-on-one
chat, document collaboration and more. Teams is integrated with a variety of
other Microsoft 365 services, including SharePoint, Skype, Yammer and Exchange.

Microsoft announced that they will “retire” Skype for Business July 31, 2021. Since
September 2019, all customers signing up for Microsoft 365 are automatically set
up to use Microsoft Teams only. If you currently use Skype for Business, we
strongly recommend that you start planning your transition, if you haven’t already
done so. All capabilities that were available in Skype for Business will be available
in Microsoft Teams. In addition to the functionality you had in Skype for Business,
Microsoft Teams serves as a modern “hub” for all communication and
collaboration. The Teams interface is more complex than the simple interface in
Skype for Business, so we do recommend training.

Teams offers three clusters of functionality and is poised to compete with services
like Slack, Jabber, Jive, HipChat, Salesforce Chatter and others. It touts itself as a
native chat tool for Microsoft shops using other Microsoft 365 services. While the
core of the tool is real-time chat among teams, Teams enables other core
collaboration platform functions by using APIs to integrate document
management, video and other applications. Teams includes the following core
capabilities:

1. Chat. While conversations are visible to the entire team, they can also be
made private. Skype video is deeply integrated into the application, and
team members can add emojis and custom memes to discussions.

3 See https://sway.com/
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2. Hub. Microsoft Teams provides a consolidated space for various Office
applications, including Word, Excel, PowerPoint, SharePoint, OneNote,
Planner, Power Bl and Delve. It enables teams to work natively and
collaboratively, without having to toggle between applications as they
collaborate.

3. Easy customization of teams. The tool features APIs that plug into various
cloud-based documents and cloud services. Microsoft Teams utilizes the
same Connector model as Exchange, which enables notifications and
updates from Twitter and other third-party applications.*

Forms: According to Microsoft, "[w]ith Microsoft Forms, you can create surveys,
quizzes, and polls, and easily see results as they come in. When you create a quiz
or form, you can invite others to respond to it using any web browser, even on
mobile devices. As results are submitted, you can use built-in analytics to evaluate
responses. Form data, such as quiz results, can be easily exported to Excel for
additional analysis or grading."®

OneDrive: According to Microsoft, "Securely store and share files from anywhere.
OneDrive offers native desktop, browser and mobile experiences on your devices.
Access and make changes that sync automatically in the cloud or sync local copies
of files for offline viewing and editing on your PC or Mac. Confidently share your
files so other people can access them seamlessly and securely."®

OneNote: "Designed to function as an electronic version of a paper notebook,
Microsoft OneNote is a note-taking and personal information management (PIM)
application for collecting, organizing and sharing digital information. By storing
text notes, photos, audio and video snippets, handwriting and similar content,
Microsoft OneNote collects and organizes the information, making it available for
searching as well as sharing with others."” This application is also free regardless
of whether you subscribe to Microsoft 365.

Dynamics 365: Microsoft recently took the wraps off of Microsoft Dynamics 365,
a new cloud powered service that repackages and rebrands several Microsoft
Dynamics programs into an offering that is both. The cloud-enabled Software-as-
a-Service project combines the customer relationship management (CRM) and
enterprise resource planning (ERP) of previous versions of Microsoft Dynamics
with additional features including Microsoft Flow and Microsoft PowerApps.®

4 See http://searchcontentmanagement.techtarget.com/definition/Microsoft-Teams

5 See https://support.office.com/en-us/forms

6 See http://bit.ly/2gT1bFS

7 See https://www.webopedia.com/TERM/M/microsoft onenote.html

8 Microsoft Dynamics 365: Everything You Need to Know by Michael Simmons, 10/31/16, Tom's IT Pro, see

http://bit.ly/2vCSDHP.
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P. Power Automate: Microsoft Power Automate (formerly called Flow) is a cloud-
based service that makes it practical and simple for line-of-business users to build
workflows that automate time-consuming business tasks and processes across
applications and services.’

Q. Power Bl: Power Bl is a robust business intelligence platform that enables
organizations to analyze and visualize their data in dashboards that drive informed
decision-making. It allows users to connect to a wide range of data sources,
transform raw data into rich, informative dashboards, reports, and visualizations.
With Power Bl's drag-and-drop interface and powerful data modeling capabilities,
users can explore data, uncover insights, and make data-driven decisions. The
platform offers a variety of advanced features, such as data cleansing, modeling,
and sophisticated analytics tools like Al-powered visuals and natural language
guerying. Power Bl also provides seamless collaboration and sharing options,
enabling teams to collaborate on data analysis and share reports securely.

V. MANY OTHER PROGRAMS INTEGRATE WITH MICROSOFT 365: Nearly every legal case
management system and all document management systems integrate with Microsoft
365. For example, this is from Clio's website (a legal case management system):

All your organizational needs in sync.

I - - -
A natural fit for every law firm—sync Clio with Google or Microsoft
Office 365 Business or Enterprise accounts. Link key business tools I ( (
such as contacts, documents and calendars with Clio to instantly

reduce data entry, minimize errors, and simplify law firm

organization.

V. MICROSOFT 365 CONTINUOUSLY UPDATES THE SOFTWARE: In other words, Microsoft
will constantly send you updates that will install in the background to the Microsoft 365
product suite. To get an idea of what I'm talking about, see What's New In Microsoft 365
here (http://tinyurl.com/n9x9f4j). If you scroll down to the bottom of that page, you'll
see that Microsoft updated Microsoft 365 in Sept. & Nov. of 2015, every single month of
2016, and Jan, Feb. and May of 2017. A great review of Microsoft 365 which shows the
content of each update can be see here: http://tinyurl.com/mz574zl.

VI. WOULD MICROSOFT 365 WORK FOR YOUR FIRM? In short, yes. We have many clients
using it and loving it. For more information on this, see:

A. How Law Firms Can Take Advantage of Microsoft 365 by Catherine Sanders
Reach, October 27, 2020. See https://www.ncbar.org/2020/10/27/how-law-
firms-can-take-advantage-of-microsoft-365/.

° See https://flow.microsoft.com/en-us/documentation/frequently-asked-questions/
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Office 365: Why A Law Firm Switched by Kevin Casey, InformationWeek, March
20, 2013. See http://tinyurl.com/p54ud8l

From Google Apps to Office 365: Why My Company Ditched Google by Derrick
Wilodarz, betanews, January, 2014. See http://tinyurl.com/lkkapaa.
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info@affinityconsulting.com. For permission to use materials from this text or product, submit all
requests via email to info@affinityconsulting.com.

This is for your personal use only, you may not distribute, modify, or copy the materials, except for
archival or backup purposes, without express permission of the copyright owner.

Version 4.02
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LEAVE THE
TRAINING TO US.

- Comprehensive digital courses - Live training sessions
- Affordable membership plans - “Ask the Expert” sessions
- On-demand training videos - Customizable training plans

Affinity Insight offers insightful training programs created by legal professionals for
legal professionals. Our digital courses and training membership plans give you
access to some of Affinity’s most dynamic law firm management and legal
technology trainers—not just for a day or a week, but all year long. Join live training
sessions with your peers or learn at your own pace with bite-sized, on-demand
training modules. Design a custom training plan for yourself or everyone in your firm.
Learn more at https://affinityinsight.com
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MEET OUR TEAM OF OUTLOOK EXPERTS

Meet our team of Outlook experts who have co-authored this manual.

i

BARRON HENLEY

Most people wouldn't relish the idea of spending a day in a conference
room, teaching Microsoft Outlook. Barron is not most people. There are few
things Barron enjoys more than teaching all-day software training classes.

As an attorney, he understands how challenging it is to practice law
without the proper training on the technology tools. When Barron isn't
training people on Word or helping transition organizations transition
from WordPerfect, he focuses on automating documents and teaching
CLE classes for attorneys across North America.

PAUL UNGER

While most people understand the day-to-day struggle of keeping up with

email, Paul knows how to tackle the problem better than anyone. Paul's
passion is coaching lawyers on managing time, distractions, tasks, emails,
and documents efficiently. As the author of Tame the Digital Chaos — A
Lawyer's Guide to Time, Task, Email and Distraction Management, Paul is
truly an expert on the topic.

Paul's expertise is well-founded from his time practicing law. When Paul
isn't coaching lawyers, he teaches CLE classes for attorneys across North

America.
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DANIELLE DAVISROE

Passionate about remote learning, Danielle is the force behind Affinity's
membership training program, Affinity Insight. Danielle focuses on
creating easily accessible training materials and webinars tailored to meet
each organization's needs. From one-on-one training to organization-wide
training plans, Danielle has her clients covered.

When Danielle isn't providing remote training, she focuses on teaching
CLE via webinar and providing legal organizations with the advice they
need to run smoothly. With a background practicing law at a boutique
firm, Danielle understands the challenges that legal professionals face
every day.
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CHAPTERT
MANAGING EMAILIN A

LEGAL ENVIRONMENT

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

This manual would be remiss not discuss why legal professionals need to be more efficient in
using Outlook in the first place.

The Email Problem

Email Overload

Studies indicate that lawyers receive around 120 and send roughly 40 emails per day.! Without
guestion, email is one of the most important technological communication advancements of the
past 100 years. It has fundamentally changed the way we communicate with clients and do
business. Major corporations and law firms are run via email communication instead of face-to-
face communication.

For lawyers, emails present a wide array of issues that most of the business world and ordinary
consumers will never face. In this seminar, we will discuss these issues and teach you how best
to deal with them.

These issues or problems range from ethical considerations to email overload and time-
management. While there is no perfect solution, there are many methods to effectively handle
email.

The first step to any problem is to understand the problems that exist. We must get our arms
around all the email issues that face lawyers. The second step is to isolate each problem and
tackle each problem, without forgetting how that might affect other email problems. For
instance, controlling spam email may prevent you from getting an important email from a client
if your spam filter inadvertently catches an email from a client. In other words, when you solve
one problem, it may open up a different can or worms.

Torrent of Interruptions

In an eight (8) hour workday, if we receive 100 emails, that equates to receiving one email every
4.8 minutes. Sound familiar? It should, because that is the world most of us live in. Combine that
with instant messages, phone calls and what | call email curiosity interruptions, that equates to
one interruption every 2-3 minutes! What can you do to minimize the distraction?

Take the following quick survey:

' See https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-

needs-to-know/
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1. Interruption Survey:

e Average number of emails you get per day:

e Average number of Instant messages per day:

e Average number of phone calls you get each day:

e Average number of curiosity email or internet breaks each day:

e Total Interruptions Per Day

2. Other Questions to Ask Yourself:

¢ How many times do you look at your email each day?

¢ What percentage of interruptions really need immediate attention? __
e Hastechnology simplified your life? O Yes O No

e Does technology control your day? O Yes O No

Email Storage
What do we do with all of this email? There are several problems related to this:
¢ How should you archive old email?
e How do you deal with attachments and keep from losing them?
e How do you search for old conversations quickly and efficiently?

¢ Howdoyou keep your email but not run out of server space? Why does the IT person keep
telling you that you have too much email in your inbox and you're clogging up the server?

Too Much Legitimate Email to Deal with Effectively

Many people simply receive more email than they can read and keep up with. How do you sort,
store and track all of this email?

No Expectation of Privacy

The old saying goes: You should never send an email that would embarrass you were it to appear
on the front page of tomorrow's paper. Is there anything you can do to create an expectation of
privacy?

Spam Getting Through

There are lots of ways to avoid SPAM, and yet it still manages to get into our mailboxes. What can
you do about it?

Are You Using Outlook Effectively?

Probably not. Although millions of people use Outlook, most do not use all of its functionality to
their advantage. In this seminar, we'll give you some great tips for making better use of Outlook.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 2
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Email Storage Problems

Disorganization

Many legal users have hundreds or thousands of unrelated messages in their inboxes. This is
equivalent to taking all of the paper out of your files and throwing it on the floor of the file room.
The point is, if it's not organized, then it's mostly useless.

Storage Space Limitations

You may have been scolded by your IT folks about this. If you're using Microsoft Exchange on your
server, then it can get overloaded with the quantity of emails and attachments you keep in your
inbox and Outlook folder structures. If you don't have Exchange, then all of those emails (and
contacts, and appointments and tasks) are stored in a PST file on your hard drive or the server.
The bigger that database, the slower your computer will run. Of course, the database can also
over-run your storage capacity.

No One Else Can See Your Email but You

In most cases, if you have an important client communication in Outlook, no one else in your
office can see it. In many cases, lawyers want to share this information, but don't know how to do
it.

Difficulties Searching

Many people complain that it's nearly impossible to efficiently search old emails for a particular
conversation. What can you do to make this task easier?

Dealing With the Overload

Deal with Email at Set Times

The first problem that we want to deal with is the reduction of interruptions so one can be more
focused and productive. After all, how on earth can anyone get anything done with an
interruption every 2-3 minutes?

Ask yourself the following question: 10 years ago, would you have let someone walk in your office
every 2-3 minutes offering to sell you a sexual enhancement product... or asking you for a favor?

Of course, you wouldn't! So, why do you let it happen now with your email? Why do you drop
everything that you are doing to read and/or respond to that email that just arrived?! You have
invested thousands of dollars in this wonderful technology that is supposed to make you more
efficient, but instead it has created an interruption hotline going straight to your brain.

Some time management experts suggest checking email 2 times a day. While this may sound
like a good plan, it is probably unrealistic. When email was just becoming popular, there wasn't
an expectation of that email would be dealt with immediately, so 2 times per day was probably
okay. However, in today's age that has changed to some degree. Entire companies communicate
via email ... it's a way of life and the way everyone commmunicates. Checking email twice a day isn't
enough. | think 3-5 times a day is more realistic ... more satisfying to senders ... and just as
important, will make it easier for you to prevent your inbox from growing out of control.

A good way to handle this is deal with email at the same time every day. For example, you could
follow this schedule and limit yourself to 10-15 minutes.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 3
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Upon arrival at the office: 8:00 am
Mid-morning: 10:30 am

After lunch:12:30 pm

Afternoon: 3:30 pm

End of day: 5:00 pm

Turn Off Outlook's Notifications About Email

You see that little envelope in the bottom, right corner of your screen and you can almost hear it
saying, "read me!" The constant notifications of new email are one of the primary distractions for
most people. So, turn them off! It's amazing how more focused you can be when your computer
isn't announcing incoming email every few minutes (or seconds). File » Options (left side)  Mail
(left side) # clear all of the boxes under Message Arrival.

o 0N W

Message arrival

Fd When new messages arrive:

Play a sound
Briefly change the mouse pointer
Show an envelope icon in the taskbar

Display a Desktop Alert

FIGURE 1-1

Treat Email Inbox like you U.S. Mailbox — Keep it Empty!

Would you ever keep your U.S. Mailbox in this condition? Of course, you wouldn't. So, don't let
your inbox get that way! However, for most people, maintaining email is the weakest link in their
system of organization primarily because of volume and frequency. They use it as a holding
bucket for undecided and unresolved tasks.

The key to mastering your inbox is to keep it empty — or under 20. You certainly don't need to
keep it at zero. In fact, if you tried, you would probably be wasting time, not saving time. Not to
mention, you will also be developing bad obsessive/compulsive habits. Every time an email
landed in your inbox, you would drop everything and try to deal with it. That would be horribly
inefficient.

The truth is that to process email efficiently, you must be able to see your emails in a single screen
(or close to it). It is very difficult and overwhelming to process emails and tasks when you are
staring at a screen with 500 emails.

So, what do you do with your U.S. mailbox? One of the best time management/organization tips
that | learned and implemented nearly ten years ago is this: Throw away your (U.S.) junk mail and
advertisements before you get into the house. Only bring mail into your house that you intend
to do something with!

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS
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Delete Whatever You Can Immediately!

Learn how to use the DELETE key. That could be the first thing that you do before you start
dealing with email ... just like not bringing junk mail and annoying advertising into your home.
Delete the following:

e All the email that gets past your SPAM filter.

e Interoffice SPAM that is irrelevant to you.

e Jokes from annoying friends and c-workers.

e Email from people you don't like (unless it's important, of course)

TIP: Sort email based on the From field (by hitting the From column header). You can often get
rid of tons of email sent from the same person. Remember that you can select a chunk of email
by single left clicking on the first email — holding the Shift-key down and single left click on the
last email.

If You Can Deal with It in Under 3 Minutes, Do It Now

The 3-minute rule is gold! Any email that can be responded to or dealt with (saved in a client file,
forwarded, deleted, etc.) within 3 minutes should be dealt with immediately — the first time you
lay eyes on it. This rule is based on the premise that the 2"@ time you have to deal with the email,
it will take you longer than 3 minutes navigate to it, open it, read it, comprehend it, re-familiarize
yourself with the topic and then handle it. So, why not just respond to it if you have the 3 minutes
to deal with it!

TIP: Don't forget that you may be able to deal with it more quickly by picking up the phone or
walking around the corner.

Remember, you are still supposed to be handling these emails only at scheduled/set times
during the day! This will be a difficult temptation to overcome - especially if you have email
notification turned on and see an email that you can dispose of quickly.

Finally, if it is an email that is going to take a while, you should dispose of it in under 3 minutes
by adding it to your task list (or calendar) and then saving it into the appropriate client/matter
file.

Delegate If Appropriate

If someone else should be handling the task or issue in the email, then hand it off appropriately.
Don't let someone else put “the monkey” back on you, in the words of The One Minute Manager
Meets the Monkey by Kenneth Blanchard. Do thisimmediately unlessit is going to take you more
than 3 minutes to delegate. You can make this easy to track by setting up the Delegated Email
rule described under Keep Track of Delegated Email on page 45 below.

Delay If Necessary

Already mentioned in the 3-minute rule above, if it is an email that is going to take a while, you
should simply dispose of it in under 3 minutes by adding it to your task list (or calendar) and then
saving it into the appropriate client/matter file.

e Do not use Outlook as your to-do list by leaving unresolved email in your inbox.

e |f you keep a paper-based task list, simply write it in and save the email in appropriate
place.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 5
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e |fyou use Outlook to manage your task list, simply drag it over to your Task button in the
Outlook navigator.
e |In some circumstances, it is okay to set up subfolders under your inbox. Clean them out
on a weekly basis.
e Ifyou schedule your tasks as appointments, add it to your calendar.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 6
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OUTLOOK'S "FLUENT
USER" INTERFACE

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Outlook is Organized into Folders

All items in Outlook are stored in Folders. Clicking on the navigation buttons in the bottom left
Mail, Calendar, People, or Tasks changes the view to that folder.

Outlook 2013/16

To see all Outlook folders, click the three dots and choose Folders.

o
Fle  Mome Send/Receive Folder View Addins Help

MR O G0 P90 S0 @ O G [ ME O B W Tee e ) 5ot S
Shareto Create New

1 B Address Book
B Bromse Groups » Read | Tandate Gt Addto  Addto

New New TRCHNUDY oo schive | Reply Reply Fonward MY > Tipht Move Rules  Unread/ Categorize Follow
Email tems> £ junk~ A [ More ~ Teams e - - Read - Up~ 7 Filter Email = Aloud ~ Add-ins | Todoist Todoist Inbox
New Delete Respond Teams Quick Steps & Move Tags Groups Find Speech | language  Add-ins Todolst v
SRy O €y ChangeView~ (2 ©5 Ruler B3 Categorize~ =
x
vFavorites Al Unread ByDatev 1 Cloud Recording - Affinity Insight Live Training Session: Excel Tips & Tricks is now available ¢ December 2021 >
SUMOTU WETH R SA
Bridgett Moore Rl | € RepyAl | > Forwerd | | KB || oee
RE: [EXTERNAL] MGMTHQ Webinar Assignments T... Tue &35 PM f""n’" <no-reply@zoom.us> i 2 3 4
o 14
5 6 7 8 9 WM
Zoom =4 o eisage o 317 P ERRERRTY - RESRTARH
(Cloud Recording - Affinity insight Live Training S...  Tue 1:39 PM
v N 2B us
Hi Daniefle DavisRoe (she/her), 2% 7 2 ¥ 0 3
Your cloud recording is now available. :
Topic: Affinity Insight Live Training Session: Excel Tips & Tricks
Date: Dec 14, 2021 12:47 PM Eastern Time (US and Canada)  ——
> ddavisroe@affinityconsultin...
- -
—
>Insight
> Training Account
Thank you for choosing Zoom.

| —

| —

| —

| ——
m—_— ——

—

This email has been scanned for spam and viruses. Click here to report this email as spam,

& [ e
2B L g Monday =
This folder Is up to date.  Connected to: Microsoft Exchange n B -—% + 100%

FIGURE 2-1
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Outlook 2019/21/365

To see all of the Outlook folders, click on the More apps button and choose Folders.

< 9 = S search
| =] File Home  Send /Receive Folder View Developer Add-ins Help  Acrobat
7 = S lgnare m E N~ & ™M [ Meeting i
e [5Z Clean Up ~ o= ¢ Loaim ~
Mew  Mew o -lean Vp Delete Archive Reply Reply Forward H Shar
Rq Email ltems~ (3 jynk~ All £ Mare ~ Teal
Mew Delete Respond Tea
¢
) All Unread
v w Favorites
Inbox - ddavisroe@affinityconsultin... Beth Thompson
& Inbox - Insight Whaddya say? Can you hear me now?
Inbox - Training Account .
Bt Danielle DavisRoe
Inbaox - Group
RE: October Update
Read Later
Processed ; ;
Danielle DavisRoe
Demo Emails October Update
DD
Sent [tems Dashlane
New device added to Dashlane
FIGURE 2-2

Opening Folders in New Windows

To open a folder in a new window, right-click on the navigation button, and select Open in New
Window.
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Quick Access Toolbar

Use and modify the Quick Access Toolbar ("QAT") to store your most frequently used commands.
By default, the QAT is configured with a few commands.

x| 9 = »~  Search

File Home Send/Receive Folder View Add-ins Help

E‘l % = Ignore m E élil @ E =] Meeting o [ proce

Mew  Mew IE% Clean Up Delete Archive Reply Reply Forward E M~ Share to — Triplt
Email fems~ = 3 junk~ All £ Mare ~ Teams
Mew Delete Respond Teams

FIGURE 2-3

In 2019/21/365, the QAT is hidden by default. To show the QAT, right click on the ribbon and click
on Show Quick Access Toolbar.

0™ & search

File Home  Send /Receive Folder VWiew  Add-ins  Help

F—Il % 'F‘ISI Igncure ‘@' E | o, I | = = hlectinn

5 Clean Up ~ Add to Quick Access Toolbar

Mew  Mew Delete Archive
Email ltems~ (3 junk ~ Show Quick Access Toolbar
Mew Delete

Custormize the Ribbon...

FIGURE 2-4

See page 18 for instructions on how to customize the QAT.

Tabs

The tabs are located at the top of the screen, immediately below the title bar. They change the
ribbon.

Rilbbon

The ribbons contain (almost) all of the commands that are used to work in Outlook. Each ribbon
contains a group of related commands and functions. While many of the tabs are the same
between email, calendar, and contacts, the ribbons are different.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 9
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Email Reading Pane

The Reading Pane shows emails in the main Outlook window without having to double-click on

the email to open it.

@ <9
| [ Fle Home Send/Receive Folder View Developer Add-dns Help Acrobat £ coming Soon | Try it now @D
TS Ignore [ Meeting ﬁ 0] s b [[m] A New Group Search People. ) b +
AT - s 2 EF By MEdl & B M o B adareiook A H OCKED
ew  New  TECENUPY b acchive  Reply Reply Foward 'O MY Shoreto L) Process Move Rules Sendto | Unread/ Categorize Follow Browse Groups Read  Trorslate  Get 30 Tiaining Training
& Email Kems~ Q0 junk~ Al B More ~ Teams || 7 Create New . ~ OneNote  Read 7 Fiter Email ~ Aloud - Add-ins ) &0
New Delete Respond Teams Quick steps I Move Tags Groups Find Speech | language | Add-ins Calendly v
<
o e Al Unread ByDate~ T Whaddya say? Can you hear me now?
. &
Inbox - ddavisroe @affinityconsuline. Beth Thompson o Beth Thompson <bthompson@affinityconsulting.com> & Reply | & ReplyAll | —> Forward | | i
& Inbox - Insight Whaddya say? Can you hear me now? 2/14/2022 To Danielle DavisRoe Mon 2/14/2022 1:22PM
Ibox - Training Account Aty Insont
B | ko -Group Danielle DavisRoe afm () Follow up. start by Fiday, March 25, 202 Due by Friday, Match 25, 2022
RE: October Update 10/14/2021 &
Read Later
Processed Darielle DavisRoe Sl
Bz I=5 QOctober Update 10/14/2021
oD
Sent tems Dashlane e M T
New device added to Dashlane 10/13/2021 A I n I t
> ddavisroe@affinityconsultin... -~
SurveyMonkey = A CONSULTING
ST Newsletter: October 2021 10/13/2021
=gl Hi Danielle,
Backtracks afe .
> Training Account See what's popular in the Technology Podcast Charts this week! 10/12/2021 Hello? Hello? Can you hear me now? Playing “telephone” is no way to communicate as a legal
professional. If you have ever felt like your message wasn't received the way you meant it or you
Zoom a aren't sure that you fully understand what others are trying to say, you should join us tomorrow.
The audio transcript of cloud recording - Word Styles 3 is now av... 10/12/2.
Affinity Director of Default Services & Strategic Consultant Erica Fujimoto will host a quick webinar to
There are more items in this folder on the server explore the best approaches to being heard and to listening well
lick here to view more on Microsoft Exchange You won't want to miss this one tomorrow (2/15/2022) at 1pm ET — register now!
Beth
Beth Thompson | Director of Client Engagement
Affinity Consulting Group | Direct: 540-224-1086 | Main: 877-676-5492
Email 1g.com | www. com
A Affini
A Inity
SRR, CONSULTING
v
tems: 25 This folder is up to date.  Connected to: Microsoft Exchange [ -—— 100%
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Convert One Type of Item to Another

For example, you can create a contact from an email by dragging the email onto the Contacts
button. You can drag emails or tasks to the Calendar button to make appointments. If you drag
emails onto buttons, it will leave the email where it was.

o o9
| = File Home  Send /Receive Folder View Dewveloper Add-ins Help  Acrobat
E 7| ﬁ S Ignore m ~ ﬂ = ﬂ E l [ Meeting @‘j’ T \l/ F_|
MNew  MNew L Clean Up Delete Archive Reply Reply Forward B Share to T Process Move Rules
.Q,Q‘ i ftems O3 junk~ All £f More ~ Teamns % Create New = v v
Me I Delete Respond Teams Quick 5teps ] Mov
\ €
) \ All - Unread ByDate v T
v wFavorites _
Inbox - ddavisroe@affinityconsultin... \ Beth Thompson & fa
2 Inbox - Insight Whaddya say? Can you hear me now? 2/14/2022
Inbox - Training Account
B | Danielle DavisRoe £ fo
nbox - Group
RE: October Update 10/14/2021
Read Later
FICURE 2-6
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DEFAULT SETTING

CHANGES

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

General Settings

This setting is found under the File menu » Options » General. Uncheck Show Mini Toolbar if
you'd rather not the mini toolbar that popups when you select text.

Mail Settings
All of these settings are found under the File menu % Options » Mail.

Format

Under Compose messages in this format, select HTML.

Check Spelling Automatically

If you want Outlook to spellcheck your email before sending, under Compose Messages, check
Always check spelling...

General Compose messages [4]
Mail . ) - -
/[ Change the editing settings for messages. Editor Options...
Calend
Fenaar Compose messages in this format: | HTML &
Groups Show text predictionswhiletyping@
People
Tacks abc Always check spelling before sending Spelling and Autocorrect...
Ignere original message text in reply or forward
Search ||

FIGURE 3-1
Click on the Spelling and Autocorrect... button and uncheck Ignore Words in UPPERCASE.

Set Up Your Signature

Under Compose Messages, click on the Signatures... button to setup your email signatures. It is
recommended that you have an email signature automatically attached to every new message
and every reply/forward. However, the reply/forward signature doesn't need to be as detailed as
the one you use for new messages.

5-34
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To create a new email signature:
1. Click on the New button to create a new email signature.
2. Type a name for the signature and click OK.

3. Inthe empty text box, create your email signature.

jnatures and Stationer, ? bt
E-mail Signature  Personal Stationery
Select signature to edit Choose default signature
Danielle E-mail account: | ggavisroe@affinityconsulting.com -
Reply
Mew messages: Danielle ~
Replies/forwards: | panielle ~
Delete New Save Rename

Edit signature

Calibri (Body) v~/ B I U Automatic v = = = |E|Business Card |L_||:| =N
~
v
Get signature templates

FIGURE 3-2
4. Click on the Save button.

To set your default email signatures for new messages and replies/forwards, select the desired
signature under Choose default signature.

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS PAGE 13
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Affinity Consulting Group

514-340-3444 | £14-310-8B852 (direct dial)
ddavisroe@ affinityconsulting.com

affinityconsulting.com

A Affinity

Get signature templates

Signatures and Stationery ? X
E-mail Signature  Personal Stationery
Select signature to edit Choose default signature
E-mail account: ddavisroe@affinityconsulting.com ~
Reply Mew messages: Danielle “
Replies/forwards: |E Y
Delete Hew Save Rename
Edit signature
Calibri (Body) 11 | | B I U Automatic ~|||/= = = | [22]Business Card | l__‘;. ‘%
Danielle DavisRoe, Esq. | Senior Consultant A

1550 Old Henderson Road, Suite 5-150 | Columbus, OH 43220

TRAINING.

SIMPLIFIED. v

FIGURE 3-3

Default Fonts

CHAPTER 3

Under Compose Messages, click on the Stationery and Fonts... button. New messages,
replies/forwards, and plain text messages all have separate font settings. Click on the Font...

button to change the default font for

each message type.

Signatures and Stationery

E-mail Signature ~ Personal Stationery

Theme or stationery for new HTML e-mail message
Theme... Mo theme currently selected

Font: |Use theme's font

New mail messages

Font... !

Sample Text

Replying or forwarding messages

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS
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Font... ! Sample Text |
[ Mark my comments with: | Barron Henley
|:| Pick a new color when replying or forwarding
Composing and reading plain text messages
Font... | Sample Text |
FIGURE 3-4
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Stop Marking Emails as Read When Viewed in Reading Pane

By default, Outlook marks emails as read when they are viewed in the Reading Pane. To retain
the unread status until emails are double-clicked to open, under Outlook panes, click on the
Reading Pane button. Uncheck Mark items as read when viewed in the Reading Pane and
Mark item as read when selection changes. Then click OK.

Reading Pane et

Reading Pane options

|:| Mark items as read when viewed in the Reading Pane

Wait |5 seconds before marking itern as read

Mark item as read when selection changes
|:| Single key reading using space bar

Turn on automatic full-screen reading in portrait orientation

Dﬁlways preview messages

Cancel

FIGURE 3-5

Turn Off Message Notifications

As described above, you can turn off email notifications and we strongly recommend that you at
least try this. Under Message Arrival, uncheck all of the boxes.

Message arrival

Fﬂ When new messages arrive:
-‘-D-'- Play a sound

Briefly change the mouse pointer
Show an envelope icon in the taskbar

Display a Desktop Alert

FIGURE 3-6

Automatically Open Replies and Forwards in a New Window

Depending upon what version of Outlook you have, when you click on the Reply or Forward
button in the navigation pane, it may open the reply/forward in the reading pane rather than as
a separate window. While you can click on pop-out to move the reply/forward out of the reading
pane and into a new window, you can change your settings to do this automatically. Under
Replies and Forwards, check the box to Open replies and forwards in a new window.

Replies and forwards

0 11~ Open replies and forwards in a new window

[+|iClose original message window when replying or forwarding:

FIGURE 3-7

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS PAGE 15
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Close Original Messages When Replying or Forwarding

When replying to or forwarding an email that was opened in its own window (by double-clicking
on the email), Outlook can automatically close the original email. Under Replies and forwards,
check the box to Close original message window when replying or forwarding.

Replies and forwards

+| Open replies and forwards in a new window
[{@

|| iClose original message window when replying or forwarding

FIGURE 3-8

Mark Messages as Read When Deleted

If you dislike having a bunch of email in your deleted items identified as unread, check the box
below under Other.

Other

o=| [+l Show Paste Options button when content is pasted into a message
=]
& +| Show Mext and Previous links in the message headers when reading messages
Don't automatically expand conversations when using the keyboard to change messages

After moving or deleting an open item: | return to the current folder =

+| Mark messages as read when deleted

FIGURE 3-9

Calendar Settings

All of these settings are found under the File menu » Options # Calendar.

Change Work Start and End Hours

If you work different hours or days than Outlook’s defaults, you can change them under Work
time.

Default Duration for Appointments and Meetings

When adding a new appointment on your calendar, Outlook defaults to a 30-minute duration.
You can change the default reminder time under Calendar options.

Calendar options

F— (] Add online meeting to all meetings @

Default duration for new appeointments and meetings: 30 minutes =

[[] Shorten appointments and meetings: -

FIGURE 3-10
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Default Reminder Timing

Outlook will add a 15-minute reminder to all calendar appointments by default. You can change
the default reminder time under Calendar options.

Calendar options

F—1 [T] Add online meeting to all n'uEEtings':I:I

- Default duration for new appeointments and meetings: 30 minutes ~
[] Shorten appointments and meetings: A
Lessthan one hour: 3 minutes =

Onehour orlonger. 10 minutes =

[v] Default reminders: | 15 minutes ~

FIGURE 3-11

Change Calendar Color

To change the default color of your calendar, select a new color under Display Options.

Display options

i:; Default calendar colon I G
=

Use thiz color on all calendars

FIGURE 3-12

Show Multiple Time Zones in Your Outlook Calendar

Under Time Zones, you can add one or two additional time zones to your calendar (which will
display side-by-side).

Time zones

@ Label: EDT

Time zone: | (UTC-05:00) Eastern Time (US & Canada) | G
+| Show a second time zone

Lakel: MOT

Timezone | (UTC-07:00) Mountain Time (US & Canada) -
+| Show a third time zone

Label: POT

Time zone: | (UTC-08:00) Pacific Time (U5 & Canada) -

Swap Time Zones

FIGURE 3-13
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People Settings

This setting is found under the File menu » Options # People. We recommend using the
settings below.

Names and filing

rQ: Default "Full Mame" order: G First (Middle) Last -
Default "File As" order: i Last, First -

+| Checkfor duplicates when saving new contacts

FIGURE 3-14

Advanced Settings

This setting is found under the File menu % Options » Advanced.

Change Your Reminder Sound and Avoid Missed Reminders

If you would prefer another sound as a reminder, you can make the change under Reminders.
Furthermore, many people have missed reminders in Outlook because they can hide behind
other applications. There's now a solution for that. Under Reminders, just check Show
reminders on top of other windows.

Reminders

Q +| Show reminders
~| Play reminder sound:  [reminder.wav Browse...

v| Show reminders on top of other windows

Autornatically dismiss reminders for past calendar events

FIGURE 3-15

Changes to the Quick Access Toolbar

You can add commands through the Quick Access Toolbar ("QAT") menu by clicking on the =
icon on the right edge of the toolbar, then choosing More Commands. The menu contains items
for the most common commands.

Select one of the common commands to add it to the toolbar. If your toolbar becomes too long
for the top of the screen, right-click the QAT, and select Show Below the Ribbon to have it
appear below the Ribbon. To add other commmands or to change the order of the icons on the
toolbar, select More Commands... to bring up the customize options (you can also get to this
window from File menu + Options # Quick Access Toolbar).

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 18
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Outlook Options r X
Use these to control the order
General EE.] Customize the Quick Access Toolbar. of your toolbar buttons
Mail
Choose commands from:
Calendar | Popular Commands &
People Customize Quick Acce: ar (D
Tasks parator> - S Send/Receive All Fol
ount Settings ") Undeo
Search dress Book.. G Change View »
Language tomatic Replies,
ose All ltems
Ease of Access ollapse the Ribbon
Advanced Y Pelete

If you don't
seea
command
you want,
change the
command
set

mpty Deleted ltems
Find Contact

Forward

Manage Rules & Alerts...
Meeting

Mew Appointment

Mew Contact

Mew Email

MNew Task

Options

Print

Reply

Reply All

Save All Attachments...
Save As

Send/Receive All Folders

|

FeeERermowe=

Selecta command
and click ADD to

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS

@j Touch/Mouse Mode put itin your 3
Unde . .
g toolbar .
Show Quick Access Toolbar bel ’i‘;
FIGURE 3-16
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CHAPTER 4
EMAIL: VIEWING AND

READING EMAIL

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Reading Emails

Double click on an email message, or single click the message with the reading pane open, to
read the email.

Emails with Attachments

Switch to viewing an attachment by left clicking on the attachment.

Brief

Danielle DavisRoe 3 Reply & Reply All —> Forward

Brief.dotx
‘ “Eﬂ 31 KB v

Please review the attached brief.

Thu 6/27/2019 11:38 AM

Danielle Dayi: Esa | Senior O

FIGURE 4-1
Switch back to the message by clicking on Back to message.

€ Back to message
Last changed:  Wednesday, May 13, 2009

Brief.dotx
31KB ¥

IN THE COURT OF APPEALS FOR FRANKLIN COUNTY, OHIO
TENTH APPELLATE DISTRICT
DENNIS RODMAN, EXECUTOR OF THE

ESTATE OF JANE DOE,
DECEASED

FIGURE 4-2

Conversations

To read emails as conversations, in the View tab, check the Show as Conversations box. This
groups email messages in a chain of emails and displays them as an expanding list.

PAGE 20
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lgnore Button

**Warning** use this sparingly or not at all. Clicking this will automatically move all future
emails in a thread to the deleted items.

See More Email at Once

If you tend to have a lot of emails in your inbox, you may want to see as many emails on the
screen as possible. If an email slides off the bottom of the screen, it is easy to forget about it. The
changes below will maximize the number of emails you can see at once.

Reading Pane

If the Reading Pane is at the bottom of the screen, it takes up space that could otherwise show
more email. To turn it off or move it, click on the View ribbon % Reading Pane button » Off or
Right.

& <9 s P search

File Home  Send/Receive Folder View Add-ins Help

G 48 D O show s Conversations I £ paee & from Gimo EP— T4 Reverse Sort 'E O|E

.
~ 51 Add Columns
Change View Reset Show Focused | Message ) . ]

View Settngs View nbox Provion P fgstatus ™ Fiag startDste P Flag: Due Date 18 5ize =

Use Tighter Folder |Reading| To-Do ]
Spacing Pane~ |Pane~ | Barv

Current View Messages Focused Inbox Arrangement Layol T Right
< [ gottom

if [T o

Options...
Inbox - Insight

FIGURE 4-3

~Favorites

Inbox - ddavisroe@affinityconsulti...

Date Grouping

By default, Outlook groups your email by date received. The date bars that run across your screen
take up space that could be used to show more email.

All - Unread By Date~ T

~ Today

American Bar Association
Articles For You T:06 AM

w~  Two Weeks Ago

Debbie Foster <
F: Microsoft Excel Tips: How to Master Autofill Like a Pro 8/14/2020

FIGURE 4-4

To turn it off the date bars, click on the View ribbon # View Settings button ® Group By...
button » uncheck Automatically group according to arrangement.

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS PAGE 21
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Message Preview

The message preview shows the first 1-3 lines of each email under the subject.

American Bar Association
Articles For You 706 Al
ABA content curated Tor you, Danielle

<http://click.em.americanbar.org/open.aspxffcb10-fecs16

FIGURE 4-5

Turning off the message preview allows you to see significantly more email on one screen. To
turn it off, click on the View ribbon » Message Preview button + Off.

Tighter Spacing (2021/19/365)

Using tighter spacing tightens up the spacing between emails, allowing you to see more emails
at once. View ribbon # Layout group + Use Tighter Spacing.

File Home  Send /Receive Folder View Add-ins Help

C R Sort T= S
s {Q}' Z) [ Show as Conversations @ = Bow ER From B BB Categories T Reverseso = O m

.
Change View  Reset ¥=1 Add Columns Use Tighter |Folder Reading To-Do
View > Settings View Spacing [Pane~ Pane~ Bar~

Show Focused  Message

fu Flag Status fe Flag: Start Date fu Flag: Due Date [l size -
Inbox Preview =

&

Current View Messages Focused Inbox Arrangement Layout

FIGURE 4-6

Compact Layout

If your email list is too narrow (either because your Outlook window is narrow or your Reading
Pane is fairly wide), Outlook switches to the compact layout by default. The compact layout
shows the sender in a larger font on the first line and the subject on the second line in a smaller
font.

American Bar Association 4 [ ]E
Articles For You 7206 A
I In Folder: Inbox - Group '| ]

~ Two Weeks Ago

Debbie Foster D)
Wi Microsoft Excel Tips: How to Master Autofill Like a Pro 8/14/2020
FIGURE 4-7
MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 22
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Turning off compact layout maximizing the number of emails you can see on one screen by
moving the sender's name and the subject to the same line. To turn off compact layout, click on
the View Ribbon + View Settings button » Other Settings button » Uncheck Use compact
layout... » tick the radio button for Always use single-line layout » OK button.

Reading Pane
(® Right () Bottom () Off
Other Options

DUsecnmpactlaynutinwidthssmallerthan 125 | characters
@Always use single-line layout OAIways use compact layout

@ Show messages from all folders in expanded conversation groups
Show conversation groups using Classic Indented view

Cancel

FIGURE 4-8

Compact Your Navigation Options (2016)

Outlook 2016 can use words at the bottom left corner of the email screen for allowing users to
switch between functions in Outlook.

Mail Calendar People Tasks -

tems: 36  Unread: 11

FIGURE 4-9

These words take up space that could be used to show more email. If you'd like to change the

words to smaller icons, click on the El button adjacent to the big words # Navigation options
# check Compact Navigation » OK button. This will convert the big words to little buttons as
follows:

| oa.
FIGURE 4-10

Unpin the Ribbon (2013/16)

Unpinning the Ribbon hides it when you are using it, allowing you to see more email at once. To
unpin the ribbon, click on the A icon in the bottom right-hand corner of the ribbon.

[, | Signore m = 9 | W process Me - . 8 oo _ | B NewGroup Search People A;) "% N @, & Block
E ™ I3 Clean Up ~ E @ @ S =5 > Tipht e SnCetegerize 3 Browse Groups | [B] Address Book ax B e Decode URL:
New New Delete Archive | Reply Reply Forward Shareto | 7 2 | BRdese | YnreRdd o, Up - ) Read | Tansiste | Get | Tru
Email ftems~ | Alunk~ Al v | Teams Create New = Read 2 S Filter Email~ | Aloud v Add-ins
New Delete Respond Teams Quick Steps ) Move Tags Groups Find Speech | Language | Add-ins | Reporter Add-in ~
FIGURE 4-11
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Inbox - ddavisroe@affinityconsulting.com - Outlook

File Home Send / Receive Folder View Help Kofax PDF

=1 New Email Search Current Mailbox 2 | Current Mailbox =

FIGURE 4-12

To pin the Ribbon open again (so that it stays open), click on the push pin icon.

Inbox - ddavisroe@affinityconsulting.com - Outlook

Send / Receive Folder View Help Kofax PDF

¥ 1 Unread/ Read | %2 New Group Search People 0+

= | rignore x D & (”\ & ip M 3 Triplt
=l 3 £ 5 Meeting rocess Me 3 Tipl .
SE | lean Up- e td 3 E7 Al - Cepiga ¥ Create New =7 | Wicategorize~ | /O Browse Groups | [EEiAddress Book .
New  Mew Delete Archive | Reply Reply Forward [ pjore - = | Move Rules ) Read 6
Email ftems~ | & lunk~ Al M - - > Folow Up - Y Fiter Email - | mjoug | Add-ing
New Delete Respond Quick Steps ] Move Tags Groups Find Speech | Add-ins =

Simplified Ribbon (2019/21/365)

Click on the arrow in the bottom right-hand corner of the ribbon to switch between the classic
and simplified ribbons.

& 29 - o X
Fle Wome Send/Recewe Foider View Addins Help Acrobat
My B B 55 ) Bwen g on ME [ MR oarch Pt A 52 o]
o tean Up ~ e 7 = “ - > = = B Address
New New = CECUOMUPY 0o srchive L Move Rules | Unresd/ Categorize Folow | H B pe | B AddessBook | Loy Get
Email temsv | 0 junke Read Up~ 7 Fier Email » - Add
It oelete nepond | Teams Quicesteps 5 o Tags Groups Fina Speech | Language  Ade

“Favorites

L PUITIONC <o "G KA WY vy WK o ORI, ACK,

FIGURE 4-14

Columns

Columns are useful for seeing information about your email at a glance (such as the sender's
name, the subject, and whether there is an attachment). Email can be quickly sorted based on
the columns and you can customize the columns to meet your needs.

Add or Remove Columns

To add or remove columns, click on the View Ribbon #» View Settings Button » Columns...
button.

To remove columns:
1. Click on the column to be removed on the right side.

2. Click on the < - Remove button.

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS PAGE 24
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Show Columns

Available columns:

MdLocation
SoftDelete

Properties Delete

Maximum number of lines in compact mode; | 2
Select available columns from:

User-defined fields in Inbg| «

Add -=

Show these columns in this order:

Importance
Reminder

|[ < - Remove

lcon
Attachment

MNew Column...

From
Subject
Received
Size
Categories
IMention

Move Up Move Down

Cancel

To add columns:

FIGURE 4-15

1. Click on the column to be removed on the left side.

2. Click on the Add -> button.

Reorder Columns

Reorder columns by click on the View Ribbon # View Settings Button + Columns... button.
Use the Move Up and Move Down buttons on the left side.

Available columns:

MdLocation
SoftDelete

Properties Delete

Add -=

<- Remove

Mew Column...

Show these columns in this order

Importance
Reminder
lcon
Attachment
From
Subject
Received
Size

Mention

Move Up Move Down

| OK | I Cancel

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS
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Sorting Email
Sort by Column

If you click on a column name, it will sort your email by that criterion. If you click the same column
name again, it will sort in reverse order.

Sort by Arrangement

You can also change how email is sorted by clicking the appropriate buttons in the Arrangement
group on the View Ribbon.

File Home  Send / Receive Folder View Add-ins Help

e  e—
I“% [@J)} Z) [ Show as Conversations @ E Date E‘Q From E‘Q To EE Categories Tl Reverse Sart

L,
=1 Add Columns

Change View  Reset ) ) I :

View~ Settings View FD Flag Status FD Flag: Start Date FD Flag: Due Date lal Size =1

¢

Show Focused Message

=
= Inbox Preview i

Current View Messages Focused Inbox Arrangement

FIGURE 4-17
Filtering Email
All/Unread (2019/21/365)

Click on Unread at the top of your list of emails to quickly filter your inbox for unread emails only.
Click on All to show all emails - whether read or unread.

All - Unread ByDate~ T

~ Today

Karen B. Scher
FW: You've been invited to 2020 AHA by Barron Henley 10:57 AM

Karen B. Scher

RE: You've been invited to 2020 AHA by Barron Henley 10:44 A
Karen B. Scher D)
FW: You've been invited to 2020 AHA by Barron Henley 10:42 A

American Bar Association
Articles For You T:06 AM

FIGURE 4-18

The All/Unread filters are unavailable if you are using the focused inbox. To turn off the focused
inbox, open your inbox by clicking on the inbox in your folder pane, then go to the View ribbon
and toggle off Show Focused Inbox. The button to toggle the focused inbox on and off only
appears when you are in your inbox - it does not appear if any other folder is open.

File Home  Send /Receive Folder View Add-ins Help

C =i R S
I‘% [{é} lo [ Show as Conversations @ @ Date i} Erom i) To EE Categories T»L everse Sort

=1 Add Columns

E::\:gf S:I::r:\;s 5,?::: ltl Shoul\;zi;used phf:‘;:?f FD Flag Status FD Flag: Start Date FD Flag: Due Date I Size ;
Current View Messages Focused Inbox Arrangement
FIGURE 4-19
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Focused/Other (2019/21/365)

The focused inbox filters email into two tabs: Focused and Other. Microsoft uses rules to
determine where to place emails. To turn on the focused inbox, click on the inbox in your folder
pane, then go to the View ribbon and toggle on Show Focused Inbox. The button to toggle the
focused inbox on and off only appears when you are in your inbox - it does not appear if any other
folder is open.

File Home  Send /Receive Folder View Add-ins Help

C =i R S
I\% [{é} lo [ Show as Canversations @ E Date Ea From i) To EE Categories T»L everse Sort

=1 Add Columns

Change View  Reset =1 Show Focused Message

s ‘ ‘ = -
View - Settings View Inbox Preview « FD Flag Status FD Flag: Start Date FD Flag: Due Date Size =

Current View Messages Focused Inbox Arrangement

FIGURE 4-20

Click on Focused and Other at the top of your inbox to flip between the two inboxes.

Focused  Other

FIGURE 4-21

You can move emails between the focused and other inboxes by right-clicking and selecting
Move to Focused or Move to Other.

(@ Copy

G Quick Print
< Reply

%3 Reply Al
— Forward

&1 Mark as Unread

B8 Categorize >
0 Follow Up »
= Find Related >
£ Quick Steps ?
{C:?} Set Quick Actions...

[ Rules »
C Move >

B Move to Other
&7

Always Move to Other

FIGURE 4-22
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You can change the rules to always send emails from a particular sender to either inbox. Right-
click on an email from that sender and select Always Move to Focused or Always Move to Other.

Conditional Formatting

Conditional formatting allows you to change the format of emails based upon certain conditions
(for example, if the email is from a certain person or group of people, you could have those emails
automatically turn red and bold the second they hit your inbox). The conditional formatting

settings are found by clicking the View Ribbon * View Settings button * Conditional
Formatting button.

Unread emails are blue and bold by default due to conditional formatting. To change how unread
emails appear:

1. View Ribbon # View Settings button + Conditional Formatting button.

2. Select Unread messages.
3. Click on the Font... button.
4. Select the desired font, styles, size, and effects.
5. Click OK.
> || Font X
Rules for this view: Font: Font style: Size:
|| Unread messages I Regular Mormal | oK |
I+ Unread group headers — =
b o e n ~| [Smate
» [ . Segoe Ul Emoji Italic Cancel
|| Expilled email Bi
] overbive email Segoe Ul Symbol Semibold ig
i " SHOTEWK BY Semibold Italic Bigger
|| Mesgages in other folders _
- . . Move Up SHOWCARD COTHIC Bold
|| Site Wailbox document pending up )
] Sitka Banner Bold Italic
p) Gma itla D v | [Black v
] acG Move Down Sitka Display ]
Propertis of selected rul Effects Sample
d messages [ strikeout
) AaBbYyZz
Color:
Condition... |-CUSK"'r1 ~ | Script:
|Westem v
oK Cancel

FIGURE 4-23

You can also create your own conditions, such as emails from a particular sender. Conditional
formatting can be used to draw attention to emails from important senders.

1. View Ribbon * View Settings button + Conditional Formatting button.
Click on the Add button.

Name the condition.

Click on the Font... button.

Select the desired font, styles, size, and effects.

Click OK.

Click on the Condition... button.

N o ouh NN
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8. On the Messages tab, enter the person's email address in the From box.

Filter X

Messages More Choices Advanced

Search for the word(s): ™
In: | subject field only e
From... punger@affinityconsulting.com|
Sent To...
[Jwhere 1 am: the only person on the To line
Time: none ~ | |Anytime

Cancel Clear all

FIGURE 4-24

Folders

Email folders allow you keep your email organized. Legal professionals often create folders for
clients or matters to keep related emails together.

Create Folders
To create a new subfolder under your Inbox:

1. Right-click on your Inbox and select New Folder.

Inbox
Jlj Open in New Window
Archive 1568

New Folder...
Inbox - Group =
MetDocs Group -
Copy Folder
Sent ltems B ~opy
1
FIGURE 4-25

2. Giveita name.

To create a folder nested under another folder, right-click the name of the parent folder and
select New Folder.
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Reorder Folders

To reorder the folders, drag and drop them in the folders pane.

4 Inbox
I> Archive 1568
Demo Mails 3
Inbox*oup
MNetDodd Group

Smith v. Jones

Sent ltems

Drafts [21]

FIGURE 4-26

Managing Multiple Inboxes

You might have multiple inboxes if you have access to someone else's inbox, have access to a
shared inbox, or have added additional email accounts (such as a personal email account) to
Outlook. Managing multiple inboxes can be a bit tricky but gets a lot easier with favorites.

Favorites appear at the top of your Folder Pane. If you don't see them, enable them under View
ribbon » Layout group ® Folder Pane » Favorites.

Adding each inbox to your favorites will make them easier to access and help you notice when
there are unread emails in them. Right-click on each inbox and select Add to Favorites.

~Insight
» Inbox
Drafts -il-_=| Open in New Window
Sent ltem D MNew Folder...
Deleted It E7
Archive % Copy Folder
» Conversa
Junk Ema =
Outbox O3
) Mark All as Read
> Archive =
|
> Training
1 Add to Favortes

FIGURE 4-27

You can add any other folders that you frequently access to your favorites as well for easy access.
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Right-Click Emails for All Possible Options

Right-click on an email to see a full range of options.

Zoom (@ Copy —
Cloud Recording - £ Tue 1:39 PM
B Quick Print b

€3 Reply

&y Reply Al

— Forward

&1 Mark as Unread

oo Categorize *
M Follow Up >
Find Related >
Quick Steps >
Set Quick Actions...

Rules >

ol @ %[

Move ?
Ignore
Junk >

Delete

[ = 2 &

Archive...

FIGURE 4-28

Add-In: Translate (2019/21/365)

Outlook 2019/21/365 can automatically translate emails.

To use Translate, on the Home ribbon, click on Translate.

e
5

Translate

i

Language

FIGURE 4-29
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Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Types of Emails

New Messages

To start a new email message, on the Home ribbon » New group + New Email button (KS:
Ctrl + N).

A blank email will appear with your default signature (if one is set up). To setup your default
signature, see page 12.
Replies

There are two options when replying: Reply and Reply All. When replying to an email sent to you
(regardless of whether you were included on the to, cc, or bcc line), Outlook will send the reply to
only the sender of the email you are replying to. When replying all to an email sent to you, Outlook
will send the reply to the sender and everyone who receive the email you are replying to
(excluding anyone who was emailed using bcc).

If you reply to an email you sent someone else, the reply will go to you. However, if you use reply
all, the email will go to everyone on the original email and Outlook will not copy you on your reply.

If there was an attachment on the email you are replying to, Outlook will not include the
attachment on the reply. If you add new people to the email thread with a reply, they will not
have access to the attachments to any prior emails in the thread.

Forwards

Use forwards to send emails and their attachments to people who were not copied on the
original email. Forwards automatically include any attachments from the email being forwarded.

Recipient Fields

There are three recipient fields you can use when drafting an email: to, cc, and bcc. You can add
more than one recipient to each field.

To

Use this for the main recipient(s) of your email - those you expect reply to your email.

Cc

Use cc (carbon copy) for anyone who needs to be kept in the loop, but you aren't expecting to
reply to your email.

PAGE 32
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Bcc

Use bcc (blind carbon copy) to copy anyone on the email without others knowing they were
copied on the email. If you don't see the bcc field, click on Options # Show Fields + Bcc button.

Edit The Auto-Complete List

Outlook stores a list of people you've emailed as an Auto-Complete list. When you start typing
someone's name in a recipient field, Outlook gives you a list of options to choose from. You can
remove people from that list by clicking on the X to the right of their name in the list.

E‘ From ddavisrce@affinityconsulting.com
Send To JEf'fI
Ce leff Schoenberger %
Jschoenberger@affinityconsulting.com
Bec

Jeff Krause
JKrause@affinityconsulting.com

_—
Subject Jeff Stouse

Jstouse@affinityconsulting.com

00

FIGURE 5-1

Changing Your Email Signature

Outlook automatically adds your default email signature default signature (if one is set up) to
new emails, replies, and forwards. To setup your default signature, see page 12. You can set up
additional email signatures and change email signatures as needed on an email-by-email basis.
Right-click on your signature and select the desired signature from the list.
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Danielle DavisRoe, Esq. | Sehinr Cancultant

Affinity Consulting Group ¥ Danielle

1550 0d Henderson Road, Suite 5 0
614-340-3444 | 614-310-8852 (dir Reply
ddavisroe@affinityconsulting.com
affinityconsulting.com

Y . TRAINING.
— ﬁ‘ff.'ﬂ'ify SIMPLIFIED.

Meed help with an issue? help@affinityconsulting.com

 flin[®)

Signatures...

FIGURE 5-2
If you don't have a signature in your email, click on the Insert ribbon % Include group +
Signature button to add a signature.

Email: Frequently Used Text
AutoText

AutoText provides an easy way to insert repetitive blocks of text into your emails quickly.
Accessing AutoText

When drafting an email message, AutoText is found at Insert ribbon » Text group # Quick
Parts button arrow » AutoText. Adding it to your Quick Access Toolbar makes it much faster to
access:

1. Click in the body of your email.
2. Onthe Insert ribbon, in the Text group, click on Quick Parts.
3. Right-click on AutoText and select Add to Quick Access Toolbar.

File Home  Send / Receive Folder VWiew  Add-ins Help

~ [ IS Ignore @ 7 Bl Masting
—|— E E é_) Add to Quick Access Toolbar I

[EZ Clean Up ~ Delete Archive | Reg

Mew Mew

Ernail Items ~ %Junkv Hide Quick Access Toolbar I
New Delete Customize the Ribbon... b
E Collapse the Ribbon
v Favorites All - Unreac )
— Use Simplified Ribbon
Inboo - ddavisroe@affinityconsulti.. e oo
FIGURE 5-3
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If you add AutoText to your Quick Access Toolbar, you can create AutoText or use existing
AutoText from there.

Create AutoText Entries
1. Type the text you commonly re-use (or find it in an existing email).
Select (highlight) the text.

Click on the Insert ribbon # Text Group * Quick Parts button arrow # Auto Text # Save
Selection to AutoText Gallery.

4. Give the AutoText entry a name and click OK.

Create Mew Building Block ? x
Mame: IEin|

! —
Gallery: AutoText e
Category: General e
Description:
Save in: MarmalEmail. dotm e
Dptions: Insert content only e

FIGURE 5-4

Use AutoText Entries
There are two ways to do this:

e Click the Insert ribbon » Text Group # Quick Parts button arrow # Auto Text ® then
click the appropriate AutoText entry.

or

e Type afew letters of the name of the entry®hit F3 or Enter.

Add-In: My Templates (2019/21/365)

Use email templates to avoid having to re-write frequent emails. Some good use-cases include
new matter request forms, sending instructions to a client, directions to your office, etc. They
aren't super sophisticated, but they are very easy create and helpful!

Create Templates
To create an email template:
1. Create a blank new email.

2. Select View Templates from the Message ribbon.
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BN Untitled - Message (HTML) P search
File  Message Insert Options FormatText Review Help

a) . s . allow Up ~ ¥ @ AttachFiles~

Calibri YA A Ry E 8 mj @ D i Follow Up ﬁ' ﬂ, @

@ ﬁ ) M ! = o I High @ o ar Files ~ S [‘;
Encryption Paste B 1 u 2. A = Address Check  Attach Link Signature - MR ImPertance piey. Editer | Immersive Clean equest Files Calendly | View

Off ~ ~ < Format Paints - = T Book Names  Filer - ~ | Lowimportance cader en & Initiate Workflow Templates
Citrix Files = Undo Ciipboard 5 Basic Text ) Names Include Tags § veice | Sensitvity | Editor _Immers itic Fles Calendly Ty TermBIEes

3. Scroll to the bottom and select + Template.

GA. He I5s a member of the American Bar
Association, Columbus Bar Association, Ohia
State Bar Association, Ohio Association for
Justice, and New York State Bar Associatio| Scroll down
and specializes in document and case
management, paperless office strategies,
trial presentation and litigation technology,
and legal-specific software training and
professional development for law firms and
legal departments throughout the United
s, Canada and Australia. Mr. Unger has
Create New  jqa( trial presentation consultation for
Template 1100 cases. In his spare time, he likes to
ramand restore historic homes.

(#) Template v

FIGURE 5-6

4. Name the template in the first field and paste your desired text in the second field and hit
Save.

Use Templates

To use/apply your email template, open a new email, select the View Templates button, and
simply left click on the desired template.

Email: Out of Office Replies

Outlook can automatically respond to any email messages you receive with an automatic reply.
Be warned that if you receive email from a listseryv, this may be a problem because every time
someone sends a post to the listserv, everyone on the listserv is going to get your out of office
message.

Manage Automatic Replies

To manage your automatic reply to anyone who contacts you while you are out of the office, go
to File menu #» Info (left side) » Automatic Replies button.
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Automatic Replies - ddavisroe@affinityconsulting.com

() Do not send automatic replies
{®) send automatic replies
[ ] only send during this time range:
Fri 1/11/2019 . 1:00 PM |~

Sat 1/12/2019 52 1:00 PM 823
Automatically reply once for each sender with the following messages:
4 - - - . - -
&i Insicle My Organization Q Outside My Qrganization (On)

Segoe Ul ~ |7 ~

Il
il
i

B I U A:=:
|

Cancel

FIGURE 5-7

Turn On Automatic Replies

Click on the radio button next Send automatic replies to turn on automatic replies. By default,
automatic replies turn on immediately and you must manually turn them off. To set it and forget,
check the box to Only send during this time range. You can then select the start and end times.

Turn Off Automatic Replies

When automatic replies are turned on, Outlook will show a yellow bar across the top of your
email. To turn off the automatic replies, click on the Turn Off button.

@ AUTOMATIC REPLIES Automatic Replies are being sent for this account.

Turn off

FIGURE 5-8
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To add an attachment, either click the attachment button or drag and drop the attachment into
the email.

Always save the attachment first before editing. Double clicking the attachment and opening it
from Outlook creates a temporary copy of the file. If you edit the file and just click “save” (as
opposed to “save as”), the changes will only be saved to the temporary file. You may or may not
be able to recover those changes later.

Polls (2019/21/365)

Polls can be used to quickly collect information from email recipients using simple Microsoft
Forms.

Creating Polls
To create a poll in an email message:
1. Onthe Insert ribbon, click on Poll.

2. In the Poll panel, add your question and options.

Poll X

115/330

w available to meet Friday afternoon?

Yes

Mo T

+ Add option

@ ) Multiple answers

Mext

FIGURE 5-9
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3. Click Next.
4. Click on Add to email.

Responding to Polls

CHAPTER S

The poll recipients can respond to the polls by click on an option and clicking on the Vote button.

|POH: Are you available to meet Friday afternoon?

Danielle DavisRoe €3 Reply | % Reply Al

To Danielle DavisRoe
Cc Danielle DavisRoe

Quick Poll

Your email address will be sent with your response.

Are you available to meet Friday afternoon?
O Yes
O No

View Results

Powered by Microsoft Forms

—» Forward

Tue 3/23/2021 417 PM

FIGURE 5-10

Viewing Responses

Open the email with the poll and click on View results to see the responses.
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Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Rules automatically take actions when certain conditions are met. For example, rules can be used
to auto-file incoming email into specific folders. Rules are very powerful and can save you a lot of
time. However, because they happen automatically, you need to be careful about creating rules
that make it so you may miss incoming emails.

Rule Parts

Rules have 3 parts:

e Condition (Optional): Use conditions to determine when to the apply the rule. If no
conditions are set, the rule is applied to every incoming email. Conditions include things
like emails from particular senders, with particular subjects, sent only to you, and with
specific words in the email. If no conditions are set, the rule will be applied to every
incoming email.

e Actions: The action is what happens when the condition is met. Actions include things
like moving to a specified folder, categorizing the email, deleing the email, forwarding the
email, and flagging the email.

e Exceptions (Optional): Exceptions to the conditions prevent the rule from being applied
to certain emails. Exceptions include things like emails from particular senders, with
particular subjects, sent only to you, and with specific words in the email.

Rules Wizard

The Rules Wizard walks you through creating simple rules based on templates.
1.  Onthe Home ribbon, click on the Rules button and select Manage Rules & Alerts.
2. Click on the New Rule button.
3. Select the desired template and click on the Next > button.
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Rules Wizard X
Start from a template or from a blank rule
Step 1: Select a template
Stay Organized
Move messages from someone to a folder
K f fold
Move messages with specific words in the subject to a folder
g5 ith ifi ds in the subj fold
E‘J:I Move messages sent to a public group to a folder
Fh Flag messages from someone for follow-up
E‘J:I Move RSS items from a specific RSS Feed to a folder
Stay Up to Date
&7 Display mail from someone in the New ltem Alert Window
<|J:') Play a sound when | get messages from someone
D Send an alert to my mobile device when | get messages from someane
Start from a blank rule
&~ Apply rule on messages | receive
E’ Apply rule on messages | send
FIGURE 6-1
4, Under Step 1, check the boxes to add additional conditions, if any.
5. Words in blue are variables that you can change. Under Step 2, click on the variables to
change them.
Step 2i Edit the rule description [click an underlined value]
App i he message arrives
with specific words jn the body
Cancel < Back Mext = Finish
FIGURE 6-2
Click on the Next > button.
7. Under Step 1, check the box(es) next any additional action(s), if any.
Words in blue are variables that you can change. Under Step 2, click on the variables to
change them.
9. Click on the Next > button.
10. Under Step 1, check the box(es) next the desired exception(s), if any.
1. Words in blue are variables that you can change. Under Step 2, click on the variables to
change them.
12. Click on the Next > button.
13. Name the rule.
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14. Optionally, to apply the rule to all emails in your inbox, under Step 2, check the box for

Run this rule now on messages already in "inbox."
15. Click Finish.

Create Rules from Existing Emails

You can also create rules from existing emails. Doing so pre-populates many of the fields for you.

Simple Rules

The simplest rules to create use sender, subject, and/or recipient as the condition and move the
email into a specified folder or create an alert as the action.

1. Find an email that meets your conditions.
Right-click on the email and select Rules » Create Rule...

The Create Rule dialog will pre-populate with information from the email, including the
sender, the subject, and the recipients. Check the box next to the desired condition(s).

Check the box next the desired action(s).
5. Click OK.

When | get email with all of the selected conditions

[ ] From Paulo Villanueva

|:| Subject contains | Video Editing

|:| Sentto | Brian Bulagsak e
Do the following

|:| Display in the Mew [tem Alert window

|:| Play a selected sound: Windows Motify Em 3 | Browse...

|:| Move the item to folder: | ShareFile Select Folder...

oK Cancel Advanced Options...

FIGURE 6-3

More Complex Rules

You can create more complex rules from existing emails, you just need to use the advanced
options.

1. Find an email that meets your conditions.
Right-click on the email and select Rules » Create Rule...

Click on the Advanced Options... button.

INENEEN

Under Step 1, check the box(es) next the desired condition(s).
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5. Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change
them.

Step 2: Edit the rule description [click an underlined valueg]
Ap.ﬂ' he message arrives
with specific words jn the body
Cancel = Back Mext = Finish
FIGURE 6-4
Click on the Next > button.

7. Under Step 1, check the box(es) next the desired action(s).

Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change
them.

9. Click on the Next > button.

10. Under Step 1, check the box(es) next the desired exception(s), if any.

1. Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change
them.

12. Click on the Next > button.

13. Name the rule.

14. Optionally, to apply the rule to all emails in your inbox, under Step 2, check the box for
Run this rule now on messages already in "inbox."

15. Click Finish.

Example Rules
Delay Send Email by One Minute
Instructions to set up a rule to delay sending mail by one minute (in case you change your mind):

1.  Onthe Home ribbon, click on the Rules button and select Manage Rules & Alerts.

2. Click the New Rule button.

3. Select Apply rule on messages | send and click Next.
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Rules Wizard

Step 1: Select a template
Stay Organized

Stay Up to Date

Start from a template or from a blank rule

E.J, Move messages from someone to a folder

DJ' Move messages with specific words in the subject to a folder
E.J, Move messages sent to a public group to a folder

F] Flag messages from someone for follow-up

E.J, Move RSS items from a specific RSS Feed to a folder

B2 Display mail from someaone in the New Item Alert Window

(]1):1 Play a sound when | get messages from someane

D Send an alert to my mobile device when | get messages from someone
Start from a blank rule

™ Apply rule on messages | receive

P Apply rule on messages | send

FIGURE 6-5

CHAPTER 6

4. On the next screen ("which conditions do you want to check"), don't check anything (you
want this rule to apply to every email you send) and click the Next button at the bottom.
You'll see the following dialog (click Yes):

Microsoft Outlook

>

| This rule will be applied to every message you send. Is this correct?

Yes Mo

FIGURE 6-6

5. In the next screen, check defer delivery by a number of minutes, and then click the
hyperlink for a number of at the bottom of the screen and enter the number of minutes
you want to delay your email. Click OK.
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What do you want to do with the message?
Step 1: Select action(s)

[] assign it to the categary category

[] move a copy to the specified folder

[] flag message for action in a number of days
[] clear message's categories

[] mark it as importance

[] stop processing more rules

[] mark it as sensitivity

[] notify me when it is read

[] notify me when it is delivered

Crtha maseana tn neonle A Sublic aron
)

|
defer delivery by a number of minutes

Deferred Delivery X

Defer delivery by |1 = minutes

Step 2: Edit the rule descriptio ck an underlined value)

Apply this rule after | sen

message
defer delivery by a numbé&f of minutes

FIGURE 6-7
6. Click Next and add any exceptions (for people you don't want to delay email to).

7. Click Next, name your rule "Delay" (or anything else you want to name it) and click Finish.

Keep Track of Delegated Email

Many people forward email to others to deal with but have a difficult time remembering what
they delegated for follow up purposes. Here's a rule that will help.

1. Onthe Home ribbon, click on the Rules button and select Manage Rules & Alerts.
2. Click the New Rule button.

3. Select Apply rule on messages I receive and click Next.

MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 45

5-67



A

Y
—
Affinity CHAPTER 6

Rules Wizard >

Start from a template or from a blank rule
Step 1: Select a template
Stay Organized
E‘J:I Move messages from somecone to a folder
E—I Move messages with specific words in the subject to a folder
E‘J:I Move messages sent to a public group to a folder
Fh Flag messages from someone for follow-up
E‘J:I Move RSS items from a specific RSS Feed to a folder
Stay Up to Date
&7 Display mail from someone in the New ltem Alert Window
(]J)) Play a sound when | get messages from someone
D Send an alert to my mobile device when | get messages from someane
Start from a blank rule
Apply rule on messages | receive |

Apply rule on messages | send

FIGURE 6-8

4. Under "Which conditions do you want to check?" check BOTH from people or public
group and where my name is in the CC box. At the bottom of the dialog, click the
hyperlink for people or public group and add your email address. We're basically creating
a rule that will look for emails from you and copied to you. Click Next.

lans | Grouns | Eincl | Sneech | &

wWizard Rule Address .

o

Which condition(s) do you want to check?

Search: (@ Mame only () More columns  Address Book
elect condition(s)

1 1 Go Offline Global Address List - ddavisroe@affi ~ Advanced Find

from people or public group
|| with specific words in the subject

[ ] through the specified account | Name Title Business Phane Location Department
[] sent only to me (J 20078-Affinity Consulting G... 866-203-9649 ~
[] where my name is in the To box ézw?s-nffinity&nsuting...
| marteg a5 Imporance R A_EARCHIVE@ACG2
[] marked as sensitiviy ABA TechShow 2017
[ | flagged for action Q
Pl Abacus Next

[/ where my name is in the Cc box Q
|| where my name is in the To or Cc box R\ Accelo Help
[] where my name is not in the To box (€5 Accelo Log
[] sent to people or public group ACG Administrator
[ with specific words in the bady RACG Demo
[] with specific words in the subject or bady {o\ACG Help
[] with specific words in the message header RACG Jobs
O w?th sgec?ﬁc words ?n the recipient's address RQACGA Accounting
[ with specific words in the sender's address QACGAF
[] assigned to category category R ax

! Bilncen Order v
Step 2: Edit the rule description (click an underlined va| | € >

Apply this rule after the message arrives
where my name is in the Cc box
and from people or public grou

ddavisroe@affinityconsulting.com|

FICURE 6-9

5. Under "What do you want to do with the message?" choose move it to the specified
folder. Make the specified folder your Delegated Mail folder. Click Next and add any
exceptions. Click Next, name it and click Finish.
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What do you want to do with the message?
tep 1: Select action(s)

move it to the specified folder

;gn T Hl— F=rat=
[] delete it

[] permanently delete it
[] move a copy to the specified folder
[] forward it to people or public group
[] forward it to people or public group as a
[] redirect it to peaple or public group

R Pt ]
=T

[] reply using a specific template
[] flag message far follow up at this time
[] clear the Message Flag

[] clear message's categories
[] mark it as importance

[] print it

[] play 2 sound

[] mark it as read

[] have server reply using a specific messag

Rules and Alerts

Choose a folder:

v [ Inbox

] Archive (1571)
Delegated
D Demo Emails (3)
D Inbox - Group
D MetDocs Group
D Smith v. Jones

w E;g ddavisroe@affinityconsulting.com ~

| QK |

Cancel

Mew...

Manage Rules
Turning Off Rules

Turn rules off by un-checking them in the Rules and Alerts dialog.

1. Onthe Home ribbon, click on the Rules button and select Manage Rules & Alerts.

2. Uncheck the boxes next to any rules you want to turn off.

Reo

rdering Rules

[] stop processing more rules D Sent ltems
Drafts [21]

Step 2: Edit the rule description (cli Deleted ltems (545)

Apply this rule after the messa rrives D Archive

where my name is in the Cc 5‘3‘3 Calendar

and from Danielle Davi A= rontads >
move it to the specifiedolder —
] [_
FIGURE 6-10

CHAPTER 6

Rules are processed in the order in which they are listed in the Rules and Alerts dialog. The order

may make a difference if more than one rule applies to an incoming email.

1. Onthe Home ribbon, click on the Rules button and select Manage Rules & Alerts.

2. Use the up and down arrows to reorder the rules.
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ty

Email Rules  mManage &lerts

;7 Mew Rule... Change Rule - E]g Copy... ){gelete hd kun Rules Mow... Options

FIGURE 6-1

Stop Processing Rules

Sometimes, when a condition is met and a rule is applied, you want to stop processing other
rules. Stop processing rules is an action that can be added to any rule. See below for instructions

on how to edit any existing rules.
Editing Existing Rules
You can edit any existing rules through the Rules and Alerts dialog.
1.  On the Home ribbon, click on the Rules button and select Manage Rules & Alerts.

2. Click on Change Rule.
3. Select Edit Rule Settings...

Fules and Alerts

Email Rules  Manage Alerts

.9 Mew Rule.. Change Rule~ ER Copy.. < Delete * A
Rule (applied | Edit Rule Settings... |
noreply @sf-n Renarme Rule
L]
FIGURE 6-12
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CHAPTER 7
EMAIL: QUICK STEPS

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Quick steps are used to automate repetitive steps. Unlike rules, they are not automatically
applied. You must click on a button or use a shortcut key to invoke the quick step. Because they
are not automatically applied, there are no conditions or exceptions to set up. Quick steps can be
used for things such as moving email to a folder, deleting email, marking it as read, flagging it,
categorizing it, creating appointments, or replying/forwarding.

Creating Quick Steps

1. Onthe Home ribbon, in the Quick Steps group, click on Create New.

File Home  Send /Receive Folder View Developer Add-ins  Help

I_V_l.l_ % 'F@ lgnore m E QIZI @ E @ Meeting 0 E‘L-I Process Me E‘l’-‘ Process and Flag

- - | .
New  New TR Clean Up Delete Archive Reply Reply Forward E M Shareto o S ~ Triplt
Email Items ~ % Junk ~ All E‘D More ~ Teams 3; Create New ~
MNew Delete Respond Teams Quick Steps I
FIGURE 7-1

Name your quick step.

Choose an Action and complete any necessary fields for that action.
Click on the Add Action button to add any additional actions.

Click Finish.

(I NN

Example Quick Step: Forward Emails

If you frequently forward emails to the same person or group of people, setting up a quick step
can reduce the number of clicks it takes to forward emails in the future.

1. Onthe Home ribbon, in the Quick Steps group, click on Create New.

File Home  Send /Receive Folder View Developer Add-ins Help

I_V_ll % 'F-@ lgnore m E élzl @ 8 @ Meeting %% E‘L-I Process Me E‘L—I Process and Flag

- - | i
New  New % Clean Up Delete Archive Reply Reply Forward b Shareto [T Bppcise - Triplt
Email Items~ 0 junk~ All &5 Mare ~ Teams 7 Create New -
MNew Delete Respond Teams Quick Steps I

FIGURE 7-2
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Name your quick step.
Under Choose an Action, select Forward.
In the To field, enter the emails address(es) of the recipients.

Click on Show Options.

CHAPTER 7

Edit Cuick Step

Mame:
Forward

~

Add actions below that will be performed when this guick step is clicked an.

— Forward

To.. john@doe.com

b

5

]

I Show Options I

FIGURE 7-3

6. Add cc or bcc addresses, change the subject, set a flag, or mark the importance, if desired.
7. Add default text to the body of your email (if desired) with the Text field.

10.

.

12.

Importance: Ma Change et

To.. john@doe.com
Hide Qptions
Add Cc Add Becc
Subject: FW: <subject=
Elag: Mo Flag W

.y
oy

%)

Text: Flease handle this.

] Autclmat'rcar-l'y send after 1 minute delay.

FIGURE 7-4

To automatically send the email, check the box to Automatically send after 1 minute
delay. If you do not check this box, the forward will open. You will have the opportunity to
change the email recipients or text, but you must click send to forward the email.

To move the forwarded email out of your inbox and into another folder, click on the Add

Action button.

Under Choose an Action, select Move to a Folder.
Under Choose Folder, select the desired folder.
Click Finish.
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Using Quick Steps
After the quick steps are set up:
1. Select the email(s) you want to apply the quick steps to.

2. On the Home ribbon, in the Quick Steps group, click on the name of the quick step.

Assigning Keyboard Shortcuts

You can assign keyboard shortcuts for up to 9 quick steps:

1. Onthe Home ribbon, in the Quick Steps group, click on the ™ button, and select Manage
Quick Steps.

2. Select the quick step and click Edit.
Under Shortcut key, select a shortcut key.

Edit Quick Step 7 x

Mame:

\l/ Process Me

Edit the actions the quick step performs.

Actions

El:ll"dnvetnfnlder W ]E
] Processed w
=] Mark as read v | il

Add Action

Cptional

—  — = |
Shortcut key:  |[EIESS ISER "

en the mouse hovers over the quick step.

Save Cancel

FIGURE 7-5
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Managing Quick Steps

"

To manage your quick steps, on the Home ribbon, in the Quick Steps group, click on the
button, and select Manage Quick Steps. From the Manage Quick Steps dialog you can edit quick
steps, duplicate them, delete them, reorder them, or create new quick steps.
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CHAPTER 8
EMAIL: STORAGE AND

INBOX CLEAN UP

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Mailbox Cleanup

Mailbox Cleanup helps you manage the size of your email by find emails of a certain age or size,
autoarchiving email, emptying your deleted items folder, and deleting conflicts. Access it by
clicking File menu ¥ Info tab (left side) » Tools # Mailbox Cleanup... button.

= Mailbox Settings
fg Manage the size of your mailbox by emptying
Tools -
B 901 G0 fraa nf Q0 GB
I_vl Mailbox Cleanup...
@? Manage mailbox size with S
advanced tools.

2 help organize your ing|

FIGURE 8-1

Removing Redundant Messages

An email conversation is also known as a thread. Many people have multiple emails in their
Outlook folders which are earlier pieces of the same thread. The last email in time contains the
entirety of the conversation so the older ones aren't needed. Clean can remove the redundant

messages from your inbox for you. Any email with a unique attachment will be retained in your
inbox. Your sent items will not be affected.

1.  On the Home ribbon, click the Clean Up button in the Delete group.
[E2 Clean Up - h'” — 1

s AL | -

'F"x Clean Up Conversation
Clean Up Folder

Clean Up Folder & Subfolders

FIGURE 8-2
2. Click one of the following:

e Clean Up Conversation: The current Conversation is reviewed, and redundant
messages are deleted.
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¢ Clean Up Folder: All Conversations in the selected folder are reviewed, and redundant
messages are deleted.

e Clean Up Folder & Subfolders: All Conversations in the selected folder and any folder
that it contains are reviewed, and redundant messages are deleted.

Archive Old Outlook Email

Outlook users end up with an enormous accumulation of email in their Sent Mail and Deleted
Mail folders. Furthermore, some mail is sorted into subfolders and forgotten about. All of this will
start to bog down servers and PCs as those databases of emails get larger and larger. Thankfully,
Outlook has an excellent way to dealing with this problem - AutoArchive. In a nutshell,
AutoArchive will allow you to a) permanently delete expired items, b) delete, or ¢) archive old
items to an archive file (archived database). Conveniently, the first time AutoArchive runs, it
creates the archive database for you. It is stored on the C:\ by default so you'll either want to move
it to a server folder or back it up directly from your C:\. Once it has established itself, you'll see the
Archive folder in your Outlook Folder List. There are two sets of AutoArchive settings: global
settings and per-folder settings.

Turning AutoArchive On or Off

1. Click the File » Options » Advanced » AutoArchive Settings... button.

Outlook Options ? X

General

@ Options for working with Outlook.
Mail

Calendar Outlook panes

Groups El Customize Qutlook panes.
Navigation...
People Reading Pane...

Tasks
Qutlook start and exit

Search

Language @ Start Outlook in this folder: |[EInbox

Empty Deleted Items folders when exiting Cutlook

Ease of Access

AutoArchive

Customize Ribben FlE Reduce mailbox size by deleting or moving old items to an archive data file. | Autohrchive Settings... |

Ouick Access Toolbar

FIGURE 8-3

2. At the top of the following dialog, you'll see Run AutoArchive every __ days. If that box is
not checked, it will not run. As you can see from the following screen shot, you have many
options for this:
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AutoArchive X

Run Autohrchive every |7 * days
Prompt before AutoArchive runs
During AutoArchive:
[ ]Delete expired items (email folders only)
[] Archive or delete old items
Show archive folder in folder list
Default folder settings for archiving
Clean out items older than | & : Months
(@ Move old items to:

ChUsers\ddavi,OneDrive\Documentsy Browse...
() Permanently delete old items

Apply these settings to all folders now

To specify different archive settings for any folder,
right-click on the folder and choose Properties, then go to

the AutoArchive tab.

FIGURE 8-4

Controlling the Archive Settings of a Specific Folder

You can control what any folder does in Outlook by following these steps: Right-click the folder
+ Properties » AutoArchive tab » Make your changes and click OK.

Saving Email Messages Outside of Outlook

When an email message is in your Outlook inbox, it is just a record in a database and not a
discreet document like a Word file. That fact is a big part of the problem associated with
organizing and storing them. Email related to a particular matter is stored in one place; and word
processor files related to that matter are stored somewhere else. However, you can create
documents out of those emails and those documents can be stored with every other document
related to a particular matter or issue.

Saving Email as a Document

The classic problem that law firms have if they do not own a document management system is
saving and finding matter-specific email. Why? Because people (1) keep them in their individual
inboxes, or (2) save them in subfolders within their own inbox (which no one else has access to),
or (3) delete the email altogether. Email is valuable correspondence that in most circumstances
should be saved. However, in a law firm or legal department, it should not be saved within one's
own individual inbox.

As it turns out, you can save email much like you save a Microsoft Word document clicking the
File » Save As. We recommend that you save as Outlook Message Format - Unicode (*.msg)
and this is the default file type.

The significant benefit of .msg files is that they also capture any attachments. If you open an MSG
file years later and the original email had a Word file and a PDF file attached to it, they will still be
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there in their native form. Of course, best practice is to separately save all attachments into the
public folders where others in your office can find them and not leave them only attached to
email.

You can also save email as Text Only although you'll lose any formatting that was in the email
and you'll lose the attachments (if any). Saving as an MSG file will retain the original formatting,
look, and feel of the email, while also keeping the attachments.

Saving Email by Dragging into a File Explorer Folder

You can clean out your inbox or subfolders under your inbox by cascading the windows and
simply dragging and dropping all of them into the desired folder. This will COPY the emails over
into that folder, saving them automatically as MSG (native Outlook Message Format) files, which
preserves the metadata and all attachments.

- <
~ Name afSvoiies Search Demo Emails
3 Quick access Inbox
Training Al Unread
m Desktop Archive 1571 _
‘,ﬂ Clean Restart
2 Document Departmer Inbox - Group Hilton Honors
Affinity Internal NetDocs Group Your March Hilton Honors Statement

o Danielle ‘--—-S-_--—--

& Word Start Up Deleted ltems 645 Danielle DavisRoe

& Answer Files Drafts [21] Your Test File

¢ 2018 Awesome Sauce ActionStep Heads Up A

wvery
2 Management Consulti i
DEDEES & Create Wherever You Go

22 Succession Planning v

FIGURE 8-5

Saving Email with Document Management Programs (DMS)

While document management programs (NetDocuments, Worldox, iManage, etc.) were
originally thought of as only word processing document repositories, that is no longer true. They
can now hold just about any type of computer file (word processor, PDF, TIF, email, JPG, etc.).

NetDocuments Example

Using NetDocuments as an example, you can move email into the document management
system by dragging and dropping (see below). Once profiled and saved, the emails are stored
within the client/matter structure and easily searchable and accessible by anyone who uses the
document management system (NetDocuments, in this case). It's also important to note that
you can save them one-at-a-time or large quantities of them all at once.

SEnToT Ups UPQate - 3722719 3722720719
-~ . .
/) punger@afflnltyconsultlng.com REALLY great meeting guys. That was 23 minutes well spent.
4 Inbox Russell Duncan P
. . N 3/21/2019
4 ! Clients Projects Drag and Drop to Outlook
folder mapped to a matter [1at to my notes.
a - AAA Corp - (nd) in NetDocuments
o Gborgeserons
a - ACC - Association of Corporate... « Personal Invitation 3/21/2019
m NetBPocuments A Dear Paul, | trust this email finds you well. | would like to
FIGURE 8-6
MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 56

5-78



A

S
—

Affinity

CHAPTER 8

Saving Email Using a Case/Practice Management Program

This would include programs like Actionstep, Cosmolex, Centerbase, Clio, PracticeMaster, etc. If
you have a case management program with Outlook integration, you can streamline the saving
of email by saving them directly into the matter within the case management program. You can
also auto-associate emails by setting up rules within the practice management program based

on the sender.

Saving

Email as PDF Files

If you have a PDF program which integrates with Outlook, the PDF program will install a few
buttons and an additional menu in Microsoft Outlook that make saving email as PDF files easier,

faster and better. For those who wish

they had a good way to archive and store emails and

attachments, this integration can be a lifesaver.

On some levels, saving emails as PDF files is better than saving as MSG files. That's because
Acrobat is an open standard (Adobe released their patent rights to the file format in 2008). As

such, you can feel pretty confident that

you'll be able to open PDF files in 20 years. Further, if you

use an integrated PDF program as described above, it will also capture the attachments just like

MSG files do.
File Home  Send / Receive
ol |
y il ¥
Selected | Selected

Messages ~ | Folders ~

Y Create Mew PDF...

Append to Existing PDF...

Change Conversion

Add-ins

[T
I.I_a’“
[+ 18

Setup Automatic
Archival

Folder  View Help  Acrobat

-
—
-5

Settings

FIGURE 8-7

PDF Programs Which Integrate with Outlook

Adobe Acrobat

Acrobat - Creating PDFs from Individual Emails or Entire Folders: Simply select

individual emails (Ctrl + left click) or select entire folders; then click the Adobe PDF ribbon

¥ Selected Messages ¥ Create

New PDF. This will create a single PDF which contains all

of the emails you've selected and all of the attachments thereto.

Acrobat - Adding Subsequent Emails to Existing PDFs: If you receive additional emails

which need to be added to an existing PDF archive, simply choose Selected Messages
Append to Existing Adobe PDF.

Acrobat - Automatic Archival: Using the Setup Automatic Archival button, you an also

setup folders to automatically archive themselves. This would be particularly useful if you
have setup Outlook rules to automatically sort your email into specific folders and then

use Acrobat to automatically arc
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File Home  Send / Receive Folder View  Add-ins Help  Acrobat
€ £ g = !
Selected  Selected Change Conversion || Setup Aut-cumatic
Messages ~ Folders ~ Settings Archival
Caonvert Preferences Archive
FIGURE 8-8

Saving PDFs Without Acrobat

Other PDF programs that cost a ot less than Acrobat offer similar functionality to that described
above with Outlook. For example, all of the following are fantastic:

¢ Kofax Power PDF Advanced: Matches features of Acrobat Professional. Windows only.
o Kofax Power PDF Standard: Matches features of Acrobat Standard. Windows only.

e Foxit PDF Editor Pro: Very strong feature match with Acrobat Pro. Windows only.

e Foxit PDF Editor: Strong match with Acrobat Standard. Windows only.

e Nitro Productivity Suite: Nitro Pro (included with the suite, but which cannot be
purchased separately) matches the features of Acrobat Professional. Windows only.

If you have Outlook and one of the foregoing programs but don’t see any special buttons in
Outlook, there are several possible causes.

e Incompatibility: The first possibility is that your versions of each program aren't
compatible. For example, if you have Outlook 2019 and Acrobat 10, you're not going to get
the integration because Acrobat 10 isn't compatible with Outlook 2019. Instead, you need
to upgrade to Acrobat DC which is compatible with Outlook 2019.

¢ Installation Order: The second possible cause is the order of installation. For example,
assume you have Outlook 365 and Acrobat DC. Those two versions are compatible for the
integration to work. However, if you installed Acrobat first and then Outlook, you're not
going to see the buttons. When you install Acrobat, it needs to find Outlook already on
your computer in order to install its integration. In this case, you might need to re-install
Acrobat so it can find your Outlook installation and add the integration.

e Add-In Disabled: Outlook add-ins get disabled sometimes. To re-enable them, go to File
+ Options » Add-Ins® Go... and check the box to re-enable the add-in.

Email Storage Tips
Store Email with Other Related Files

Store the email in the same location as other electronic files related to any particular matter. Any
system that requires you to save email separately from other electronic files related to a matter
is inadequate.

Delete or Archive Email Once Stored

After an email is stored into a folder or a document management system, delete or archive it.
Keep Outlook as clean as possible.
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Always Separately Save Attached Documents

Outlook is NOT a document management system and should not be used as a document
repository. Documents attached to Outlook emails are actually stored in a temporary folder
structure that is incredibly convoluted and is normally hidden. For example, the attachment to
an email | just opened is stored in my hard drive under this folder:

C:\Users\barron\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Outlook\
OOTOASES

For the record, that's 8 folders deep and the structure from \Temporary Internet Files down is not
even visible in Windows Explorer. The point is, it is incredibly easy to lose attached documents
that aren't saved separately (unless you have a document management system that saves
attachments at the same time the email itself is saved).

Stop Printing Email

If you've saved email digitally, then they're easily searchable and printing them to throw in paper
files only makes your paper files fatter, harder to manage and harder to search.

Benefits of Storing Email Outside of Outlook
No Worry About Email Storage Limitations

If you offload the email in your Outlook folder structure and save them as separate files or in other
programs, then you can get them out of Outlook. As such, the IT folks will stop complaining that
you're overloading the Exchange server and your computer will operate faster.

Everyone Else Can Find Them Too

Once saved as separate files, others in your office will be able to find these important client
communications. You're on your way to building a complete digital file.

Searchable Like All Other Documents

If you're saving into a document management system, then the content of all email stored
therein is searchable. If the email is stored as separate files (PDFs, MSG files), then there are free
or very inexpensive search programs that can help you find any of them by the words contained
inside them.

Saving Attachments to Email

Open the email, right click the attachment, and choose Save As. To save all attachments once,
choose Save All Attachments.
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CHAPTER 9
EMAIL: DEALING WITH

SPAM

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

If unwanted emails are flooding your email, you can use Outlook's junk email settings to send
emails to your junk email folder.

Junk Mail Options

You'll find the junk mail options on the Home ribbon % Delete group # Junk button % Junk
Email Options.

Junk Email Options - ddavisroe@affinityconsulting.com X

Options  Safe Senders Safe Recipients Blocked Senders  International

r d‘ Outlook can move messages that appear to be junk email into a special
Junk Email folder.

Choose the level of junk email protection you want:

(@ Mo Automatic Filtering. Mail from blocked senders is still moved to
the Junk Email folder.

{_JLow: Move the most obvious junk email to the Junk Email folder.

() High: Mast junk email is caught, but some regular mail may be
caught as well. Check your Junk Email folder often.

() Safe Lists Only: Only mail from people or domains on your Safe
Senders List or Safe Recipients List will be delivered to your Inbox.

[ ]Permanently delete suspected junk email instead of moving it to the
Junk Email folder

warn me about suspicious domain names in email addresses.
(recommended)

FIGURE 9-1

Select No Automatic Filtering if you do not want Outlook to automatically filter suspected spam
into your junk email folder. Use this you use another service to quarantine spam for you.

If you select Safe Lists Only, Outlook will send all email to your junk email folder unless the sender
has been added to your safe senders or recipients list.

Low or High will use Al to determine which emails are likely spam and filter them into the junk
email folder accordingly.
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Checking the box to permanently delete suspected junk email will skip your junk email folder. If
any legitimate email is suspected of being spam, you will not be able to retrieve it.

Block Senders

The easiest way to do this is to right-click on an email from a sender you want to block in the
future. Right-click the email, choose Junk # Block Sender. You can also block all emails from
someone at the sender's domain.

Safe Senders

To add someone to your safe senders list, right-click on an email from them, and choose Junk »
Never Block Sender. You can also add the sender's domain to your safe senders list, ensuring
you never miss an email from someone at that domain.

Managing Blocked and Safe Sender Lists

Open your junk email options: Home ribbon # Delete group # Junk button # Junk Email
Options.

Open the Safe Senders tab to see a list of safe email addresses and domains. To remove one, click
on it and click on the Remove button.

Open the Blocked Senders tab to see a list of blocked email addresses and domains. To remove
one, click on it and click on the Remove button.
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CALENDAR

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Configuring the Calendar View

Almost everything in the calendar view can be turned on or off from the controls on the View tab.
The diagram below shows the controls for the various panels.

P Search ® -]

File  Home Send/Receve  Folder View  Add-ins  Help  Grammarly  Acrobat  Meeting Series

C = Time Scale ~ =
G &YIDOEEE B S & E
Change View Resct | | Day | Work Week Month Schedule — Color | Use Tighter Folder Reading To-Do | Reminders Openin New Close
View ~ Settings View Week View | - Spagj

Current View

Apri 2021

4 s 9w = B
Y PRI g R
w1002 22 u g m
sxT AR g R

B m
May 2021 etral ot R
SU MO TU WE TH R SA Smith . White - Witness . [3 o
Oraft Compisint v P
TR A N S 200m v N Tesw
DR RS 2 i
T we N2 S m
BussR BB m
WM 23 s o m
S m
+[8] My Calendars - S Bk
o pm
S m
e M
™
- - - . S m
o m
o m
L e e “o m
P o M
L] Affnity nsight hp) : .
L] Al Affinity
[ Adom Ringel

[ Alex Palzewicz

1) Alison Wendell
‘Show tasks on: Due Date Due Date Reminder Time In Folder vis
Quick Question Wes 020 Wed4/152020 None L
g Thu 4162020 020 None L]
(= Thu4/162020 Thu4/16/2020  None L]
o nd our dientst - and . Thu 4162020 Thu416:2020  None ]
Ths folder 1 up to date.  Connected 10 Microsoft Exchangs

To see tasks underneath the calendar, activate the “Daily Task List” on the View tab.

Creating Appointments and Meetings

An appointment is an event on your calendar. A meeting is an appointment that others are
invited to. Create either fromm the Home ribbon using the New Appointment or New Meeting
buttons. Alternatively, you can click on the start time on your calendar and press Ctrl + Shift + A.

PAGE 62
5-84



A

X\
S
Affinity CHAPTER10

Converting an Appointment to a Meeting

You can make an appointment a meeting by clicking on the Invite Attendees button on the
Appointment ribbon.

File Appointment  Scheduling Assistant  Insert  Format Text  Review  Help
e m Calendar $ Qi_ ESHDWAS' I:' BLIS}" M G
|_| \ —
Delete 5 Forward Tear_ns Irvite I:_L Reminder: 15 minutes .. Recurrence
Meeting Attendees
Undo Adtions Teams Meeting  Attendees Options

FIGURE 10-2

All-Day Appointments

You can schedule an all-day appointment by checking the All day box.

File Appointment  Scheduling Assistant  Insert  Format Text  Review  Help
Ty m . . 5" B
Calendar * p Show As: Bus -
. = 4+ = 1 Busy D Og
Delete % Forward Teams Invite g Reminder 15 minutes . Recurrence  Catego
Meeting Attendees -
Undo Actions Teams Meeting | Attendees Options
Title
Save &
Close Start time Tue 12/14/2021 E 4:00 PM - 7 A day ] @ Time zones
End time Tue 12/14/2021 E 4:30 PM w| 4% Make Recurring
Location
FIGURE 10-3

All day appointments show up at the top of the calendar. If others have access to your calendar,
it can be easy for them to miss all day appointments. Therefore, many people schedule all day
events from 8 am to 5 pm to make them hard to miss.
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FIGURE 10-4

Making Appointment Private

Right click on calendar and select “Private.” No one you share your calendar with will be able to
see the details of the appointment. Outlook will continue to show the time of the appointment
as busy.

Adding Attachments to Appointments

You can add attachments to appointments by dragging and dropping files into the Notes field
or using the Attach File button on the Insert ribbon.

Duplicating an Appointment

Hold down the control key and drag the appointment to a different date or use Ctrl + C to copy
the appointment and Ctrl + V to paste it. You will need to then send any meeting invitations on
a duplicated appointment.: open the meeting and click on the Send button.

Recurring Appointments

Recurring appointments are denoted by a = symbol.

FIGURE 10-5

To make an appointment a recurring appointment, click on the Recurrence button on the
Appointment ribbon.
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File Appointment  Scheduling Assistant  Insert  Format Text  Review  Help

m Calendar * pi Eﬂhuwhs: I:'BLIS}" e G

Delete 5 Forward ~ Tear_ns [nvite l:_l. Reminder: 15 minutes | Recurrence
Meeting Attendees

Undao Adtions Teams Meeting  Attendees Options

FIGURE 10-6

Recurrence Pattern

Daily recurrence is used for appointments that occur every day, every weekday, or a specific
number of days apart.

Weekly recurrence is used for appointments that recur on the same day(s) of the week every
week or a specific number of weeks apart.

Monthly recurrence is used for appointments that occur on the same day each month, whether
that is the 14t day or the first Friday every month or a specific number of months apart.

Yearly recurrence is used for appointments that occur on the same day each year, whether that
is the 14t day of September or the first Friday or May every year or a specific number of years
apart.

Range of Recurrence

The recurrence can continue indefinitely or can end after a specific numlber of occurrences or on
a certain date.

Changing Recurring Appointments

When opening a recurring appointment, Outlook will ask whether you want to open just this
appointment or the entire series. Open just this appointment to make any changes specific that
one occasion. Open the entire series to makes changes to all appointments.

Appointments that differ from the series are denoted with slash through the recurrence symbol.

FIGURE 10-7

If you later edit the times or days of the series, any changes you made to specific appointments
will be overwritten by the new recurrence.

Scheduling Meetings

Scheduling meetings can be challenging when everyone has a busy schedule. Luckily, Outlook
has some tricks you can use to make finding time to meet easier.

Scheduling Assistant

For those whose calendarsyou are able to see (see page 70), you can use the Scheduling Assistant
to see their availability when scheduling meetings.
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1. Onthe Home ribbon, in the New group, click on New Meeting.

2. Click on the Scheduling Assistant tab.

CHAPTER10

3. Click on Add required attendee or Add optional attendee to add someone's availability.

o™} Untitled - Appointment £ search

File Appointment Format Text

o R A& H

Scheduling Assistant  Insert

Refresh  AutoPick Add Add Options
Availability ~ Attendees Rooms ~
Scheduling Attendees Options
Start time Tue 12/14/2021 =
End time Tue 12/14/2021 i
1FM 2PM 3PM 4 FM 8 AM
All Attendees

~ Required Attendee

Review  Help

4:00 PM

430 PM

- [ an day O @ Time zones

w| 4 Make Recurring

Tuesday, December 14, 2021

10 AM 11 AM 12 PM 1FM 2PM

|Z Danielle DavisRoe

IPhiII Out|

IWUrd Trai|

IMicII Fich

IAffilIJoh||

I Affinity c:l TM‘rI 1pm Excell Affn}L Trid|

Add required attendee |

~ Optional Attendee

I Add optional attendee I

]

3FM

*

FIGURE 10-8

Add-In: FindTime

FindTime is an Outlook add-in that makes it easier to schedule meetings with people outside of

your organization.

Installing FindTime

Start by installing it from the app store:
1. Onthe Home ribbon, click on Get Add-Ins.
2. Search for FindTime.
3. Click on the Add button.

Using FindTime

To use FindTime when drafting an email:
1. Add required attendees to the To field.
Add optional attendees to the Cc field.

INSNEEEN

the individual's name.
e Green: Available

e Red: Unavailable
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On the Message ribbon, click on New Meeting Poll.

In the FindTime pane, availability will be shown by color. Hover over the silhouette to see
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Gray: Unknown (people outside your organization or whose calendar you do not have

permissions to see)

Underlined: Required Attendee

5. Click on times to offer them as possible meeting times for the attendees.

FindTime X

6. Click Next.

B> From v ddavisroe@affinityconsulting.com
Send T Select times for your poll
Duration
Cc
30 minutes ~  +/ Work hours
Bcc
(UTC-05:00) Eastern Time (US & Canada) v
Subject
g‘li LA = sl £ ER. February 2021 >
31 01 02 03 04 05 06 >
—
Danielle DavisRoe, Esq. | Senior Consultant Thursday February 4
Affinity Consulting Group
1550 Old Henderson Road, Suite 5150 | Columbus, OH 43220 Sort by Availability | Time @
614-340-3444 | 614-310-8352 (direct dial)
ddavisroe@affinityconsulting com . &
affinityconsulting.com s3oam {00 fo [@
A Affinity L w
SRR, CONSULTING
Other times
nnnnnn Aanma N e

7. Change the settings as desired and click on Add to email.

Attendees will receive a link with the proposed meeting times. They will be prompted to select

their name from the list of attendees and can get specify which times work for them.

Invitation to meet
(© 30 minutes duration
©  Nolocation provided

g 2 options provided

®  (UTC-05:00) Eastern Time (US & Canada)
Show availability
Organizer
BB FindTime poll
Danielle DavisRoe
Choose times you prefer or are available How others voted Required Attendees
Thursday, Febi 04, 2021 Danielle DavisR... N
ursday. February anielie Davis j You (Danielle DavisRoe)
8:30 AM QO Prefer | v Yes X No v |- Add required attendee
9:00 AM QO Prefer  Yes % No v Optional Attendees
|- Add optional attendee
{- Propose another time
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Rooms

If your organization uses Outlook to schedule conference rooms or other locations, you can add
that room directly to your calendar appointment or use the Room Finder to locate an available
room.

Scheduling a Room
To schedule a room to an appointment or meeting:
1. Click on the Location button.
2. Double-click on the name of the room.
3. Click OK.

Checking Room Availability
To check what rooms are available for an appointment or meeting:
1. On the Scheduling Assistant ribbon, click on Add Rooms.
Double-click on the names of the rooms.
Click OK.

On the Room Finder pane, see which rooms are available at which times.

INNINEEN
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B8 Untitled - Meeting

File Meeting

Scheduling Assistant  Insert

£ search

Format Text ~ Review Help

< R A& U &

Refresh  AutoPick Add Add | Room Options
Availability ~ Attendees Rooms |Finder ~
Scheduling Attendees Options
B’ Start time Tue 12/14/2021 [=]|| 400PM [ Alday
Send End time Tue 12/14/2021 E 430 PM w| 4% Make Recurr
Tuesday, December 14, 2021
1FM 2PM 3PM 4 FM 8 AM 3 AM 10 AM 11 AP

~ Required Attendee
Danielle DavisRoe
Add required attends
~ Optional Attendee
Add optional attend:
~ Resource (Room or...
Affinity Marketing

Add resource

IPhiII Out| IWord Trai| IMicII Pich IAffinityC
< 3 »

B Busy B Tentative B Out of Office F¥ Working Elsewhere [N Mo Information [T Outside of working hou

Room Finder

Building Clear filters

Select a building

Capacity Floor
Any ” Any :
Features

No features available

Suggested conference rooms

Azure Epona

@ Available 2100
Azure NetDocuments
© Available 2100
Azure Worldox

© Available 2100
PMProjects

© Available 250
Centerbase Demao Server
@ Available 2100
CricnDemoServer

@ Available 2100
Zola Deme Server

@ Available 2100

ActionStep Demo Server

FIGURE 10-11

Viewing Your Calendar

Arrange Options

You can easily switch between a single day view, your work week, the full week, and a month use

the arrange buttons found on the Home and View ribbons.

GoTo

The Home ribbon's Go To options allow you to quickly navigate to the current day or see the next
7 days.

Viewing Non-Contiguous Days Side-By-Side

To view non-contiguous days side-by-side:

Go to your Outlook calendar and click on the Day button.

2. Left click on the first day you want to see.

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS

3. Now hold down on the Ctrl key and left click the rest of the days.
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Move an Appointment by Dragging It

If an appointment gets moved, the easiest way to make the change on your calendar is by
dragging it to the new day. When you're in the calendar in Outlook, the “Folder Pane” on the left
side of the screen can be re-sized to show you multiple months. An appointment from the right
side of your screen can be dragged to any day you see on the left.

T 2 3 4 5 6

8 9 10 11 12 13

15 1719 20

22 23 24 %5 26 27
29 30

October 2013

SU MO TU WE TH FR

1.2 3 4

§ 7 8 9 10 11

7
14
2
28

SA
5
12

16 17 19

13 mEl*

20 21 22 23 24 25
27 28 29 30 31

November 2013
SU MO TU WE TH FR
1
3 4 5 6 T &
10 11 12 13 14 15
17 18 19 20 21 22
24 25 26 27 28 29

26

1 2 3 4 5 6 7

u My Calendars

l Breakfast meeting ||

FIGURE 10-12

If you want to copy the appointment rather than move it, follow the steps above, but hold down

on the Ctrl key at the same time.

Reminders

Outlook allows you to add one pop up reminder to each appointment. If you need additional
reminders, you'll need to create separate appointments to remind you. Alternatively, you can set
the reminder for the first time you want reminded and then snooze the reminder when it pops

up.

Sharing Calendars
Opening a Shared Calendar

Click Open Calendar on the Home tab and then Open Shared Calendar or File®»Open+®Other
User's Folder.

Sharing Your Calendar

Click Share Calendar on the Home tab to send an invitation.

Giving Elevated Permissions

Click Calendar Permissions on the Home tab, click the user, then set the permissions and click

OK.
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Creating Calendar Groups

Select Calendar Groups on the Home tab and Create new calendar group. Add calendars or
rearrange calendars by dragging and dropping from another group.
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Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Creating New Contacts

On the Home ribbon, click on New Contact, drag and drop email on People button, or right-click
on email address and select add to contacts.

People View

Outlook defaults to the “new” People view by default. To change back to an older view, just click
a different view in the Current View box on the Home ribbon. The new people view has a
streamlined interface and a streamlined editing dialog box for contacts. The people view also
tries to aggregate contacts: if the same person is in Outlook twice, the people pane will recognize
the same name, link the contact cards, and present them as one card.

Contact Groups

If you routinely send email to a group of people, you can create a distribution list or contact group
which will make it much easier. To create one, go to your Contacts in Outlook » New Contact
Group button (Home ribbon) » name the group and add the appropriate email addresses.

Quick Contact Search

For the Quick Contact Search, just hit the F11 key and type in a first or last name.
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Default Outlook to Your Contacts Address Book

CHAPTERT

When you click the TO button in a new Outlook email, if you have Microsoft Exchange, it defaults
to Global Address List which is your internal contact list. This forces you to switch to "Contacts"
from the drop-down list every time in order to search your Outlook contacts for an email address.
Click Mail in Outlook # on the Home ribbon, click the Address Book button # Tools menu »

Options » under When opening the address book... choose Contacts.

Addressing

When sending e-mail, check address lists in this order:

O' Start with Global Address List

() Start with contact folders

() Custom

Global Address List
Contacts

Add... Remove Properties

When opening the address book, show this address list first:
Contacts W

FIGURE 11-1
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Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Configuring the Tasks View

Almost everything in the tasks view can be turned on or off from the controls on the View tab.
The diagram below shows the controls for the various panels.

P search &

¢ View  Addins  Help  Grammary  Acrobat

1L Reverse sart
1 Add Colurnns

covies P susone [ ouebne

B type | jmportance 2}

G BPEDEED

(]
B ® mwEERE®

B2 @ & B -

Fiter appied Updating Inbox.  Connected to: Microsaft Exchange | (T8 Bl

FIGURE 12-1

Tasks vs To-Do List

Atask is a separate item in a task folder. One or multiple task folders can be created (for example
a task folder could be created for an individual project). The To-Do List aggregates all of the
flagged items (emails) and all of the tasks from all of the folders into one list. Think of the To-Do
List as a “master task list.”

® W R E®R R RR R RT R RRRBDW

+

§

Creating Tasks

Click New Task on the Home ribbon or drag and drop email to Task button or screen.
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Setting Task Reminder

Check the Reminder box below the task end date and set a reminder date and time.

Hiding Completed Tasks

To hide completed tasks, click View Settings on the task View ribbon, then Filter, then
Advanced, and add Complete equals No to the list.

Assigning Tasks

Open the task, click Assign Task, enter an email address, and click send. The Assignee now
becomes the owner of the task and is the only one that can make changes to it. The Assignee
can also send status reports back to the Assignor. There is a built-in view under Change View to
view assigned tasks in a folder.

Flags

Flagging an email will make the email appear in the To-Do list, but that is not the same as
creating a task. A flagged email will disappear off the To-Do list if the email is deleted. However,
a task created from an email (via drag and drop) creates a separate task item, independent of the
email. An independent task item will stay on the task list even if the original email is deleted.

Flags are a great way to alert you to follow up on an important email, especially if your plan is to
delay action with the email for a day or so. Simply right click on the desired email and select
Follow Up and then select the desired follow-up flag.

f‘\‘c"CI)l VL Ve ur_!uau W T T. 1T T TV
. Follow Up 4 Fj Today
Brittany Pa... Annual Conf
= Find Related v | Tomorrow
Brittany Pa...Annual Conf Quick Steps » |8 This Week
Hilton Hono... Danielle, intrc i Rules v | B Next Week
. . T \ No Date
Hilton Hon... Claim your [ B Move | =
. . . 'F"@ Ignore F:' Custom...
Hilton Hono... Danielle, Poin _
@ Junk 3 Q Add Reminder..
Hilton Hono... Claim unlimit: [l Delete ~ Mark Complete
Hilton Hono... Danielle, you &= Archive..
Hilton Hono... We see you h <" Conyert to Adobe PDF P
. =% Append to Adobe PDF
Brittany Parr... Annual Conference: satura... sat 37372018 8:57 AM

FIGURE 12-2
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You can set a custom date as well. Outlook will notify alert you on the date and time specified.

Custom X

Flagging creates a to-do item that reminds you to follow up. After you
follow up, you can mark the to-do item complete.

Y Flag to Follow L.|p| e

Start date  Friday, January 11, 2019
Due date  Friday, January 11, 2019 w
[ |Reminder
Friday, January 11, 2019 b 4:00 PM g iz
Clear Flag Cancel
FIGURE 12-3
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MICROSOFT TO DO

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Microsoft To Do is the online and app interface for Outlook tasks. Use To Do in tandem with
Outlook tasks or without ever using tasks in Outlook. You can access it by logging into office.com,
using the Windows app, or downloading the app to your mobile devices. To Do is available within

Outlook for 365 users, by clicking on the navigation button.

Interface

To Do is organized into smart lists and lists, available from the navigation pane on the left-hand
side.

,O
¢

Doe v. Smith

% My Day +  Add a task

% Impartant

) Planned

~ 1ef3 . BO 03,2020 « @ AMinity Insight

2, Assigned to you

O Flagged emai

 Draft Complaint
' BOverdue, d, December 2, 2020

Completed

= Doe v. Smith 3
., Bfoor men cient egaraimg Rl the compart
+ Newlist [0 @

FIGURE 13-1

To collapse the navigation pane to just icons, click on the < button at the top of the pane.

- My Day

37 Important

Planned Fi

FIGURE 13-2
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Task Details
To open the task pane to view details about a task, click on the name of the task.

_ -

Doe v. Smith

% My Day

% Important

[ Planned

2 Assigned to you

R Flagged email

R Tasks 10

FIGURE 13-3

Sync Between Outlook and To Do

Tasks automatically sync between Outlook and To Do. Tasks added in Outlook will automatically
appear in To Do and vice versa. However, not all of the fields and options sync between the two.
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The task name, due date,

What Syncs

reminder,

details,

attachments,

priority/importance, and folder/list sync between Outlook and To Do.

-

E"""“"""

Request the typical documents.

In Folder’ Doev. Smith

Request Discovery - Ta

File Task Insert Format Text Review Help Acrobat
e I o2 [ [x O
e 3 g v L&
F¢ Important Save & Delete Forward | | Task Details Mark  Assign Send Status
Close Complete Task  Report
E Planned Adtions Show Manage Task
Affinity Insight
Q Assigned to you -
F1' Flagged email Subject uest Discovery
Y Tasks
Start date Men 11/30/20; Status In Progress
= Due date Thu 12/3/2020 Priority High
= Doe v. Smith -
. Reminder Fri 3/26/2021 ol der Time | 830 AM
New list

Exercise - Adobs
Acrobat - Bri...

sk

Q  Tell me what you want to do

Y i |:I] G C)\
L og |
Recurrence | Categorize Follow ' * | Zoom
: pe
Recurrence Tags Zoom ~
-
~| % Complete |25% =
~
~ | a Owner  Danielle DavisRoe,

CHAPTER 13

recurrence, categories,
(O Request Discovery *
[ x
() Interrogatories X
() Admissions X

Next step

Remind me at 8:30 AM

Fri, March 26

Overdue, Thu, December 3, 2020
4 Repeat
<P | Affirity Insight | Pick a category
3 Exercise - Adobe Acrobat - Brief.pdf
37.8KB PDF
I Add file

-..‘Requesl the typical documents.<< Exercise - Adobe

Acrobat - Brief pdf >>

Updated Yesterday
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sync with Outlook.

What Doesn't Sync

Outlook's start date, status, and percent complete do not sync with To Do. To Do's steps do not

Request Discovery - Task

Exercise - Adobe
Acrobat - Bri...
Request the typical documents.

In Folder Doe v. Smith

File Task Insert Format Text Review Help Acrobat Q Tell me what you want to do
FI SR v 33O M mEaQ
& 4 4| v [k | O cm ,
Y Important Save & Delete Forward = Task  Details Mark  Assign Send Status | Recurrence | Categorize Follow = | Zoom
Close Complete Task  Report ~ Up~
Planned Adtions Show Manage Task Recurrence Tags Zoom
|| Affinity Insignt
.Q. Assigned to you
M Flagged email Subject Request Discovery
Y Tasks
Start date Mon 11/30/2020 [ Status In Progress -
T T
L ) Due date Thu 12/3/2020 1| Ppriority High <] % complete | 25% =]
= Doe v. Smith =
F Newlist [¥] Reminder Fri 3/26/2021 [‘j Reminder Time | 8:30 AM - | & Qwner Danielle DavisRoe
ew lIs
R SR B R R R S S B SR SRR S BRI - SRR R R SRR

N

CHAPTER 13

Request Discovery *
RFP X
Interrogatories X

O Admissions ®
Next step

%+ Add to My Day
Q Remind me at 8:30 AM
Fri, March 26

Overdue, Thu, December 3, 2020

E2 Repeat

<J | Affinity Insight X | Pick a category

Exercise - Adobe Acrobat - Brief.pdf
57.8KB PDF

i Add file

Request the typical documents << Exercise - Adobe
Acrabat - Brief pdf >>

Updated Vesterday

FIGURE 13-5
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Right-clicking on a task pulls up a menu that lets you add the task to my day, mark it as
important, mark it as complete, set the due date to today or tomorrow, create a new list from the

task, move the task, copy the task, or delete the task.

Review Will
1t My Day "
#  Remowve from My Day
() Draft will ¥ Mark as important

(«) Mark as completed

f5] Due today
Due tomorrow
Create new list from this task
<X Move task to..
[ Copy task to...
] Delete task
FIGURE 13-6

If nothing happens when you right-click, enable the right-click menu.
the upper-right corner and open your settings.

:

Flagged email -

W Flagged messagss from the last 30 days, plus anything you flag from now on, will show up as tasks here. Leam mors

Flagged today

Chambliss HotDoes Request -

Click on the gear icon in

Contact preferences

Update contact preferences >

FIGURE 13-7
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Under General, toggle on Show right-click menus.

CHAPTER 13

Settings

General

Confirm before deleting

@ o

Add new tasks on top

@ o

Move starred tasks to top

@ o

Play completion sound

@ o

Show right-click menus

@ o

FIGURE 13-8

Smart Lists

If you're unable to all of the smart lists listed below, click on the gear
corner and open your settings.

?

Flagged email -

W Flagged messages from the last 30 days. plus anything you flag from now on, will show up as tasks here. Leam more

Flagged today

Chambliss HotDocs Request - URGENT

ams Foliow Up

icon in the upper-right

Language and time zone
Change your language >

Password

Change your password

Cantact preferences.

Update contact preferences >

FIGURE 13-9

Toggle on the smart lists you want to see and toggle off Auto-hide empty smart lists, if you want
to see each list regardless of whether anything is in it (allowing you to drag-and-drop tasks to

many of the smart lists).
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Smart lists

Important

Completed

@ o

Assigned to you

@ o

Auto-hide empty smart lists
@ ) off

FIGURE 13-10

My Day

CHAPTER 13

My Day resets every day. Start your day by selecting which tasks you want to focus on and adding
them to My Day to help you focus on today's priorities. Unfinished tasks remain on the task list,
they just disappear from My Day at the beginning of the following day.

To add tasks to My Day, either drag and drop the task onto My Day in the navigation pane or click
on Add to My Day in the task detail pane. You can also right-click on a task and select Add to My
Day.

< Doe v. Smith - Tl Sort 2, Share
- My Day 1 -+ Add atask
¥ Important by -~ 2 () Draft Complaint *
~ My Day - & Overdue, Wed, December 2, 2020
B Planned ‘
@ Check in With Client
R Assigned to you £ Overdue, Mon, November 30, 2020 5
[ Flagged email O Request Discovery *
10F3 - B Overdue, Thu, December 3, 2020 - 0 [7 - @ Affinity Insight

ark as completed

() Check in With Client +r

I Add step

- Add to My Day

£ Remind me

fZ_Overdue, Mon, November 30, 2020

FIGURE 13-11
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My Day can be sorted by importance, due date, alphabetically, or creation date by clicking on

Sort.

Important

Tasks marked as high priority in Outlook show up under Important in the To Do navigation pane
(as well as under Tasks and a list, if applicable). To add a task to the Important list in To Do, either
drag and drop the task onto Important in the navigation pane or right-click on the task and

select Mark as important. You can also click on the star to the right of the task.

i oo

< Doe v. Smith - Tl sort A Share
0 My Day 1 —~+  Add atask
37 Important ‘ 2 0 Draft Complaint *
‘ 2 My Day - B Owverdue, Wed, December 2, 2020
Planned —~ gy ~ !
_ aCheck in With Client
Q Assigned to you B Overdue, Mon, November 30, 2020 & ) -~
- Add to My Day
fo Flagged email O Request Discovery +*
1of3 - BlOverdue, Thy, December 3,2020 - Q2 |s% Mark as important
(ar Tasks 10
~ Completed ) Mark as completed
FIGURE 13-12
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Planned

Tasks with deadline appear under Planned organized by deadline. Overdue tasks appear at the
top under Earlier. Tasks due today show up under Today, tasks due to tomorrow show up under
Tomorrow, tasks due in the next week (other than ones due today or tomorrow) are under a date
range, and everything due father out shows up under Later.

< Planned -
o My Day 1 +  Add a task due today
3% Important 2 .
Earlier
T Planned 7
. ¢y Draft Wil
~  Assigned to you ' Tasks - B Overdue, Mon, March 22
FU Flagged email
& Today
@ Tasks 10
y Open up a new business formation matter for John Doe
" Tasks - BDueToday « & @
= Doev. Smith 3
™y Request Discovery *
L New list [0 =~ Doev.Smith - 10f3 - BlDueToday - @ @ -« M Filesattached - @ Affinity Insight
Tomorrow
¢y Check in With Client
~~ Doev.Smith - £ Due Tomormrow &
Fri, Mar 26 to Tue, Mar 30
¢~y Draft Complaint *
" Doew. Smith - # MyDay - B Due Mon, March 29
™ Send John Doe client intake form
*~ Tasks - B DueMon, March 29
Later
¢~y Draft POA for John Doe
~ Tacks - B Due Wed, May 12
= | A &

All of your tasks created in Outlook or To Do, tasks assigned to you Microsoft Planner or through
a shared list in To Do, and flagged emails show up under All, organized by type and list.

Completed

Tasks marked as complete show up under Completed, organized by type and list.

Assigned to You

Tasks that are assigned to you in Planner or in a shared task list in To Do, appear in the Assigned
to You smart list. Tasks delegated to you in Outlook do not show up here - those show up under
Tasks (see below).
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Flagged Email

Emails flagged in Outlook show up under Flagged email. Flagged emails can be sorted by
importance, due date, added to my day, alphabetically, or creation date by clicking on Sort.

Tasks

All Outlook and To Do tasks other than those assigned to by planner or in a shared list, appear
under Tasks. can be sorted by importance, due date, added to my day, alphabetically, or creation
date by clicking on Sort.

Lists

Lists allow you to categorize tasks by matter, type of task (ex: business development, active
matters, and personal), or team (for shared lists). Tasks on lists also appear in smart lists (as
described above).

Creating New Lists

To create a new list, click on + New List at the bottom of the navigation pane, type the name of
the list, and hit the enter key on your keyboard.
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©F My Day 2

3¢ Important 2

Planned 15

CO Al 27

@ Completed

o] Assigned to you 7

M Flagged email -

{fnt Tasks 11

i= Doe v. Smith 4

i= Broker Estate Plan g/ 2
Green Divnrcel [

FIGURE 13-14

Sync with Outlook Task Folders

Lists that you create in To Do automatically appear as folders in your Outlook tasks. Folders you
create in Outlook tasks automatically appear as lists in To Do.

Shared Lists
Sharing Lists

Lists can be shared with others in your organization, allowing tasks to be delegated through To
Do. To share a list:

1. Open the list by clicking on it in the navigation pane.
2. Click on Share.
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= O X
& Green Divorce - To Do X  + Q

& C & to-do.office.com/tasks/I-2e6gkgkpiaj * BB YL N 0 H

2
< Green Divorce - 11 Sort

% My Day +  Add a task
3% Important 3

Bl Planned 28

Co Al 40

@ Completed

Q Assigned to you 7

o Flagged email 17

@ Tasks 11

= Doe v. Smith 4

i= BrokerEstate Plan R 2

Green Divorce

FIGURE 13-15
3. Click on Create invitation link.

4. Share the link by inviting people via email or copying the link.

Share list X
List members
9 Danielle DavisRoe Owner
L

https.//to-do.microsoft.com/tasks/sharing?Invit

Amyone in your organization with this link can join and

edit this list

Manage access

FIGURE 13-16
5. Those who click on the link will be granted access to the shared list.

Once a list is shared, anyone in your organization with the link can join the list.
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Remove List Members

To prevent remove members from the list:

1. Open the list by clicking on it in the navigation pane.

2. Click on the sharing button.

< Broker Estate Plan - 1 Sert
0 My Day 4+ Add atask
3% Important 3
() Review Wil LI
—
[E] Planned 28
oo Al s O Drefwil [ I
(\:f) Completed
Q Assigned to you 7
[l Flagged email 17
i Tasks 1
= Doe v. Smith 4
i= Broker Estate Plan oA 2

3. Click on the x next to the name of the member to be removed.

Share list X
List members
ﬁ' Danielle DavisRoe Owner
e
9 Jeff Schoenberger X
FIGURE 13-18
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Prevent New List Members

To prevent additional people from becoming members of a list:

1. Open the list by clicking on it in the navigation pane.

2. Click on the sharing button.

< Broker Estate Plan - 1 Sert
0 My Day + Addatask
3% Important 3
¥ () Review Wil LI
-
[E] Planned 28
oo Al 0 (O Draftwil (<
(¥) Completed
9 Assigned to you 7
[l Flagged email 17
i Tasks 1
= Doe v. Smith 4
#= Broker Estate Plan o 2

3. Click on Manage access.

Share list x
List members
ﬂ Danielle DavisRoe Owner

e

o Jeff Schoenberger X

https://to-do.microsoft.com/tasks/sharing?Invit

Anyone in your organization with this link can join and

edrt this list

hanage access

FIGURE 13-20

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS PAGE 90

5-112



H,
—
Affinity CHAPTER13

4. Toggle on Limit access to current members.

4 Manage access pd

Limit access to current members @ Off

Turn on this toggle to prevent new people from
Joining the list.

FIGURE 13-21
5. Click Limit access.
Stop Sharing
To stop sharing a list altogether:

1. Open the list by clicking on it in the navigation pane.

2. Click on the sharing button.

Broker Estate Plan - 11 Sort
¥ My Day 4+ Addatask
7 (EeEn ? O Review Will c *
Planned 28
&% Al M ) orattwil (s
@ Completed
2 Assigned to you 7
e Flagged email 17
ar Tasks 1
i= Doe v. Smith 4
= Broker Estate Plan 2 2

FIGURE 13-22
MICROSOFT OUTLOOK FOR LECAL PROFESSIONALS PAGE 91

5-113



CHAPTER 13

3. Click on Manage access.

Share list x

List members

9 Danielle DavisRoe Owner
g

o Jeff Schoenberger X

https://to-do.microsoft.com/tasks/sharing?Invit

Anyone in your organization with this link can join and

edrt this list

hanage access

FIGURE 13-23
4. Click on Stop sharing.
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CHAPTER 14

CATEGORIES

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Categories you to color code or tag an appointment, email, contact, or task with a named
category which has a color assigned to it. These are particularly helpful with appointments;
assigning a category to an appointment turns the entire appointment the color of the category.
You can also sort by category which can be useful with email.

Create Categories

Let's say you want to create a category called Billed which you will assign to each appointment
on your calendar AFTER it is billed. Just follow these steps:

1. Right-click an appointment you have billed.

2. Choose Categorize + All Categories.

Quick Print
Invite Attendees
Forward

Private
Show As 4
Categorize 4

EEEILDPF L D&

Delete

EEETEEN

Clear All Categories

Client Call

Coding

Follow Up

Holding for Coding
Meeting Participant
Out of Office
Reminder Only
Webinar

[T
oo

All Categories...

Set Quick Click..

FIGURE 14-1

3. Click the New... button and create a category as follows:
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4. Click OK » OK.

Add New Category

Mame: |Billed

Color: Shortcut Key: | (None)

S

FIGURE 14-2

Apply Categories

CHAPTER 14

Right-click on an item. Under categorize, select the desired category. You can apply more than
one category. If more than one category is applied to an appointment, the additional colors will

be shown as small boxes.

FIGURE 14-3
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SEARCHING

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.

Quick Search

In Outlook 2013/16 At the top of each mail folder, you'll see a box like the one below:

Search Current Mailbox £ | current Mailbox ~

FIGURE 15-1
In 2019/21/365, you'll see a search bar at the top of the application.

5 search

FIGURE 15-2

This will search for words you type in the email address or body of any email contained in that
folder.

The Search contextual tab will also appear, providing additional options.
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Advanced Search Capability

Advanced search gives you a tremendous number of options for searching through Outlook. Hit
Ctrl + Shift + F.

B

V] Advanced Find — O >

Look Messages s~ | In: |Inbox Browse...

Messages More Choices Advanced

Search for the word(s): hd Stop

In: | subject field only h Mew Search

From...
Sent To...

[ ]where | am: the only person on the To line {

Time: | none ~ | | Anytime

FIGURE 15-3

Search Folders for Repetitive Searches

Use search folders to reuse the same search over and over.

Creating Search Folders
To create a search folder:
1. On the Folder ribbon, click on the New Search Folder button.
Under Custom, select Create a custom Search Folder.
Click on the Choose... button.

Name the Search Folder.

oA WD

Click on the Criteria... button to set up the search.
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Using Search Folders

Search folders appear in the Folder Pane, on the left-hand side. Click on the folder name to
repeat the search.

v ddavisroe@affinityconsul...

> Inbox
Sent [tems
Drafts [4]
» Deleted Items 67
Archive 3

» Conwversation History
Junk Email [15]
Outbox
CQuick Step Settings
R5S Subscriptions

b Search Folders

Missed Calls

Missed Conversations
Text Messages

Vioice Mail

FIGURE 15-4

Editing Search Folders
To edit a search folder:
1. Inthe Folder Pane, right-click on the name of the folder.

2. Click on Customize This Search Folder...

R55 Subscriptions I s Customize This Search Folder... |

Unwanted Properties...
> Worldox

Es Convert "Inbox Sent” to Adobe PDF

w Search Folders
& Append "Inbox Sent" to Adcbe PDE
Inbox & Sent

FIGURE 15-5
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LEAVE THE
TRAINING TO US.

- Comprehensive digital courses - Live training sessions
- Affordable membership plans - “Ask the Expert” sessions
- On-demand training videos - Customizable training plans

Affinity Insight offers insightful training programs created by legal professionals for
legal professionals. Our digital courses and training membership plans give you
access to some of Affinity’s most dynamic law firm management and legal
technology trainers—not just for a day or a week, but all year long. Join live training
sessions with your peers or learn at your own pace with bite-sized, on-demand
training modules. Design a custom training plan for yourself or everyone in your firm.
Learn more at https://affinityinsight.com

M Affinity
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Definition of Imposter Syndrome: Struggling with the sense that you haven’t earned what you’ve achieved and

are a fraud (Bravata, D. M., et al., Journal of General Internal Medicine, Vol. 35, No. 4, 2020).

Tips for Managing Imposter Syndrome:

1.

10.

Keep a subfolder on your desktop or in your email, of clients, colleagues, etc. praising, thanking or
offering positive feedback of any kind. Sometimes, when we're most insecure, we need reminders of
our competence and impact.

Learn the facts: One of the best ways to manage feeling like an impostor is to address the cognitive
distortions contributing to those feelings. Remind yourself of times that you've achieved positive
outcomes for clients, or been asked to speak on your area of practice. Acknowledge to yourself the
evidence that you do know what you’re doing.

Pay attention to the conversation in your head. Ask yourself how you would support a friend who
minimizes their accomplishments and then apply the same supportive language to your own story.

Perfectionism fosters feelings of inadequacy. Feeling like no matter how much you do, it's not enough,
and that others do more, leaves one perpetually unsatisfied and insecure. Instead of pursuing
perfection, pursue excellence...and self-compassion.

Seek out mentors with a different experience & perspective from you. Be proactive in connecting with
them and share openly and transparently. It is ok to ask for the time you need as a mentee, even as a
junior.

Boundaries to keep out toxicity. Say ‘no’. If you have guilt, choose over your feelings of obligation.
This includes ending relationships that are too much work, where you're treated poorly, even if it's with
clients, colleagues or even mentors.

Hearing or reading about prominent, successful people who speak openly about their own Imposter
Syndrome, like Albert Einstein, Justice Michael Moldaver, Neil Armstrong, or Maya Angelou.

Sometimes, the system is designed to keep you feeling inadequate. It's not you. This is particularly so
for equity seeking groups (BIPOC, women, LGBTQ#+, religious groups, etc.).

Deliberate positive self-talk and self-affirmation to counteract the impact of self-doubt and negative
self-talk.

Catching yourself comparing yourself to others. We may think that we can measure how we’re doing
by how we perceive others are doing but, a) We have no idea how others are actually doing, and b)
Your journey is incomparable to anyone else’s journey. Comparison is the thief of joy.

Resource provided by:
Doron J. Gold, BA, JD, MSW, CPCC - Psychotherapy and Wellness Education
Email: thelawyertherapist@gmail.com
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Imposter Syndrome
Resources

Doron Gold
Doron J. Gold, Psychotherapy and Wellness Education

Visram, Yasmin, (LEAP) When Implicit Bias Amplifies Imposter Syndrome (LEAP)
https://www.oba.org/JUST/The-Community/2020/May-2020/When-Implicit-Bias-Amplifies-
Imposter-Syndrome

Tulshyan, Ruchika and Burey, Jodi-Ann, (HARVARD BUSINESS REVIEW) Stop Telling Women
They Have Imposter Syndrome
https://hbr.org/2021/02/stop-telling-women-they-have-imposter-syndrome

Jamison, Leslie, (THE NEW YORKER) Why Everyone Feels Like They’re Faking It
https://www.newyorker.com/magazine/2023/02/13/the-dubious-rise-of-impostor-syndrome

Cuddy, A. J. C. (2015). Presence: bringing your boldest self to your biggest challenges.
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Fact Scenario

Colleen Peffers, PeffersLaw

Iama (enter practice type). I employ 2 staff members. My partner does

not work outside the home as they are taking care of our two children, one with special
needs. Unfortunately, I was in a motor vehicle accident and now I'm stuck in the hospital
with a broken pelvis, recovering from being in an induced coma for three (3) days
following the crash, and I'm still taking some really heavy-duty pain medication. Ihave

a (settlement conference/real estate deal) to attend on Monday. Payroll

for my staff and myself is due on Friday and I'm the only one who can process those
payroll amounts. Payroll Taxes and our HST is due to be paid on Tuesday. I also found
out that we have received settlement funds for a small claims court matter into the firm’s
trust account. What I can remember about that matter (the narcotics are really impairing

my ability to focus) is that we only have five (5) days to disburse those funds.

My long-time clerk, Jennifer, has been answering the phones and trying to keep on top of
my emails, but as you know a lawyer can get more than 100 emails a day. Some from
clients, some from other counsel, some from other third parties, real estate agents,
mortgage brokers. You know the daily inflow of “stuft” that we have to deal with every

day.

So, what happens next, while I'm recovering from my broken pelvis and my “foggy”

brain from all the medications I've been taking.
If I've drafted a POA for me, as a person, then the person I have appointed will be able

to manage “my” stuff. Pay the mortgage, withdraw funds from my personal bank, buy

the groceries for my partner and my children. I'm all set, right?

71



Not so fast. Who is going to take care of my responsibility in my practice? If I haven't
drafted a POA for my practice, what happens (Kimberly Mackay is going to speak to that
shortly)

I need a POA for my practice, whether I'm incorporated as a Professional Corporation or
a sole proprietorship. The person I appoint must be a lawyer in good standing with the
LSO. Why does the attorney have to be a lawyer?? Well - they can give instructions to

my staff, Jennifer, and step into my shoes when I'm not able to do that.

How are those settlement funds going to be released from my trust account? Jennifer
should not have access to sign trust cheques. But my attorney would be able to take care
of those settlement funds. Jennifer can’t take instructions from an opposing lawyer to
release an original Certificate of Appointment (because that trustee has died and the next
in line needs it), but an attorney, for my practice, would be able to take care of instructing
Jennifer to release that original certificate. Jennifer can’t sign the Transfer for
completeness, but my attorney could do that for my client’s real estate closing. I can
pretty much guarantee that the lawyer acting on the other side of that real estate deal is
not going to be able to get instructions from their client to postpone the deal because of

my accident.

How will my partner and children survive when I'm not cutting myself a payroll cheque
this week? Maybe Jennifer has access to process payroll, but that can be dangerous. We
all want to think that the staff we hire will be loyal and honest, but sometimes the
temptation of doing things that aren’t perfectly above-board is too tempting. That’s why
your attorney is so important to ensure that your practice, your family, your clients,
you're your interactions with opposing counsel continue to run as smoothly as possible

while I concentrate on getting well.
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What happens if it's the unthinkable, and I died in that car accident? I drafted a Will and
my partner is going to sort everything out right? Not so fast.....My partner is not a lawyer
and my Will doesn’t specifically address my practice assets....so what happens to my
practice, my staff, my clients, all those people my practice is responsible to and for? Well,
Jennifer is calling Kimberly at LSO Trustee Services to figure out what to do....Be mindful
that if I don’t address my practice, whatever value it may have could be distributed to

people, if I were to have a say, I don’t want those funds to go to.

How do I (or us as a group of lawyers) avoid adding Kimberly’s burden....draft a Second
Will that specifically addresses my practice assets. The Estate Trustee, who is a lawyer
in good standing with the LSO, will have the responsibility of running my practice for
windup and/or sale, and then distribute the residue (what’s left after taxes, liabilities,
expenses) to the beneficiaries in named in the Second Will. My Estate Trustee will give

Jennifer instructions to deal with clients, other lawyers, third parties.
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Survey

Colleen Peffers, PeffersLaw

I am a (gender)

I am a sole practitioner Y/N

I have incorporated my practice (professional corporation) Y/N
I am employed by my Practice Y/N

I am a litigator Y/N

I am a solicitor Y/N

I have a blended litigation/ drafting Practice Y/IN

[ am a (son/daughter)

Iam (marital status)

I have a loved one in receipt of ODSP

I have a trust account for my Practice

I have a general account for my Practice

I have a dog/cat/bird/snake named (insert pet here)
I have employees in my Practice Y/N

I have contractors in my Practice Y/N

I have an HST number for my Practice

I have a Payroll Tax number for my Practice

I own/lease a car

I own/rent my home
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I have registered investments (RRSPs/RRIFSs)

I have children

I have an RESP for my

children

I have an equipment lease for my Practice Y/N

I own the “stuff” in my home Y/N

I own the “stuff” in my Practice Y/N

I have loaned my Practice money Y/N

I collect

(insert baseball cards/stamps/enamel ware/ cars)
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The Law Society & Role of Trustee Services:

When do we get involved?

J Licensee is no longer attending to their practice

e Risk Assessment - Client Property/Interests at Risk
e lllness/Incapacity

e Death

e  Abandonment

e  Suspension/Revocation

Levels of Involvement:

e  WHY? Required to protect client interests
- files, funds, confidentiality

e  HOW? Court appointment as trustee or voluntary
Authorization & Direction

- Authority found in Sections 49.44 to 49.52 of the Law
Society Act

e  WHAT? Information — Consulting Services - Support/advice
& guidance/assistance

e  WHO? Advice to Retiring Licensees / Staff / Estate Trustee/
Family / Colleagues

7-7



2021 stats:

Trustee Services helped 140 licensees and their families with
practice wind up

14 Trusteeship Orders issued

Inventory - staff maintained 119 active administrations, 47
trusteeships

3243 public/licensee inquiries

Best Practices:

e Create a Will and Power of Attorney naming a Licensee as
Trustee/Attorney of Law Practice

e Discuss with bank their requirements re signatories and
transfer of accounts - every bank is different!

e "“Buddy System” - discuss (and document) the transfer (or
coverage) of files/funds with a colleague.

* Maintain current contact and file lists, diaries and
financial/client account records, secure passwords to
banking and computers, etc.

e Access tools on LSO website: contingency-planning-for-lawyers
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WHY?

Relieves family of burden and cost

Preserves value of the practice and your reputation
Protects clients’ interests and property

Relieves the cost to the profession

It’s the right thing to do....What is your legacy?
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For Further Reading:

Artificial Intelligence

Artificial Intelligence in Practice video youtu.be/rclhcgvuFMO The slides are here

Resources to Keep Up with Al (News, Legal News, and Tools)

e The Rundown - https://www.therundown.ai/

e Prompt Engineering Daily - www.neatprompts.com/subscribe
e Legaltech News | Newsletters - www.law.com/legaltechnews
o LawsSites - https://www.lawnext.com/

¢ Ride the Lightening - senseient.com/ride-the-lightning

Articles

e Al Tools in MS 365 in Advance of the CoPilot Launch - North Carolina Bar Association (ncbar.org)
e The Al Genie Isn't Going Back in The Bottle

e Will ChatGPT Replace Ediscovery Review Teams

e EDiscovery Buyers Guide — Al Tools

e 5 Types of Al Tools For Lawyers That Can Supercharge Your Practice

e Bing Chat and Bard: The Basics of Al Chat Search Engines

Tools We Demonstrated/Discussed *** Notfe: Most of these are in public BETA or prerelease
Legal Tools

e Docket Alarm — docket search and analytics

e Casetext CoCounsel —legal research assistant

e LawDroid CoPilot — Al assistance for documents and client chat
e Spellbook — contract drafting

Search, Content Generation, Image Generation

e ChatGPT — Generative Al
e Google's Bard — Generative Al/Search
e Bing Al - Generative Al/Search

Al for Your Own Data

e Josef Q - Al for your own policies and regulations
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https://link.edgepilot.com/s/36c60df6/rMbad17ZHE2-6KzYKh0WZg?u=https://www.jdsupra.com/legalnews/will-chatgpt-replace-ediscovery-review-6341652/
https://link.edgepilot.com/s/767fb948/xMWHYIDFbEm6Xt9kFmQq2w?u=https://470182.fs1.hubspotusercontent-na1.net/hubfs/470182/Non-Event-eDiscovery-Buyers-Guide-2022_12.15.22.pdf
https://link.edgepilot.com/s/ed7a54cf/EfbofpGhBkuug8rPrEJ-KQ?u=https://www.spellbook.legal/blog/5-types-of-ai-tools-for-lawyers-that-can-supercharge-your-practice
https://www.ncbar.org/2023/04/04/bing-chat-and-bard-the-basics-of-ai-chat-search-engines/
https://link.edgepilot.com/s/8d5a2541/YbPtCwS2YEK_C5dm68Rnwg?u=https://www.docketalarm.com/
https://link.edgepilot.com/s/44484b8b/bsodT8rpbEqRyrw75nkAkA?u=https://casetext.com/cocounsel/
https://link.edgepilot.com/s/ce850949/0ITNfsFSQU_RYI2Mr5nnGQ?u=https://lawdroid.com/copilot/
https://link.edgepilot.com/s/35a0b789/9yHUsCaCqUW_BCevIvDwbg?u=https://www.spellbook.legal/
https://link.edgepilot.com/s/405abcf4/OFCkDhv8VUeMuJxcYXNOAA?u=https://chat.openai.com/
https://link.edgepilot.com/s/7f70324b/XvyQPhcP5Ee8GfnSVicGqw?u=https://bard.google.com/
https://link.edgepilot.com/s/92a972e0/0sB7vAeL6E_IQKi8nfH9ww?u=https://www.microsoft.com/en-us/bing?form=MW00X7%26ef_id=_k_Cj0KCQjw8qmhBhClARIsANAtbodz0wS4Bh-0C3y21LoDxmYVxpV6s1q3FnU3o82MkefULZQFMhp5_uoaAn4oEALw_wcB_k_%26OCID=AIDcmmf8m4fdss_SEM_k_Cj0KCQjw8qmhBhClARIsANAtbodz0wS4Bh-0C3y21LoDxmYVxpV6s1q3FnU3o82MkefULZQFMhp5_uoaAn4oEALw_wcB_k_%26gclid=Cj0KCQjw8qmhBhClARIsANAtbodz0wS4Bh-0C3y21LoDxmYVxpV6s1q3FnU3o82MkefULZQFMhp5_uoaAn4oEALw_wcB
https://link.edgepilot.com/s/7f5ca0e5/84_s0J7pPEe2pMDVa2Bb1A?u=https://q.joseflegal.com/
https://ncbar.org
https://senseient.com/ride-the-lightning
https://www.lawnext.com
www.law.com/legaltechnews
www.neatprompts.com/subscribe
https://www.therundown.ai
https://acrobat.adobe.com/link/review?uri=urn:aaid:scds:US:80424133-9762-38d3-8a26-8e8888d1d025

Microsoft 365 Copilot — Al for Microsoft 365
Channel — query your own databases

My AskAl - Your own ChatGPT, with your content
Kaya.chat — your personal Al

Marketing

Copy.ai — Al blog posts

Gamma — Al presentation, document, webpage creation
Blog Title Generator - SEO Blog Title Ideas

Stunning — Build webpages with Al

Microsoft Designer

Meetings

Tactiq — virtual meeting transcription with Al notes and summaries
OtterPilot - Al Meeting Assistant

Microsoft and Other Tools

3 Little Marketing Hacks for Law Firms - North Carolina Bar Association

e What To Expect from The New MS Outlook - North Carolina Bar Association
e New Features in MS Word for 365 Subscribers - North Carolina Bar Association
e New(er) Collaboration Tools in MS Outlook/365 - North Carolina Bar Association
e Qutlook Life Savers - North Carolina Bar Association
e Three Personal Knowledge Management Tips for MS 365 Subscribers - North Carolina Bar Association
e Quick Parts: The Good, the Bad, and the Alternative - North Carolina Bar Association
e Are There Alternatives to Email? - North Carolina Bar Association
e SimplyFile Add-on for MS Outlook - North Carolina Bar Association
e How to Use Microsoft Teams Channels - North Carolina Bar Association
e  Microsoft OneDrive Explained - North Carolina Bar Association
e Lists in Microsoft 365 - North Carolina Bar Association
e The Power of Speech: Voice Options in MS Word - North Carolina Bar Association
e  Microsoft 365 Power Automate - North Carolina Bar Association
e Microsoft 365 and MS Office Resources - North Carolina Bar Association (ncbar.org)
Security
e Early Spring Cleaning for Your Technology - North Carolina Bar Association
e Redux: Is a Password Enough to Keep Your Sensitive Information Safe? - North Carolina Bar Association
e Lessons from the LastPass Breach - North Carolina Bar Association
e Testing and Training for Cybersecurity in Law Firms - North Carolina Bar Association
e ATale of Two Templates - North Carolina Bar Association

The Cost of Not Upgrading Technology - North Carolina Bar Association
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https://link.edgepilot.com/s/cfbe06fd/zt-PUQXQKUarxUekkU5rgQ?u=https://www.usechannel.com/
https://link.edgepilot.com/s/10bc5656/jRKzVBpRz0S2LysTElz0_g?u=https://myaskai.com/
https://link.edgepilot.com/s/3ea94231/E-p22gROo0eq8c-OG_iIyA?u=https://kaya.chat/
https://link.edgepilot.com/s/fa1bf64b/UMNk_kHW_E6nqGFO7KYPLw?u=https://app.copy.ai/projects/24287963?tool=chat%26tab=results
https://link.edgepilot.com/s/1cc89d4f/H7aTEefNVUeNKIiX6vufSw?u=https://gamma.app/generate
https://link.edgepilot.com/s/dccd4f63/wsIDDt8fP0mPPCIm9J-jMg?u=https://www.ryrob.com/blog-title-generator/
https://link.edgepilot.com/s/6833757d/-HPmeRe2SESqsf2H3qWhZA?u=https://stunning.so/
https://link.edgepilot.com/s/15ddf56e/JOPOY-XGKUimucmiamsdKQ?u=https://designer.microsoft.com/
https://link.edgepilot.com/s/b37f91e8/S3xXgA2TTk2VeDN6EFHHsg?u=https://app.tactiq.io/
https://link.edgepilot.com/s/f3c655bf/uveJp-eEQUeW9Pyrj0p10w?u=https://otter.ai/blog/otters-new-otterpilot-tm-is-the-smart-ai-meeting-assistant-youve-been-waiting-for
https://www.ncbar.org/2023/03/28/3-little-marketing-hacks-for-law-firms/
https://www.ncbar.org/2023/05/02/what-to-expect-from-the-new-ms-outlook/
https://www.ncbar.org/2023/02/21/new-features-in-ms-word-for-365-subscribers/
https://www.ncbar.org/2023/01/31/newer-collaboration-tools-in-ms-outlook-365/
https://www.ncbar.org/2022/11/15/outlook-life-savers/
https://www.ncbar.org/2022/06/14/three-personal-knowledge-management-tips-for-ms-365-subscribers/
https://www.ncbar.org/2022/05/03/quick-parts-the-good-the-bad-and-the-alternative/
https://www.ncbar.org/2022/02/22/are-there-alternatives-to-email/
https://www.ncbar.org/2021/06/08/simplyfile-add-on-for-ms-outlook/
https://www.ncbar.org/2021/04/19/how-to-use-microsoft-teams-channels/
https://www.ncbar.org/2021/02/16/microsoft-onedrive-explained/
https://www.ncbar.org/2021/01/05/lists-in-microsoft-365/
https://www.ncbar.org/2020/09/22/the-power-of-speech-voice-options-in-ms-word/
https://www.ncbar.org/2020/06/23/microsoft-365-power-automate/
https://www.ncbar.org/2021/06/21/microsoft-365-and-ms-office-resources/
https://www.ncbar.org/2023/02/14/early-spring-cleaning-for-your-technology/
https://www.ncbar.org/2023/01/24/redux-is-a-password-enough-to-keep-your-sensitive-information-safe/
https://www.ncbar.org/2023/01/10/lessons-from-the-lastpass-breach/
https://www.ncbar.org/2022/11/29/testing-and-training-for-cybersecurity-in-law-firms/
https://www.ncbar.org/2022/02/28/a-tale-of-two-templates/
https://www.ncbar.org/2021/10/12/the-cost-of-not-upgrading-technology/
https://ncbar.org
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Artificial Intelligence

ay -




Al in ndMail (NetDocuments)

Evaluates content, attachments, your & other team members
filing behavior, sender, recipients to achieve 1-click filing

All Unread
E;Mall
Q Clients-Dema ACG - Clients Client Documents
Lebowski, Bunny / Corresponde Predictive Filing
Panel

_#/ Rename Default

aul Unger
Paul Unger Welcome to the How to Better Manage Your . jed 1
Paul Unger Welcome to the How to Better Manage Your .. Wed 11/2;
Paul Unger Paul Unger Paul MetDocuments Sample Email 1 Mon g,
— []j Dr. Robert general-discussi i eneral-discussion] Remote Part-Time Oppo.. Mon 9
Ohio State Bar Association Paul Unger B Exclusive Film Screening Invite: Reel Pers...  Fri

Paul Unger Nashwille CLE
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re more items in this folder on the server

Connect to the server to view them




Artificial Intellige

Decision

YOU ARE

Machine
Learning

Data Science

ledge ‘LPatte rn Matching I—\.
"lh‘“.-

HERE
Image Processing

L

Problem Solving I

MNL Generation z \

Speech Processing

{ Intelligent Interfaces

Text Processing

I Reasoning

\

Regression

I | Projection |

Comparisons |

Optimization

Data Aggregation

Planning _‘i\ /

I NL Understanding

Predictive Systems

—~—

I Data Mining

/

Inference |—// \l Correlations /

Intersection of Al and Data Science

Source: Artificial Intelligence at Northwestern: A View from Computer Science,

https://www.mccormick.northwestern.edu/news/articles/2019/05/artificial-intelligence-at-northwestern.html
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New Al Skill to Develop:
Prompt Engineering

Prompt




New Al Skill to Develop:
Prompt Engineering

ChatGPT is Creating Jobs That Pay As Much as $335,000

By Aasil Ahmed  Published Apr 17,2023  2:09 pm

f ¥ © in




Al for Content
Creation

e Descript —audio and video
editing

* Copy.ai — marketing content

* Blog title generator — SEO
friendly blog titles




Al for Search,
Summary, Automation

* ChatGPT 3.5and 4.0 -
generative Al

* Bing Chat — Search, content
generation, summaries

* Google’s Bard - Search, content
generation, summaries

8-12




Al Meetings
Assistant

* QOtter.ai or Tactiq

* Joins your
Zoom/Google/Teams/Webex
meetings

* Transcribes and shares with
attendees

* Creates outline, meeting notes,
action items



https://Otter.ai

Tactig Al Summary

XXXX and Catherine discuss starting a law firm and the services available at the Center for Practice
Management. They also discuss address options, insurance policies, succession planning, and taking
payments from clients. They discuss various ways to charge clients for legal services and the logistics
of taking payments. Catherine recommends getting a practice management software like Clio or
LawPay to manage payments and client communication. They also discuss the importance of getting
a privileged license and marketing strategies. Catherine recommends using Microsoft 365 for its
integrations and suggests using the free Calendly tool for scheduling meetings.

- Catherine introduces XXXX to Otter, an Al app that transcribes meetings and identifies action
items.

- XXXX discusses her desire to start a law firm and her experience in XXXX law.

- They discuss address options and the pros and cons of different services.

- They discuss insurance policies and succession planning.

- They briefly discuss taking payments from clients and maintaining a fiduciary trust account.
- They discuss different waYs to charge clients and logistics of taking payments.

- They recommend using Clio and LawPay for practice management and payments.

- They discuss marketing strategies, including referrals and website language.

- Catherine recommends using timelines to help clients understand legal transactions.

- They suggest using Microsoft 365 and Calendly for scheduling.

- Catherine recommends using Google Voice for a business phone number.

- They discuss the requirements for letterhead and malpractice insurance.

- They briefly discuss health insurance.

8-14



Al for Design and
Presentation

MS Creator and Designer — Al design
tools

Gamma App — presentations
Stunning.so — website builder
MS Word outline to PPT

#selection at the end -

' ob.select= 1 -
* ob.select=1
.scene.objects.activw
Selected” + str(modifies
#wirror_ob.select = @

» bpy.context. selected__ob”'
#ata.objects[one.name].se

"‘nt("please select exatﬂ:.‘J‘I

__ OPERATOR CLASSES

types: to th
- X ﬂ:s:o,. mirror_

x.

.oper'ator) =e 5eleCt‘-
X"

: js not
gontext) o opiect
.3
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Understand How Al Is Being Used In Legal Tech

NICE - nexidia
‘\ Bloomberg

Law: .
Thomson Reuters @ Lex Machina

exisMNexis” Company

RAVEL

a Lexrsiex® Compan)

Westlaw Edge” &= casetext JUDICATA
reveal text 1Q
: ) S
exXbe avfie

_empIsco ¢ casepoint A2 VERITON

(1l



Casetext CoCounsel

CoCounsel is powered by
OpenAl's GPT-4, the first Al to
pass the bar

CoCounsel builds on the power of GPT-4, the
Al that outperformed real bar candidates




Josef Q

8-18

ABC Par'ental Leave Q&A

18 cla Irom complexity = your FAQS, simplifie

Do bod h parands gat tha sama laawa? “

l& Grrsimss

Yes, both parents get the same leave. We do not differentiate between primary and
secondary carers, and all parents equally have access to 20 weeks of fully paid
parental leave.

This was besl phal '.'\_ Fxpm e on T an s Triw dosa'| mske s

https://joseflegal.com/blog/josef-g-public-release/


https://joseflegal.com/blog/josef-q-public-release

PRODUCTS ¥ TESTIMONIALS RESOURCES ¥ LABS SCHEDULE DEMO LOGIN

e Copilot

Use Our Al Legal Assistant to Research Legal Issues, Help Draft Emails and
Letters, Summarize Documents and Keep You Happy ©.

Get Early Access




Spellbook




iDOXQi®* =

Products ~ Store  Support Company v  Enterprise Resources v

What Can Auto Redaction Find

Out For You

Log In ‘ Request A Demo ‘ m

iDox.ai Redaction helps you to find sensitive informations in your document with just one click.

o

Personal Info

o

Medical Info

https://www.idox.ai/

& ©

Sensitive Info Health Info

o

©

Social Security Info Bank Account Info

Taking Document Security To
The Next Level

=

Financial Info

o

Other Related Info
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a Channel Features Integrations Login ‘

SELF SERVE DATA

Get the answers you need S s
without knowing SQL.

Self serve your data insights, finally. $ 6 7 7 K
. %

=

| - ~ - - - r r— — J‘,vv ‘ B |
i i ish. | |t €F i g% |c &7 | \E [ Ml S LCICL

+ asewy in plain En“ilmh'f”u rﬂ!t Fr P rW}cr:zJp |E:-|: (m _ﬁ“f"m‘ S? ) r , : : >t e he nimbey of orders by week

Channel learns how to get the answers you neea-“from just plain ) )

English.

bstman ol courinies Oy sv@men tena o ma tha numbar of
Dinkributice of Courl ke by Auerago Time B Drdar gnd R hipi of Orskers ger Ween

& Beautiful visualisation. Channel automatically generates beautiful @ Aravags Thos Beiwons Orcer-and 0 B ereed O

visualisations for your data, and picks the right chart type based

on your preferences.

AR
ke Self service, for real. Channel is designed to be used by anyone, I | I I l | | l | I

from analysts to product managers. No more waiting for the data

g22 You need.



Digital Detox & Declutter

What we know in 20237

« According to Pew, 70% of adults and 81% of teens use social media.

* Suicide rate among 10-24 year-olds was stable from 2000-
2007. ltincreased by 57% between 2007 and 2017.

e Suicide is now the 2nd leading cause of death among those

between the ages of 10 - 34.




Digital Detox & Declutter

What we know in 20237

* For 50 years, it took us 15 minutes to return to work after an
Interruption.

e Since 2017, that number has increased to 25 minutes!

ay -




Number of times the average worker checks their phone in a day.

ay -




’ 2.5 hours a day

... and 50% of time spent on mobile device is on social media

ay -



Digital Detox and Declutter

Why Do it? If for no other reason ...

RE-CLAIM 5-
10 HOURS
PER WEEK'!




SOCIAL MEDIA FAST




DIGITAL MINIMALISM




Social Media Fast/Detox

* Delete Apps from Mobile Device
- 30 Days
* Plan Replacement Activities
* No Decisions until the End

« Set Boundaries & Re-Introduce what truly furthers your
Values /—_L\



DIGITAL BOUNDARY EXAMPLES

* No Social Media between 8 am -5 pm
« Only 15 min of total Social Media per day
* No Devices after 9 pm/no email after 7 pm
 Instagram for post Art Projects - that’s it
* Phone Free Food
* Only Follow Family and Close B+



[.Limit Time on 1Phone

Settings > Screen Time > App Limits > Add Limit

< Choose Apps LinkedIn Add
Time 10 min, Every Day
9
O hours 10 min
1 11
i 12

Customize Days

App limits will apply to this device. A notification will
appear five minutes before the limit is reached.

CATEGORIES, APPS, AND WEBSITES

in Linkedin
8-32




[.Limit Time on Android Phone

Add Screen Time Widget
Touch & Hold Home Screen > Tap Widgets

s ==




Block Yourself - Set Boundaries
Cold Turkey - www.getcoldturkey.com ($39)

Web or Mobile Apps

m Cold Tu rkey Products v Features Support -

Your future self will thank you.

Block websites, games and applications to boost your productivity
and reclaim your free time.

LN N Cold Turkey Blocker Pro

@ Blocker U Blocks BERGC TR0y

= Overview

8-34 Blocks



Microsoft 365 & Windows 11

/. A




Windows 11 - Dictation Anywhere
Windows Key + H

You can already dictate in
Word, Outlook, PowerPoint
and OneNote

This allows you to dictate
anywhere else!




0 Copilot

A whole new way to work

8-37



b

Welcome to the new Bing

Your Al-powered copilot for the web

@ Ask complex questions (D) Get better answers & Get creative inspiration

"What are some meals | can make for my
picky toddler who only eats orange-colored
food?"

"What are the pros and cons of the top 3 "Write a haiku about crocodiles in outer
selling pet vacuums?" space in the voice of a pirate”

Let’s learn together. Bing is powered by Al, so surprises and mistakes are possible. Make sure to check the
facts, and share feedback so we can learn and improve!

Terms of Use  Privacy Statement

Choose a conversation style | Preview |

More More More
Creative Balanced Precise
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O M| )  https//ncbar365-my.sharepoint.com,/w/r/personal/csandersreach_ncbar_org/_layouts/15/Docaspx?sourcedoc=%7B4C... A 1 O 6 £ h B # W {3 e O 9 /bﬁ = ]

b Gmail [ CPM [ NCBA [ Social [] Weather [[] CRWK [7) HOME # Evernote [J§ TrackCPM G Googlelmages @4 LaunchZoom (@) DuckDuckGo [9 Findinpage [N NCSBlawyers [9 TinyURL [7] Covid & Staripage > | [ Other favorites
:* Word Onboarding New Hires Leveraging Technology - Saved £ Search (Alt + Q) I () Chat [ Compose  Insights O X
File Home Insert Design Layout References Review View Help [J Comments | A Catch up / Editing v |_|-¢> Share
Erl O Summarize this article in bullet points
Calibri (Bod W1t | AA R Evise iy i = 5 Find 8 é‘ i
[] [t o v | EviE- 7 E Efx ABbCC asBbcc  AaBbCc |, A d @9 /
e B I U a x, X Aav #+ A~ =E==1=v3i=v q Mormal Mo Spacing Hesding 1 t Replace = Reuse | Dictate | Editor | Designer
g = Files v v Here are some bullet points summarizing
Clipboard Font Paragraph I Styles a Editing Feuzs Files Vaice Editar Designer o the current web page context:
J « Many law firms are excited to embrace
new hires and provide orientation and
some onboarding. Then the new hire
is left in the coming weeks or manths
1o sink or swim.
Onboarding New Hires Leveraging Technology . Once your firm has made a hire there
. . ) . . ] ] is a lot to do to prepare for their
Many law firms are excited to embrace new hires and provide orientation and some onboarding. Then arrival. If you do not already have one,
the new hire is left in the coming weeks or months to sink or swim. Handing a new hire, whether an create a checklist.

They will need a phone extension, an
email address, licenses to your
software, application subscriptions, a
new laptop, peripherals acquired, and
Set Up for Success network access and permissions set
up.

Once your firm has made a hire there is a lot to do to prepare for their arrival. If you do not already have B le O

one, create a checklist. They will need a phone extension, an email address, licenses to your software, their physical space and give it
cleaning and sprucing up.

associate, a lateral, or support staff, an employee manual and making introductions cannot ensure a
smooth transition.

application subscriptions, a new laptop, peripherals acquired, and network access and permissions set
« [fthe new hireis a lateral, do a

up. Then send the new hire their phone number and email address so they can update their contacts _ _
conflicts check right away and create

and LinkedIn profile. ethical walls as necessary.
. . . . . . . . , = Add the new hire to your firm's website
If they will work in an office, create their physical space and give it cleaning and sprucing up. Don’t and get thelr help with the creation of

forget to make keycards, parking passes, or anything else needed for physical access if applicable. Itis abio.

« If you do an orientation for individuals
or groups, get that on the employee's
calendar. 8-39

Many lawyers may focus on a list-oriented project plan that flows in a mostly linear

— -



a tugboat in high waves with some seagulls

> v Bing Image Creator | 1024 x 1024 jpg | 29 days ago
(= Share (s Save | Download | Feedback

Created with Al
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Welcome

% We are the Loop team and we're excited to have you join us for the Public Preview! This workspace is all about helping
& -,-mlmnmdhhthnﬂdthﬂulpp.cht:kMﬂwﬁd-rbut-nﬂﬂnphrhgdtmundﬂuﬂ-,rnuﬂndnrl

About Loop

Microsoft Loop is the next-generation co-creation app that connects teams and tasks across your tools and devices. It's
a new way of working — s0 you and your team can think, plan, and create together from ampwhere!
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@‘“‘] F' Loop components

Send a component that everyone in the
Loop Assig chat can edit inline.
Components ~| | Policy -

:— Bulleted list
— Bulleted List o |
__ := Checklist T Live task listfluid
“= Checklist _ _
' — 3;: Mumbered list T Loop listfiuid

— MNumbered List
[Z] Paragraph

Paragraph
=] Paragrap &
FH Table g
Y= Task List

Table

Task list

: v 1T 2 P O B [F G 9 0 B o
?QEI'.IE'L

Loop Components
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Bar Leader Weekly, Issue 334: Clio Releases Legal Trends for Solo Law Firms Report
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|+ Bar Leader Weekly

Issue 334 | April 26
Clio Releases Legal Trends for Solo Law Firms Report

Clio Releases Legal Trends for Solo Law Firms Report

Trends impacting big law often command the lion's share of legal news coverage. Clio's
Legal Trends for Solo Law Firms report aims to shine a spotlight on this often-overlooked
market segment. Using data from Clio customers, as well as surveys of legal professionals
and consumers, the report looks at how solo law practices differ from those of lawyers at
other law firms. Solo practitioner Bob Ambrogi provides a precise summary of the survey,
and how the data highlights both the advantages and disadvantages of a solo practice.

The

New
Outlook

Ohio State Bar Association Surveys Members on Public

Policy Opinions

The Ohio State Bar Association published the results of 2022-2024 Public Policy Survey of
its general membership. With an imminent new state legislative session, the bar wanted a
sense of where its membership stood on current public policy proposals and to gat a broad
sense of the issues most important to OSBA members. While nonpartisan judicial elections
and increased indigent defense funding were broadly supported by the membership, learn
what topics were more divisive to respondents.

Mental Health Challenges Continue to Impact the Legal

Profession

The steady drum beat of data showing the unique mental health challenges of the legal
profession continued this week with the release of "Putting Lawyers First Task Force: An
Excerpt of the Report and Recommendations on Improving the Legal Profession for
Lawyers” from the Mew Jersey State Bar Association. The November 2022 survey, released
April 10, found that 283 of the state's lawyers have considered leaving the profession
because of mental health, burnout or stress. Twenty-three percent reported a high
prevalence of depressive symptoms, and 10% reported thoughts of suicidal ideation. The
ABA Journal has more alarming data plus a link to the full NJSBA report. This data was
accompanied by news that a Michigan Supreme Court justice will miss a special oral

. Put together ICYMI
Now New Qutlook 0

Reply

Reply all

Forward

Other reply actions >
Delete | BM

Mark as unread

Flag

Add to board >
Report >
Block b
Print

Download

View b
»~ Boomerang b

i@ Share to Teams

«s Asana >
[G] Clio’s Outlook Add-in >

3% Slack for Outlook
fll Send to OneNote

@ Viva Insights

S Get Add-ins
Customize actions
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Al Driven Virtual Agents

Environment

Power Virtual Agents ! ’ £ B North Carolina Bar Asso Y

Test bot —
Copy of Meeting Bot @ |2 Share

Chatbots @ Track between topics @

Topics

View Solution (Common Data Services Default Solution) @

Entities

Analytics

Publish

Settings
LR N
hl f"

Create generative answers (preview) Edit and test your bot
Boost your conversations in real time based on selected content to answer unanticipated Customize topics to fit your business. Test the bot to see the conversation in action.

questions. Learn more

E‘++ Get started in Al Capabilities &2 Test bot |

Learn more Tell us what you think

Hil I'm a virtual agent. | can help with

: 2 . Paivar bl B entati
account questions, orders, store information, e LB  Ask questions and learn from the community

and more, Pradhistvidass Support community

Cx Building bots better together

If you'd like to speak to a human agent, let
me know at any time.

So, what can | help you with today?

Type your message




2 Flagged email

v Hagged this week 2

ed
1ed to you

ed email
40 Tips in 40 Minutes- the webinar
B Mon, Mar16 - =

rp digest: March 15, 2020
B Mon, Mar16 + &2
SHOW Wrapup

igazine Hot Buttons... o*

Response |deas

To-Dos from Fla

() 40 Tips in 40 Min
webinar

emind me

Due Mon, Mar 16

Open in Outlook :

[EXTERNAL]
Good Morning from my snao

We would like to morph the
presentation planned for the

ged Emails
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Automate Responses with

Untitled - Message (HTML)

File Message Insert Draw Options

Paste [E‘ B I U Wz A
Clipboard [} Basic Text

Bl ndmail

B‘ To

Subject

Warmest regards,
Paul J. Unger, Esq. | Partner

Format Text

Review

Help

A/l &8

= | Address Check
Book MNames

MNames

Grammarly

) © [

Attach
File ~

Acrobat

Signature

w

Include

I:tl Follow Up ~
! High Importance

Q  Tell me what you want to do

Dictate Immersive
Low Importance Reader
Tags al Voice Sensitivity Immersive

8 T e mEm e B| o

Viva

Insights | Meeting Po Templates

Add-in FindTime Iy Templates

Bio - Unger
Biography of Paul J. Unger

Paul J. Unger is a nationally recognized speaker, author
and thought-leader in the legal technology industry,
He is an attorney and founding principal of Affinity
Consulting Group, a nationwide consulting company
providing legal technology consulting, continuing legal
education, and training.

He is the author of dozens legal technelogy manuals
and publications, including recent published

bocks, Tame the Digital Chaos — A Lawyer's Guide to
Distraction, Time, Task & Email

Management (2020), Fight the Paper (2019),

and PowerPoint in an Hour for Lawyers (2014). He
served as Chair of the ABA Legal Technology Resource
Center (2012-13, 2013-14)[ www.lawtechnol 0,
Chair of ABA TECHSHOW (2011){www.techsh
and on the Executive Board for the Association for
Continuing Legal Education (ACLEA) (2017-18, 2018-




FindTime

File Meeting Scheduling Assistant Insert Format Text Review Help Q2 Tell me
= L] o— ¢
[l e | ©) | @ | 87 |5 B 8 ] e
Delete S Eorward ~ Skype Teams Meeting Cancel Address Check Response .[;lFr sights
Templates

Meeting Meeting Nates Invitation Book MNames Options ~

fJ

FindTime MMy Templates

Attendees

Skype Meeting | Teams Meeting | Meeting Motes

Actions

FindTime

You haven't sent this meeting invitation yet.

Add some attendees first!

E, Title

Send -
Required attendees go on the Toline
Opticnal att 1 the Celine
Start time Wed 4/22/2020 ﬁ 10:30 AM - Eastern Time (US & Cana
Message Insert Options Formar
End time Wed 4/22/2020 ﬁ 11:00 AM - Eastern Time (US & Cana «
1%
T+ FRoom Finder Paste
F Clipboard Fl Basic Text
-
e From = david@contoso.com
— Ta.. emma Gontoso.com|
’ Send
/ L.
Bo
{, subject Discuss sales opportunity
b
y Hi guys, let's find a time to discuss how to make
this sale happen.
e
4 8-47




Finding Outlook

Add-ins

File Home  Send / Receive Folder  Wiew Developer J

Delete Archive | Reply Reply Forward =
- 0

New
Email ltems -

New. Delete. Respond

ADD-INS CONNECTORS

Al My add-ins
My add-ins

Admin-manag Store add-ins

Boomerang

&k ok T

The ultimate email productivity tool.
Send later, track responses, schedule
meetings, and more!

Frae

@ Added

FindTime

* ok ok ki

Discover the easiest way to find time to
meet.

Free

e Added
Quick Poll by Microsoft
Forms
L & & &

Easily create a poll, collect votes, and
wview results within an email.

Free

Q Added

Policy ~ 3 Follow Up +

Taas

DS |E WO 506 e ; =
N:\N% g1

Add-ins that you added from the Office store,

Add-ins may access personal information. By turning an add-in on, you agree to its License Terms and Privacy Policy. ‘ Search add-ins

Evemnote

g * ok ke okre

Tame your inbox. Save important email
to a workspace where ideas go from
projects to completion.

Free

@ Added

-, Trustifi for Outlook —
% Secure and Productive
Trustifi 44w awn

Get true email power with encryption,

controlling, tracking and certified email.

May require additional purchase

e Added

ﬁ/\

D

O
Customer Reply with | Insights
Manager Meeting Poll
£ Boo.. |  FindTime

Adobe Sign for Outlook

&k ok ki

Sign any document, or send it for
signature in Qutlook, with the Microsoft
preferred e-sign solution

May require additional purchase

@ Added

Zoom for Outlook
&k ok ki

Add a Zoom meeting to any Outlook
«calendar event.

May require additional purchase

o Added




gthics alexa

&  Evolution and Ethics h
Cathenne Sanders Beach’s Onellraee - ML, = AFRCC s

By Catherine Sanders Rea... mc
B Open
EVOLUTION AND ETHICS: What Are Youw

me?hﬂmzﬂln @ sl Lok
M2 106721 EVOLUTION AND ETHICS:
B Reuse Content

Reuse
Files in
MS Word

L a Ethics and Law Firms Use of Social Media

= Open 2 Insert Link

Law Firms, Ethics, and Use of Social Media

Many law firms have ernbr:aced thE use of social
media, such as Face iith potential
clients. Individual la S Use L ns like Linkedin
and Twitter to share and corgmunicate. With in-person
networking and "'.:Iﬂ"'ll-'llr"l-'i"‘-u+ stand '
and lawyers are lo - | pld
outtoc I|er1t:. anc

a as part -nf‘,.'- our markv.—_-_ g are
a number of ¢ opinions and rules of pro
conduct that appl, uﬁ-’i "I|-_=ul'i be re-r

'F:IEI:IdH:I ; and use of testime ?Illdlh ’rllat Hln..luld |JE

considered.
Confidentiality

:utlm s the
dinc l._lr"lﬁlj'-_'l"II:E according to the

E!.e C autl- ous 3||d consid

number in a blog post.

Communication and Advertising

Was this useful? Yes No



Meeting Insights in MS Outlook Calendar

Meeting Insights

Here's information you might find relevant to this
event. Other attendees will only see content they
have access to.

Q Meeting Insights

Sent Tue 3/28/2023 9:39 AM Emails

Chris Bodrer
Sent at 3/30/2023

Re: NCBA Member Research - M...

(TERMNAL] Hi Catherine, | just included

iU

a Zoom link to our meeting invite, Talk

i~ e T

shortly! Best, Chris On Tue, Mar 28, 2023

McKinley Advisors

Sent at 3/23/2023

Thanks for reaching out to McKi...

[EXTERMAL] A member of our team wi
be in touch soon. Catherine, Thank you
for reaching out to McKinley Advisors!
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New Stock
Photography
n MS Office
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MS Lists

£ Search this list
:i:  Microsoft Lists

Integrate ~
E Edit in grid view |2 Share ﬂ Export ~ #2 Automate ~  H In a

= All ltems ~ T @

CPM Admin
Conflicts Check +#+ @

Is there a conflict ~  + Add column
i i by ~~ Completed

Date Added Attorney Full Party Name Assigned to Reviewed by

Initiating Event ~ ate e

Requires Conflct Check

D ber 07, 2020 Erik Mazzone Jehn William Sims Catherine Sanders Reach
Email ecem .
‘Yes

December 07, 2020
yes -

_«ent Ticketing

Stop editing this list

v Issue ID Title Assigned To Issue Status Priority Due Date Category +
Z / Sally’s trust balance Catherine Sanders Reach Resolved with Approval | (2) Normal 4/16/2020 12:00 AM | rent Clieni ‘ R
send Willis Pucket a copy of his deed Catherine Sanders Reach Active (1) High 4/17/2020 3:00 PM Potential Client
Sue Beam wants to know when contract sice ) ) Current Client
s Catherine Sanders Reach Active

(1) High 4/20/2020 12:00 AM .
Former Client
Catherine Sanders Reach Resolved with Approval (1) High

Rese_»nd bill to John Snow (he knows O i
i 4/17/2020 12:00 Am | ©PPOsing Counsel
Sally wants to add to her evergreen tryst

Co-Counsel
balance Catherine Sanders Reach Active

(2) Normal 4/20/2020 12:00 AM Other
Send Lan his fil 7
vy e Catherine Sanders Reach Active

(1) High 4/24/2020 12:00 AM

Current Client
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Give MS Edge Browser a Try i 5§

Send to Bxcel

Send to OneMote
Lawyer Tech Tips: to
Try Today W' Send to Word

y, attomeyatwe

Sl @ 9O

] 5;:? Evernote  F Track CPM @ GoogleImages ([ LaunchZoom @@ DudDuckGo [% Findinpage &) NCSBlawyers [3 TinyURL! §ll Covid == Startpag

ww.attorneyatwork.com%2Flawyer-. M & s ; o Ll ] £ |

A} Read aloud %A Text preferences =& Gr|

catherinereach’s notebook - Ever X 0 Send to Pinterest

Text size

# 5 handy Windows 10 shortcuts £ X awyer TeCh TipS: Online . Medium 3 e

Text spacing [ ]
Wider spacing could improve reading
fluency

Multi author +l  Sort by name

HErR 3 Tools to Help Leaders Steady T X Attomey Burnout Sort by date created ¢

o attomeyatwe @ Sort by recently used

w Lawyer Tech Tips: Online Busines X e hame
Ar An Az Aa Ar
- - - Createatableof: [ Open all
o} Ensure pasting from other progr. X More themes Word

Copy all
Delete your Facebook account oo X

ImmerSive microsoft.com Paste

Rea de r Delete your Facek 7 Learn more and
all - CNET

m Create a table of authorities - W: X

w Attorney Burnout | 4 Traps to Ave X

cnet.com

wiil | Your Brain Feels Foggy And Yo X

Ensure pasting from other

New Ctrl+T programs into #MicrosoftWord

Mew tab (Ctrl+T)

Vel’tlca| TabS . ; : i ' tiktolk.com

| can't believe I'm shaning a tiktok video

.Y

Get ready to refresh your online business development toolkit. Our

experts have recommendations.
Collections
During the pandemic, lawyers have experienced changes in how they 8-53



Dictate and
Transcribe in

MS Word




Dictation = Dictate

in MS Word,
Outlook

Y 5§

i Share Request Dictate Editor Reuse
PDF  Signatures Files

nbe Acrobat Vaoice Editor | Reuse Files

i

Click the microphone to resume
dictation

Enable auto-punctuation
Filter sensitive phrases

Spoken language




Transcription = MS Word in the Browser

1@; Dictate v /}' Editor g’ Designer

g
v Dictate Transcribe x &
@ Transcribe Generate a transcript by uploading your audio file (wav, ‘ %
* mpd, .mda, .mp3) or start a recording.
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NCBA Center for Practice Management

CPM Consulting

Initial consult CPM Consulting

1 hour 1 Flgur
Free

April 23

Bookings

> April 2020 Select staff (optional)
Su Mo Tu We Th Fr Sa Anyone v
1:00 pm 2:00 pm 3:00 pm

© =

27 28 29 30

(i) All times are in (UTC-05:00) Eastern Tirne (US & Canada) ¥
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CPM Projects 3¢

CPM Admin » General

To do

—+  Add task

O Send Larry a thank you

@ 0s2

@ Catherine Sanders Reach

O Learning Objectives: Tasks
Post registration link
Prepare materials and demos
Send reminder to registrants
Give presentation
Produce recording
Send link to recording to Jeremy

Send link and follow up to attendees
U T 04715 ST

@ Catherine 5anders Reach

O Write article on ToDo from Planner

@ Catherine 5anders Reach

Charts Schedule

Doing

—+ Add task

O Finalize SFT MS 365 Slides
Get screenshots

Share with CLE Team

il o4/22 @ 0/2

@ Catherine Sanders Reach

O Contact client for spouse name
Contact client
Sdd name to database

finalize billing record

©
[}

@ [Mosimoe &

@ Catherine Sanders Reach

Done

—+ Add task

Hide complet@ 3

& =T

[ 101042019

e Completed by Catherine Sanders...

9 Completed by Catherine Sanders...

oee—te-—t-r-aeeﬁﬁes

9 Completed by Catherine Sanders...



T [ Saalib R g SR A

eate new

Upload Recording

commended

o You edited this
(= Ao

Technology in Law Practice:
Whoops, What, and Wow

aw Practice Tech for UNC 1
82 Shared

H Law Practice Tech for UNC 1
Cathenine Sanders Reach's Files

welcome
Test for Georgia

H Recording-20230406_142930
Cathenine Sanders Reach's Files
I

| aw Practice Tech for LINC

8] .o ’
GIPRE kiR

O Search

Playlist

o You recently opened this
10m ago

o You edited this
~  Apré

4 s simply false. The person did not reveal all
his situation up front in our first and

cmused the conzequences he is now 1o upset
about ™

Welcome to

o You recently opened this
=~ Apré

welcome

77 Favorites

Modified

5m ago

10m ago

Apr b

Law Practice Tech for UNC

Recording-20230406_142930

Catherine Sanders Reach

Catherine Sanders Reach

Catherine Sanders Reach

Activity

/7 You edited this

[ You recently opened this

i 8-59
[} You recently opened this

M Feedback

. To visit Stream (Classic) click here



Convert Word Online Outline to PowerPoint

Themes . Free and Cheap Tech March 2023
1. Get more out of what you are already paying for
2. Spend for technology where it really matters - anchor tenants
3. Reduce the spend on IT support - increase the spend on products you understand well
enough to manage internally
Layer human touch on top of automation - and automate everything you can
Don't try to replace people with technology - replace pieces of jobs with technology
Freelancers are your friend
Keep rigorous track of ROI
Frugal is savvy, but cheap is for chumps
. |Leverage consumer technology where you can do so safely and ethically
10. Maximize your NCBA discounts

= L

Productivity
1. How to scan documents for free - ELM
2. Google One vs Google Drive - ELM
3. Hidden tricks in Apple Notes - ELIM
4. Saving hours with shortcuts - ELM
5. Browsing with savings - CSR
6. Otterai - CSR
Office Suite

1. X things you didn't realize Gmail could do - ELIM
2. Add-ons and integrations are your friends - CSR

Time, Billing S T How o scan documents for free - ELM
1. Reducing your AR to $0 - fixed fees - ELM
2. Zoho accounting - ELM
3. LawPay Pro - New! - CS5R Hiclders tricks in pple Mobes
4, Time59 - $199 per year, unlimited users - CSR

Google One vs Google Deive - ELM

Saving hours with shorbos -

Practice Management Broversing with ssvings - CSR
1. Running your practice in Google Workspace - ELM
2. Online scheduling - ELM Otter.ai - C5H
3. Running your practice in MS 365 with some help - CSR

File — Export — Export to PowerPoint Presentation
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Power
Automate

F/K/A
Flow

Show advanced options ™

L
L

<

Get my profile (V2)

Show advanced options ™

o

i
A,

<

Send Email

*To m Mail = .

Subject Trouble Ticket issue added and assigned to you

-

" Bady

Him =B e o
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Collaboration
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Loom - Video Messaging

Soraya

Hey team — | know there's a lot going on

Loom on.

. today so let's do our project update via
M o ﬁ 9 Loom and get some time back:
eetir 1gS OfTT.

Record quick videos to update your team
and cut down meetings by 29%

Get Loom for Free




Share a File or Folder

. . X
Link settings
@ client communications live.pptx
e Wheo would you like this link to work for?
ﬁ_j client communications live
. | Learn more
MNCBA_CPM_STEMP_2019_Evaluatiorr Dece...
© 2 views Anyone with the |IHE ~
@ MNCBA CPM S5T&amp;MP 2019 Evaluation(2... People in North Cari:lj .
§:> = = 1 o -
@ = see stalls Association with the link
Stamp final attendess for Afixlsx
1 Viewer - 2 Views People with existing access
Stamp final attendees for Afilixt - -
D ? o You viewed this Specific people
Mar 26
@ Thank you for participating in the NCBA CP...
Other settings
[ ] Allow editing
Set expiration date X
&y Set password =

© Block download @

Apply Cancel
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Sharing settings

Practical Al ...ractice.docx

Share the link with

@ Anyone @

People in Morth Caroli...r Association

) €D rPeople with existing access ©
Share a File o

or Folder

Can review
Can only suggest changes

Can view
Cannot make changes

S Can view

@ Block download

Cancel




See Who Has Access to the Folder

Files > CPM

selection for all items

% D Mame Madified Maodified By File size Sharing
_ STAMP August 29, 2019 Catherine Sanders Reach 28 items Private
__ Building 2 Website April 25, 2019 Catherine Sanders Reach 21 items Private _A Planning and Administration p e
i April 22, 2019 Catherine Sanders Reach 4 ite Private
T NCBA Staff Training pril 22, 2 atherine Sanders Reac itemns riva Manage Access
__ Learning Objectives Webinars April 17, 2019 Catherine Sanders Reach 21 items Private
o _ % Planning and Administration = March 26, 2019 Catherine Sanders Reach 28 items #* Shared _
“23 Links Giving Access (U & Share
_ Tech Consulting March 12, 2019 Catherine Sanders Reach 22 items Private
T There are na sharing links for this item.
o Direct Access @ +
Catherine Sanders BEeach o
Director of the Center for Practice Manag.. wner
Erik Mazzone »

8-66 Senior Director, Membership Experience



Manage Access

@ Member Discount Provider agrees to.d-- %

Files > CPM > Planning and Administrati Manage Access

Stop sharing

s

@ Links Giving Access (D I Share

‘ https://ncbar365-my.... ‘ Copy ‘

Pecple you specify can view

D Mame ™ | Shanng

@ Member Discount Provider agrees to.doc #* Shared

This link works for ™

. Jennifer Shapira
Sponsorship Coordinator

s Direct Access @ -+
Catherine Sanders Reach
: . Chwner
Director of the Center for Practice Manag...
Erik Mazzone »

Senior Director, Membership Experience
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CITY ATTORNEYS MATTER - LEADING AND ...

E NCAMA 2022 CSR materials
McGirt NCAMA conf. Leadership final.docx

s

McGirt NCAMA conf. Leadership final.pdf

McGirt SOG photo .jpg

Inside look @
NCAMA 2022 C5R matenals.docx {5} Time to read: 28 min

. At a glance
NCAMA 2022 CSR matenals.pdf

+ If you are a M5 365 subscnber and receive the Viva
Daily Briefing email or occasionally review Viva

NCAMA 2022 McGirt Reach papers and slid... Insights, you have probably noticed it is always
trying to get you to block time for “focus time",
- + Reduce nisks associated with poor process
ncama law practice management PP #2.ppt poorp
. P g PP documentation, haphazard task management,
a r e I e siloed information, and other issues that plague
ncama law practice management PP Versio... businesses both large and small.

+ The pimary issue with DY file naming comventions
is lack of documentation, overly complex

[ ]
| n t e ‘ | | g e n C e B ncama law practice management PP Versio... structures, and lack of compliance by the file
creators.

ncama law practice management slides.pdf

; Your conversations
ncama law practice management.ppix

¢ You, Emanuel D. McGirt
paper #13 Leading and Managing City Atto... RE: [External] Re: ing on tomomow

A=sted the =i =

Planning Notes for Law Office Practice Man...

2 Viewers - 22 Views

F o L 7 . B N



Send Link to Request Files from OneDrive

Send file request

Req uest files Here's the link peoplfkcan use to upload files

https://ncbar3és-my.sharepoint.com/:f./g/personal/csanc Copy link

EJ What files are you requesting? E3J Anyone with the link can upload files

Testing Request Files{

Recipients will see the above request name and Or you can send it via email

To: Name, group or email

Message...
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Multi-Author Document Collaboration

“- Start conversation

Hii Edit in Teams

@ Editin Word

@8 Edit in Word Online

2018-19 Bar Leadership Orientation

A few words from Jacqueline Grant, 2018-19 NCBA/NCBF President

Congratulations! Your peers have chosen you, whether by election or appointment, to serve on the North Carolina
Bar Association and North Carolina Bar Foundation's leadership team for 2018-19. As chair or vice chairofa
section, division, committee or task force, or as a member of our board, you have the privilege and responsibility of
serving our great profession, our 19,000 members, and our fellow North Carolinians,

This is an exciting time for the Association and the Foundation, This year we will continue to hone our value
proposition in an effort to enhance the experience of our members, We will continue to advocate and educate the
publicon the importance of judicial independence. We will work hard to build stronger relationships between our
members and the publicthrough our pro bonoe and publicservice activities, Through our Foundation we will seek
to grow our culture of philanthropy, which will enable us to have a more powerful impact on the people and
communities throughout North Carolinawho are in need ofthe Foundation's charitable services and programs, We
will continue to support our executive director, Jason Hensley, whose vision for the Association and Foundation
include enhancement of our advocacy, leadership, education, and involvement in the community. We will continue
to servethe diverse professional needs of lawyers, law students, judges, and paralegals across North Carolina,

Qurwork will be accomplished by 67 sections, divisions, committees and task forces, The success of our work will
be due, in large part, to your leadership as well as the energy and efforts of our members. In order to have a
productive and successful year, it is important that you start planning now. We want to make this the bestyear
possible.
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Office 365 Materials.docx - Last Modified: Yesterday at %23 AM ~

File Mame

Office 365 Materials

Location

I @ Version History

‘ Small Firm 2020 Conference
Onelrive - Morth Carolina Bar Association »...

K/ersion History

Yesterday, April 21, 2020

Meodified by: Cathenne
Sanders Reach

Apnl 20, 2020

Meodified by: Cathenne
Sanders Reach

Open version

Modified by: Cathenine
Sanders Reach

Open version

Medified by: Catherine
Sanders Reach

Open version

Modified by: Cathenine
Sanders Reach

Open version

Meodified by: Cathenne
Sanders Reach

Open version

Meodified by: Cathenne
Sanders Reach

Open version

% Share | | O Comments |

Send Link

Office 365 Materials.docx

@ People you specify can view

Enter a name or email address

Word Document

PDF

™ Send a Copy
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Search or type a command
Recent  Contacts &
E— i

Conversation Files Organization  Activity —+

ﬂ 12:05 PM Ve Great! BTW, you've already sent me a quarterly report for CPM right? Even IVI S I e ; l rrl S ; —
0 You: Easiest is a spreadsheet templat... ) .
though you were only here for 2/3 of a quarter

M Jeremy and Lindsey 12/21

Lindsey: Sounds good to me -- thanks Rocking and rolling over there ( h a t ( a I I S
12/21 ’ ’
You: | am in my office. I've got a call ... 9:27 AM

[ ]
| sent you a report, I'll resend and see what you think, what you V I d e O
v 12/20
@ 10-4 thanks
Conference
)

[ ]
Hey - I'm going to need for sections folks to start tracking their time spent F I I e S’
e S e 1218 on each section. What would you recommend for that in terms of a toal?
Haha, O

OK -- | am free now

@ Collaboration

You: Erik said to use his old Office to... Easiest is a spreadsheet template. in Excel https://templates.offi

Erik, Jeremy, and Mark 12/20

You: Thanks. Going to hunt.

®

Q You: Yeah! Thanlks.

A =TT —cf f-bv-client-a _nroiact-TRMOGNES 28 A
4 Lindsey and Mark 12/7 us/Weekly-time-sheet-by-client-and-project-TM08088884 or Gd
! You: That's a danger @ I'm out! https://trackingtime.co/time-tracking-for-google-sheets or a fre
Suaoested https://clockify.me/

Weekly time sheet by client and project
I — Employees whose time is billed directly to clien
should complete this time sheet each week The

&
@
Type a new messags
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View Rooms More Camera Mic

[ 1]

Share

Share content Include computer sound l

Window (11)

Microsoft Whiteboard

Collaborate on a whiteboard
Content from camera
Share a document, a whiteboard, and more
PowerPoint Live
your notes, slides, and audience while you present.
8 Microsoft 365 Hidden Gems for Georgia
#M Tips for Paralegals
M Getting More Qut of the Tech You Already Ha...
#8 Microsoft 365 Hidden Gems

M practical ai
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Reply for Consu... R = |

Share ta [ Add to Tasks Move r| . Tags Editing | Immersive | Translate | Zoom Reply with Ring

Teams Ebar - = ~ - - = Scheduling Poll | for

Teams Quick Steps Moaove Language Zoom Find Time

Share to Teams

* Share to Microsoft Teams

Share to

Type the name of a persan, group. or channel

Participants from email
KL Kate Leahy

Frequently shared to

& General
Design Your Law Practice: A Practical Guide to Design Thinking for Lawyers Looking to Getting Things Done

— zeneral
: WSB TECHSHOW 2022 - Tech to Succeed

Recent locations

e% Amy, Cheyenne, and Erin

This sounds like a really good session! Please let me know how | can help.

Sarah Saint

ich@nchar
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is not a cure all, but | can't believe this state is just starting it. Between Pacer, Tyler, and even trademarks and the IRS going efiling | barely need p

Send
Email to

Teams
Channels




Teams

Your teams

n MX Dept

General

Membership Appreciation Month

Social Media

CPM Admin

General

Learning Objectives

m Website Redesign

General

1 hidden channel

Hidden teams
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1. Learning Objectives ...
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Recorded CLE ideas

CSR Travel

CPM Conferences 2...

Learning Objectives series (3rd Wed at noon)

Learning Objectives: Defensive Calendaring (May 15 12-12:45)

Event ID: CPMW052019 https://ncbar.zoom.us/|/6753562861

Does your calendar feel like it is under constant attack? Is managing meetings, events, client consultations and to-dos overwhelming? Do
you know how to effectively leverage electronic calendars such as Google Calendar or Microsoft Outlook to block and tackle for time?
Come to this session to learn some defensive calendaring technigues and tips to effectively coordinate meetings with multiple people,
allow people to self schedule and leverage artificial intelligence to help you get out of the business of negotiating availability.

https://crm.ncbar.org/eweb/DynamicPage.aspx?webcode=Eventinfofireg_evit_key=667D3ABA-AB1F-453F-87E9-
S5EDB381111688RegPath=EventRegNoFees

Learning Objectives: Outlook Tips and Add-ons (June 19 12 -12:45)

Event ID: CPMW062019 hittps://ncbarzoom.us/j/6753562861

MS Outlook is the top email application for business use. It is an incredibly powerful product but like many powerful applications most
users only know how to leverage a small fraction of it's power. In this session we'll look at not only native features and functions that will
help manage email more effectively but we’ll also look at some add ons that will super power Outlook for communication and
collaboration.

https://crm.ncbar.org/eweb/DynamicPage.aspx?webcode=Eventinfodireg_evt_key=1DDDDCF7-ECCH-45C1-8148-
T772CAF9BDES&RegPath=EventRegNoFees

Learning Objectives: Encryption at Rest and in Transit (July 24 12 -12:45)
Event ID: CPMWO72019 https://ncbar.zoom.us/j/6753562861

Whether third party encryption or setting built into the technology you use every day there are a number of ways to encrypt emails and
their attachments. Why do you need to encrypt them? Here are a few scenarios: You are a real estate aftorney under constant thread of
wire fraud and man in the middle attacks; you are a family law attorney with an enraged spouse potentially between your emails and
your client; you don’t know whether your client is reading the email on a corporate device that by policy brings into question the
privilege of the email; you are emailing patent specifications; you are representing a government whistleblower and the list goes on. The
question is when do you NOT need to encrypt emails and securely send documents to clients. We will look at a variety of ways to easily
and efficiently get this done.

https://crm.ncbar.org/eweb/DynamicPage.aspx?webcode=Eventinfo&ireg_evit_key=9203DBD1-044A-4539-8D7F-
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W General rosts Files Planning Notes

HBoard E Charts & Schedule

To do

-+  Add task

O Send Larry a thank you

@ 0/2

e Catherine Sanders Reach

O Learning Objectives: Tasks
) Post registration link

(_J Prepare materials and demos
_J) Send reminder to registrants
) Give presentation

_J Produce recording

) Send link to recording to Jeremy

_J Send link and follow up to attendees
LI 6 04/15 EE)

e Catherine 5anders Reach

O Write article on ToDo from Planner

e Catherine 5anders Reach

CPM Projects ~ CPM Calendar Client Ticketing

Doing Done

-+  Add task -+  Add task

O Contact client for spouse name

() Contact client Hide completed 3
) Sdd name to database
I_J finalize billing record

& =k

o Wo05/0d4 & o3

e Catherine Sanders Reach

@ 10/10/2019

0 F - .

e 03,23

e Completed by Catherine Sanders...

°66—t6—tf&d&f—jaes

i 02/22 @ 33

6 Completed by Catherine Sanders...

e Completed by Catherine Sanders...

Add new bucket



Search for apps

i

Website

Clio
IO

Fower
Automate

P

Tasks by
Planner and

Stream

Asana

Channel
calendar

Whiteboard

SharePoint
Pages

Viva Engage

SharePoint

Evernote

Lists

-y

H ¢
Document Visio
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Forms Power Bl
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Add a new app

Word

Excel

Trello

OneMote

@

PowerPoint

Power Apps

8-77



SharePoint 2 Search in SharePoint
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Preview and apply template

From Microsoft

Organization home

Provide the online home for your organization with
news, resources, and personalized content.

Site capabilities

Highlight news and conversations

Showcase organization resources

Emphasize organizational values and culture

Provide easy access to popular portal

E2 Preview site full screen

an still be
itent added
leted later. Learn more

m Organization Home
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Security




Al in AntiVirus / Malware Protection

« Carbon Black
* Deep Instinct

e Total AV

* Legacy Applications
» Malwarebytes, Norton, McAfee,
 Windows Defender, AVG




Why is Al-based Antivirus Better?

* Enhanced Detection & Adaptability
* Real-Time Detection

* Reduced False Positives

» Continuous Learning

e Proactive/Predictive




High-Profile Skadden Litigator Goots, Sends February 5, 2008, 5:42 pm
Private E-mail to Reporters Report: Lawyer's Email Slip-up Leads to Zyprexa Leak

Fosted by Dan Slater
T

Oops. Former bar prez copies top court on

:T:s“ti?)?l?s?t its "ill-conceived and uninformed E m a ” IS (Stl ‘ |) th e I\/l OSt
Dangerous Tool You Use

Every Day

Ex-DLA Piper partner caught in "churn that bill, baby!
crossfire sues firm's counsel

MARTHA NEIL




Suspended For Texting Witness During Deposition

| 11:53 AM 11:55 AM 11:55 AM
| | | | |
11:53 AM 11:54 AM 11:55 AM 11:56 AM
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Phishing Isn’t
Just for Emails
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Use An
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App Instead of
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= Passwords
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will syne here,

Sync with mw
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Transmitting Electronic Files

Alex Jones lawyer suspended 6 months over records release

By DAVE COLLINS January b, 2023
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Transmitting Electronic Files

* Know what you are sending
* Password protection
* Encryption

e Send links instead of

attachments

e Use a client portal

L@ Signed and all signatures are valid.

L]
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@

Signatures

[

"]
B=

Walidate All

b

8| N

% Rew. 1: Signed by Catherine S. Reach <csandersreach@chicagobar.org> (Catherine Sanders Reach)

Signature is valid:
Document has not been modified since this signature was applied
Signed by the current user
Signing time is from the cleck on the signer's computer,
Signature Details
Last Checked: 201311.14 14:29:42 -06'00"
Field: Signature2 on pagel
Click te view this version
Document Locked by Signature?




Passwords

FIDO Authentication

A Passwordless Vision
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-ncrypt All Mobile
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Portable Storage
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W%]'o s Listening? thfghing?




John Oliver marries a cabbage. You're welcome.
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Text

Speaker Prompt

VALL-E

The others resented postponement, but it was just his scruples that charmed me.

P =)
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https://valle-demo.github.io/

i
W,

THIS IS NOT MORGAN FREEMAN.,




Thank You

Paul J. Unger | punger@affinityconsulting.com

Catherine Sanders Reach | csandersreach@ncbar.org

- @
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Rebooting Your Client Intake Process
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Lisa Feldstein Law Office Professional Corporation

Jennifer Reynolds
Fresh Legal

June 8, 2023
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REBOOTING YOUR
INTAKE PROCESS

17th Solo and Small Firm Conference
Thursday, June 8, 2023
Law Society of Ontario

g o -2

Lisa Feldstein, BA, JD' s6co0o
Jennifer Reynolde, BASc, LLB cScoas

Lisa Feldstein Jennifer Reynolds
BA, JD BASc, LLB

Lisa Feldstein Law Office PC Fresh Legal

o @lisafeldstein @FreshStartOtt
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Agenda

e Why is an intake process important?
’ e What makes a good intake process?

e How can a good intake process help you meet LSO
l client identification requirements?

e Why should you qualify clients early in your process
(and how do we do it)?

e What tools/software can be used to improve your
intake processes?

#17SoloSmall @lisafeldstein @FreshStartOtt

Why is an intake process important?

~o®
g

#17SoloSmall @lisafeldstein @FreshStartOtt

9-2



What makes a good intake process?
| san ]

Y, U

Filtering/ Standards for EOSV tools &

qualifying responding automation
; Track and Build trust
follow up and provide

with leads value

#17SoloSmall @lisafeldstein @FreshStartOtt

et I Lisa's Process

—zapier
Microsoft 365

»g Airtable

» g Airtable
LawPay

9-3



Jennifer's Process

“zavier Jo cio

—zapier
—zapier

ﬁ &) ACUITY SCHEDULING
|

LSO client identification requirements
and conflict checks

G as

#17SoloSmall @lisafeldstein @FreshStartOtt
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Filtering/qualifying clients

#17SoloSmall @lisafeldstein @FreshStartott

What tools/software can be used?

@ coY

#17SoloSmall @lisafeldstein @FreshStartott
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What is YOUR next action item?
| Share it with the person beside you or
on Twitter using #17SoloSmall!

#17SoloSmall @lisafeldstein @FreshStartOtt

9-6
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e
\\L H Identifying and Rebooting
Your Intake Process

Initial Client Contact @

How is the potential client reaching out to your firm? g

[1 Chatbot

[] Text message

[1 Email

[1 Phone call

[1 Social media (ie. Instagram, TikTok, LinkedIn)
[1 Other:

Who is accountable for receiving the inquiry?
[1 My assistant
[0 Another lawyer at the firm

I do it myself
[ Other:

Is there a standard for how and when to respond? \8/

[]Yes
1 No

If no, what standards would you like to see in place?

%8 WORKSHEET 1



Filtering Clients

Do you filter out leads that are not a good fit before they speak with a lawyer?

[l Yes

L1 No ‘.’
)

If yes, how do you do it?

[0 Outline areas of practice on website

[0 Standard questions on a form

[0 Standard questions in call with assistant
O Other:

If no, how might you start to filter your leads?

Do you ever take on clients and realize they are not a good fit after
they sign the retainer?

] Yes
1 No

If yes, what factors indicate they are not a good fit?

WORKSHEET




What questions could you ask to identify these factors before you speak
with the client?

What kind of questions do you ask yourself about every single client
before you agree to represent them?

Could you standardize or automate these questions? %

Creating Value During the Intake Process

What questions do you answer over and over?

Can you provide that information to your clients up front and
systematically? Consider auto-replies, handouts/PDFs, links to useful

resources, FAQ

o110 WORKSHEET




Client Identification

Are you collecting the required intake information set by the Law Society
of Ontario for every client?
[1Yes

1 No
O 1 don't know

If you aren't sure, refer to By-Law 7.1 at the back of this workbook.

If yes, how and when do you collect it?

Is it the same person or process/tool every time?
[]Yes
[0 No (If so, could it be?)

If no, what information do you still need to collect?

When in your process will you collect it?

WORKSHEET




Conflict Checks

Do you do a conflict check before a potential client speaks to a lawyer?

Ll Yes

L1 No ﬂ
If no, when do you do your conflict check?

Who is responsible for the conflict check?

Is it the same person every time?
LlYes
L1 No

If no, could it be?

How do you do your conflict check?
[0 CRM software

[0 Practice management software
[ Other:

Where is the information recorded?
[0 CRM software

(1 Practice management software
(1 Other:

o

12 WORKSHEET




Appointment Booking

Are you making promises (e.g. about how quickly leads will get an
appointment with a lawyer)?

[]Yes
L1 No

If yes, are you tracking and monitoring to ensure you are keeping
your promises?

[1Yes ﬁ

1 No

If no, what action steps will you take to monitor it?

How do clients schedule initial appointments?

[J Send them our calendar booking link

[1 Directly book from our website

[1 Manually book the appointment ourselves
[1 Other:

If they are manually booked, is it the same person booking it every
time?
[]Yes
[1No

If no, could it be?

WORKSHEET




% ~
. . §S8s
Tracking and Converting Leads S-S
8398
O Sie
®

Do you track each lead that contacts your firm? If yes, how?
[1 CRM

[1 Excel spreadsheet

[1 Other:

If yes, what information do you gather?
[1 Name

[1 Phone number

[1 Email address

[1 Conflict information

[1 Other:

If no, how could you track leads and what information will you track
about them?

Do you follow up with potential leads?

[ After initial contact (once)

[1 After initial contact (more than once)

[1 After consultation before retainer (once)
[0 After consultation (more than once)

[1 Not at all

[1 Other:

If not at all, where could follow ups be added to your system? What
tools could you use to follow up?

#14 WORKSHEET




Retainers and Non-Engagement Letters T
V
Does every client sign a retainer agreement? 4’

] Yes
1 No

If yes, is the retainer agreement and the process of sending it to the client
standardized? Does the same person do it every time?

If no, where will you add this to your process? How will you ensure itis
done? Who be responsible for it?

Do you send non-engagement letters?
[1Yes

[1No

[J Sometimes

If no or sometimes, where could you add this to your process?

o

WORKSHEET




Automation

What tasks, if any, in your intake process do you dislike when you do them
because they are repetitive or feel like a waste of your time?

What tools have you heard of that you could use to automate these tasks?
[1 Clio (Manage/Grow)

[1 Zapier

[1 Acuity

[1 Airtable

[1 SignNow

[ Trello

[1 Other:

How could you learn more about these tools?

o

%16 WORKSHEET




YOUR REBOOT PLAN ./:(/ o

Commit now to doing three things to improve your intake ‘/

process. What will you do? When will you do it? ./\/
Tell someone in the workshop or online.

WORKSHEET 10 o-17



/’/:(//
/
QUALIFYING PP

QUESTIONS

Name / Email address / Phone Number
May we leave you a message at the phone number provided?

Where do you live? (Website note tells them we only serve clients in the Province of
Ontario.)

What is your spouse/former spouse's name? *Conflict check (Website note explains
how this information is used.)

Are you looking for a lawyer or a mediator?
Were you referred to a particular member of our team?
Are you applying for legal aid funding?

Please tell us a bit about your situation.

%18 WORKSHEET
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EMAIL TEMPLATES ™ 7

After Initial Call (same day):
Hello [name]:

| am writing to follow up on our telephone call. It was a pleasure to speak with you and |
hope you found the information you received during our conversation helpful.

Do you have any follow-up questions, or things you forgot to ask?

We find that often people think of things they want to or meant to ask us after the
telephone call is over. If you think of anything, please do not hesitate to contact us. We
would be happy to help.

What happens next? Book your consultation or intake meeting now.

If you have not done so already and are ready for the next step, please book a
consultation or intake meeting with me at a time that works for you using this link.

Important: Until you have a signed retainer with us and have paid the required deposit,
we will not take any action on your file. If you have any questions about this, please do
not hesitate to contact me.

Take care,

[lawyer name]

WORKSHEET 12 %1


http://freshlegal.as.me/initial-consultation
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EMAIL TEMPLATES ™ 7

After Initial Call (seven days later if consultation not booked)
Hello [name]:
We are writing to follow up on your telephone conversation with [lawyer] on [date]. If

you would like to book an initial meeting with [lawyer], please use this link to schedule
a time that works for you.

Important: Until you have a signed retainer with us and have paid the required deposit,
we will not take any action on your file. If you have any questions about this, please do
not hesitate to contact our office.

Take care,

[Firm Namel]

One Week After Consult (if not retained):

Hi [First Name],

We are writing to follow up on your consultation with [lawyer] on [date]. If you wish to
retain [lawyer] to assist with your matter, please contact them directly or reply to this

email.

Please note, as a reminder, until you have a signed retainer with us and have paid the
required deposit, we will not take any action on your file.

If you have any questions about how we can assist in your matter, please do not
hesitate to contact our office.

Thank you,

[Firm Name]

%-20 WORKSHEET
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EMAIL TEMPLATES™ 7

After Initial Call (seven days later if consultation not booked)
Hello [name]:
We are writing to follow up on your telephone conversation with [lawyer] on [date]. If

you would like to book an initial meeting with [lawyer], please use this link to schedule
a time that works for you.

Important: Until you have a signed retainer with us and have paid the required deposit,
we will not take any action on your file. If you have any questions about this, please do
not hesitate to contact our office.

Take care,

[Firm Namel]

One Week After Consult (if not retained):

Hi [First Name],

We are writing to follow up on your consultation with [lawyer] on [date]. If you wish to
retain [lawyer] to assist with your matter, please contact them directly or reply to this

email.

Please note, as a reminder, until you have a signed retainer with us and have paid the
required deposit, we will not take any action on your file.

If you have any questions about how we can assist in your matter, please do not
hesitate to contact our office.

Thank you,

[Firm Name]

WORKSHEET 14 o2


http://freshlegal.as.me/initial-consultation
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EMAIL TEMPLATES® %

Hello [First Name],
Thank you for choosing [Firm Name]!
There are three simple steps to complete so we can begin working with you:

Step 1: Review our office policies. If you have any questions or concerns regarding
these policies, please let us know.

Step 2: Please review and sign the retainer agreement. Click the link below to complete
this step. You can do this from your phone or computer. This link is valid for one week.

Step 3: You will receive an emailed invoice for the deposit. You can pay this deposit via
email transfer, credit card, cash or cheque. If you are paying by credit card, there is a
link in the emailed invoice. To pay by email transfer, please send the payment to
office@freshlegal.ca and set the password as the first name of your lawyer. To pay by
cash or cheque, please contact our office.

Please do not hesitate to call or email if you have any questions or concerns. We look
forward to assisting you with this matter.

Take care,

[Firm Name]

%22 WORKSHEET



https://www.freshlegal.ca/office-policies
mailto:office@freshlegal.ca
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EMAIL TEMPLATES™ 7

Four Weeks After Consultation (if not retained)
Hi [First Name],
We are writing to follow up on your meeting with [lawyer] on [date].

As to today’s date, you have not retained [lawyer] and they do not represent you in
your matter. As such, they will not take any action with respect to your matter.

Please note that limitation periods may exist with respect to your matter. A limitation
period is a deadline by which you need to make a claim. You should seek legal advice if
you are concerned about these time limits, and ensure you take action prior to the
expiry of the limitation period.

If your circumstances change and you wish to retain our firm with respect to this
matter, or if we can be of any assistance to you in the future, please do not hesitate to
contact us.

Thank you,

[Firm Name]

WORKSHEET 16 ¢2
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Law Society of Ontario
By-Law /.1

Client identification
23. (1) When a licensee is retained to provide her or his professional services to a client, the licensee
shall obtain the following information about the client:

1. The client’s full name.

2. The client’s business address and business telephone number, if applicable.

3. If the client is an individual, the client’s home address and home telephone number.

4. If the client is an organization, other than a financial institution, public body or reporting issuer, the
organization’s incorporation or business identification number and the place of issue of its incorporation
or business identification number, if applicable.

5. If the client is an individual, the client’s occupation or occupations.

6. If the client is an organization, other than a financial institution, public body or reporting issuer, the
general nature of the type of business or businesses or activity or activities engaged in by the client, if
applicable.

7. If the client is an organization, the name, position and contact information for each individual who is
authorized to give instructions with respect to the matter for which the licensee is retained.

8. If the client is acting for or representing a third party, information about the third party as set out in
paragraphs 1 to 7, as applicable.

Additional client identification: activities mentioned in clause 22 (1) (b)

(2) When a licensee is engaged in the activities described in clause 22 (1) (b), in addition to complying
with the client identification requirements set out in subsection (1), the licensee shall obtain from the
client information about the source of the funds being received, paid or transferred.

Additional client identification when organization involved: activities mentioned in clause 22 (1) (b)

(2.1) When a licensee is engaged in the activities described in clause 22 (1) (b) and the client or third
party that the client is acting for or representing is an organization, in addition to complying with the
client identification requirements set out in subsections (1) and (2), the licensee shall,

(a) obtain the name of each director of the organization, other than an organization that is a securities
dealer; and
(b) make reasonable efforts to obtain,

(i) the names and addresses of the persons who own, directly or indirectly, twenty-five percent or more
of the organization or of the shares of the organization, if applicable,

(i) the names and addresses of all trustees and all known beneficiaries and settlors of the trust, if
applicable, and

(i) information establishing the ownership, control and structure of the organization.




Alternate requirement when unable to meet identification and other requirements re organization
(2.2) If a licensee is unable to obtain the information mentioned in subsection (2.1) or to confirm the
accuracy of the information as required by subsection (12.2), the licensee shall,

(a) take reasonable measures to identify the most senior managing officer of the organization;

(b) determine whether the client’s information in respect of their activities and the source of the funds
and the client’s instructions in respect of the transaction are consistent with the purpose of the retainer
and the information obtained about the client as required under subsection (2.1) and record the results
of the determination and the date on which it was made; and

(c) assess whether there is a risk that the licensee may be assisting in or encouraging fraud or other
illegal conduct and record the results of the assessment and the date on which it was made.

Client identification: identification by others in licensee’s firm

(2.3) A licensee complies with the identification requirements set out in subsections (1) to (2.2) if an
employee of the licensee’s firm or another licensee who practises law or provides legal services through
the licensee’s firm, acting on behalf of the licensee, complies with the requirements.

Timing of verification, individuals

(5) A licensee shall verify the identity of an individual mentioned in subsection (1), including an
individual mentioned in paragraph (1) 7, immediately after first engaging in the activities described in
clause 22 (1) (b).

Timing of verification: organizations

(6) A licensee shall verify the identity of an organization mentioned in subsection (1) immediately and,
in all cases, by not later than 30 days after first engaging in the activities described in clause 22 (1) (b).
Documents, data and information for verification

(7) Subject to subsection (8), the following are the documents, data and information for the purposes of
subsection (4):

1. If the client or third party is an individual,

i. a government issued photo identification document, excluding a document that is issued by a
municipal government,

ii. information in the individual’'s credit file that is located in Canada and has been in existence for at
least three years,

iii. any two of the following pieces of information, each from a different source that is not the individual,
the licensee or an individual acting on behalf of the licensee pursuant to subsection (11),

A. information from a reliable source that contains the individual’'s name and address,

B. information from a reliable source that contains the individual’'s name and date of birth,

C. information that contains the individual’s name and confirms that they have a deposit account, credit
card or other loan amount with a financial institution.




2. If the client or third party is an organization such as a corporation or society that is created or
registered pursuant to legislative authority, a written confirmation from a government registry as to the
existence, name and address of the organization, which includes the names of the organization’s
directors, if applicable such as,

i. a certificate of corporate status issued by a public body,

ii. a copy obtained from a public body of a record that the organization is required to file annually under
applicable legislation, or

iii. a copy of a similar record obtained from a public body that confirms the organization’s existence.

3. If the client or third party is an organization other than a corporation or society that is not registered in
any government registry, such as a trust or partnership, a copy of the organization’s constating
documents, such as a trust or partnership agreement, articles of association or any other similar record
that confirms its existence as an organization.

Requirements re documents, data and information used for verification

(8) For the purposes of subsection (4), documents and records used must be authentic, valid and
current and other information used must be valid and current.

Client verification: individual younger than 12 years

(9) If a licensee is required to verify the identity of an individual who is under twelve years of age, the
licensee shall verify the identity of a parent or guardian.

Client verification: individual 12 years or older but younger than 15 years

(10) If a licensee is required to verify the identity of an individual who is at least twelve years of age but
not more than 15 years of age, the licensee may do so by obtaining information from a reliable source
that contains the name and address of a parent or guardian and confirming that the address of the parent
or guardian matches the individual’'s address.

Client verification: use of agent, etc.
(11) A licensee complies with the verification requirements set out in subsection (4) if,

(a) an employee of the licensee’s firm or another licensee who practises law or provides legal services
through the licensee’s firm, acting on behalf of the licensee, complies with the requirements; or

(b) an individual who is not an individual mentioned in clause (a), acting on behalf of the licensee,
complies with the requirements, provided that,

() the licensee and the individual, prior to the individual acting on behalf of the licensee, enter into a
written agreement for this purpose, and

(i1) the licensee obtains from the individual the information obtained by them under the agreement,
satisfies themself that the information is valid and current and satisfies themself that the individual
complied with subsections (4) to (10).




Client verification: previous verification
(12) A licensee complies with the verification requirements set out in subsection (4),

(a) if the licensee has previously complied with the verification requirements set out in subsection (4) and
has no reason to believe the information or the accuracy of the information has changed; or

(b) an individual acting on behalf of the licensee under subsection (11) previously complied with the
verification requirements set out in subsection (4) either acting in their own capacity at the time, whether or
not they were required to comply with the verification requirements set out in subsection (4), or acting on
behalf of another licensee at the time pursuant to an agreement under subsection (11).

Recording information

(12.1) The licensee shall record all information obtained for the purposes of subsections (1) to (2.2) and the
date on which it was obtained.
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A Few Tips for Growing a Law Firm

Jacqueline Swaisland
Co-Founder, Landings LLP

Landings LLP is an immigration and refugee law firm which was named one of Canada’s Best Law Firms by
the Globe and Mail in 2023. Landings was founded in 2020 at the height of the pandemic. In its first three
years, it has grown from 3 lawyers, a law student, and one legal assistant to 9 lawyers and 7 support staff.

Managing this kind of growth was tricky and involved a lot of growing pains. Here are a few tips that were
learned along the way on how to grow your law firm.

1. Figure out why you want to grow.

Before you start to grow your law firm, it’s important to think through in advance why you want to grow
your law firm. Bigger isn’t always better, so figure out what it is that you want to accomplish with growth. Is
it to increase your bottom line? Diversify your practice? Make it easier to do the kind of work that you want
to do? By figuring out the reason or reasons you want to grow, you will have a better idea of what kind of
growth is likely to work best for your firm (Do you need more admin support? Additions to your legal team?
A bit of both?). It will also assist you to put metrics in place so you can assess down the road if your firm’s
growth is actually helping you to accomplish what you wanted it to.

2. Try to be proactive with growth.

It often feels safer to take on a lot of new clients to support your firm’s growth and then add on the staff you
need. However, onboarding new people, whether they are lawyers or support staff, takes a lot of time and
energy, especially from a small team. So, if you wait until you are overloaded with work, taking on new staff
may be overwhelming, and you may have to cut corners when doing so. A better approach is to do the
onboarding of new staff and then do a big push for additional clients once the new staff are onboard.

3. Try to think through any unintended consequences of your growth.

In a small practice adding just a few more people can significantly impact how things work. Try to think
through how all aspects of your practice might be affected by the new growth and where it may create
bottlenecks. For example, with additional lawyers on board you are likely to get more intake calls, require
additional bookkeeping services, and potentially additional office space. It may also result in you having
different technology needs. For example, you may need to increase your internet capacity, change the legal
software you work with, or upgrade your online storage capacity. You may also need to formalize firm
policies and practices to ensure consistency and fairness across employees, have different lines of
communication available (team meetings anybody?) and develop reporting hierarchies. Thinking through
and ideally proactively addressing these issues as you grow will make the growth easier to manage.

4. Try to standardize employee onboarding.
If you are hoping to add more than 1-2 people to your team (either now or in the future) a big timesaver can
be standardizing your onboarding process. Put together a list of all the items that must happen when a new

person joins the firm. What technology do they need to have? What programs do they need
passwords/subscriptions for? What training do they need? Not only will this help to prevent you from
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reinventing the wheel each time an employee gets hired, but an added benefit is that much of this list can
easily be turned into an offboarding checklist you can use when employees leave.

5. Hiring is tough — you aren’t always going to get the right one.

Hiring new staff, whether it’s a new administrative support person, a bookkeeper, or a new lawyer, is tough.
Some people interview very well but make terrible employees. Others tell you that their lifelong dream is to
work at your firm only to leave a few months in for their actual dream job. Turnover is inevitable as you
grow you firm. Do your best not to take it personally but do try to learn from the experience. For example,
were there red flags that you saw that you should have paid more attention to? It can also be helpful to
conduct exit interviews with your staff as they are leaving. What did they think about the job? The
onboarding process? The firm environment? Is there anything they would recommend changing?
Employees on their way out the door may feel less inhibited and provide helpful feedback that can help you
to retain employees in the future or make other positive changes to your firm.

5. Check in and make sure your firm’s growth is doing what you want it to.

After you have experienced growth, it’s always helpful to look back on your initial goals and see if the
growth got you where you wanted it to. Sometimes the growth will have helped you to accomplish
everything you wanted to and more. But sometimes you may find that it hasn’t had the consequences you
wanted. For example, while you may have hoped that the growth would allow you to cut back on your
workload, you may find that the additional management and client load has actually added to it. Or maybe
the increase in income you were hoping for isn’t where you wanted it to be. Or maybe you didn’t add the
right balance of people and an extra support person or lawyer will help to make things run more smoothly.
Critically evaluating your growth will help you to assess if you are where you want/need to be and will also
help you to figure out what your next steps are for the future of your firm.

Some Additional Reading:

Lawyer Monthly - 5 Tips to Help You Grow Your Small Law Firm:
https://www.lawyer-monthly.com/2022/10/5-tips-to-help-you-grow-your-small-law-firm/

Clio: The Complete Guide to Growing your Law Firm:
https://www.clio.com/blog/growing-a-law-firm/

California Business Journal — 4 Law Firm Tips That Help Grow Your Practice Even In Tough Times:
https://calbizjournal.com/4-law-firm-tips-that-help-grow-your-practice-even-in-tough-times/
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Growth Stories of Successful Law Firms

Darlene Tonelli, Inter Alia Law
17th Solo and Small Firm Conference: Secrets for Success

Background on IAL:

Inter Alia Law was founded as a sole proprietorship in 2013. Since then it has steadily grown into a team of
10 lawyers who practice in association. IAL lawyers use their in-house experience and large firm training to
help small companies with no legal department, as well as other in-house counsel in larger companies. to
solve workload issues and workflow challenges. We focus on commercial contract drafting and negotiation
in the technology and entertainment industries, and copyright licensing.

Growth for IAL has been fueled by:

. Creating a values-driven organization that attracts lawyers who share those values. By being clear
on our values and speaking publicly about them, we’ve attracted a team that supports the goals of
the organization, making it easy to grow with those goals in mind.

. Building the business model out steadily to ensure that it supports the concept of creating a great
team and great work environment (awesome clients, respectful interactions, transparent revenue
model). There are so many micro-levers that make this possible.

. Marketing using my own extra time in the early years, rather than spending marketing dollars. | did
a lot of speaking all over the city, and invested energy in making my presentations reflect Inter Alia’s
personality and brand and did one of the first lawyer podcasts that focused on the practice of law

rather than black letter law topics.

. Hiring a team of competent and capable helpers (assistant, bookkeeper, accountant, marketing/web
person) as variable costs.

J Not compromising on talent for recruits, and making hiring decisions slowly and with an eye on the
ecosystem of the association and what each new member will contribute.

. Flexibly responding to the needs of our clients when creating new products at the firm.

. Not getting caught up in growth for the sake of it, but growing to organically serve our clients as
well as we can, and to enhance our team.
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